Урок №1 Растрова, векторна і фрактальна графіка. Історія анімації. Формати графічних і анімаційних файлів. 

Растрова, векторна і фрактальна графіка

Під терміном “графіка” звичайно розуміють результат візуального подання реального або уявного об’єкта, отриманий традиційними методами – малюванням або друкуванням. Комп’ютерна графіка включає методи і засоби створення і обробки зображень за допомогою програмно-апаратних комплексів і охоплює всі види і форми подання зображень, доступних для сприйняття людиною на екрані монітору або в вигляді копії на певному носії. 

В залежності від способу опису та формування зображення розрізняють растрову, векторну та фрактальну графіку.

Історично термін “растр” вказував на те, що пристрій при відтворенні зображення використовує набори пікселів (точок), організовані в вигляді послідовностей рядків розгортки. Растрові дані являють собою набори числових значень, які визначають кольори окремих пікселів, впорядкованих таким чином, щоб їх легко було відобразити на растрових пристроях. 

Базовим елементом растрової графіки є піксель. Логічні пікселі подібні до математичних точок: вони мають місцеположення, але не займають фізичного простору. Фізичні пікселі – це реальні точки, що відображаються пристроєм виводу. Вони є найменшими фізичними елементами поверхні відображення і займають її певну площу. В зв’язку з цим на відстань між двома сусідніми пікселями вводяться обмеження. Якщо задати пристрою відображення надто високу роздільну здатність (кількість пікселів на одиницю довжини зображення), то якість зображення знизиться із-за накладення або злиття сусідніх пікселів. При надто низькій роздільній здатності пікселі можуть бути розкидані по всій площі пристрою відображення. Таким чином, при відображенні значень логічних пікселів із растрових даних в фізичні пікселі повинні враховуватись реальні розміри і розміщення фізичних пікселів.

Розрізняють роздільну здатність оригіналу, екранного та друко¬ваного зображення. Роздільна здатність оригіналу вимірюється в точках на дюйм (dpi) і залежить від вимог до якості зображення, розміру файла, способу оцифровування або методу створення початкової ілюстрації, вибраного формату файла. Підвищення вимог до якості зображення вимагає вищої роздільної здатності оригіналу. Для екранної копії достатньо роздільної здатності 72 dpi, для роздруковування на кольоровому принтері – 150-200 dpi, для виведення на фотоекспонуючий пристрій – 200-300 dpi. 

Розмір точки растрового зображення залежить від методу і параметрів растрування оригіналу, коли на оригінал як би накладається сітка ліній, комірки якої утворюють елемент растра. Частота сітки растра вимірюється кількістю ліній на дюйм і називається лініатурою (lpi). Розмір точки растра розраховується для кожного елементу і залежить від інтенсивності тону в комірці. Для вищої інтенсивності щільніше заповнюється елемент растра. При раструванні з амплітудною модуляцією ілюзія більш темного тону створюється за рахунок збільшення розмірів точок при однаковій відстані між центрами елементів растра. При раструванні з частотною модуляцією інтенсивність тону регулюється зміною відстані між сусідніми точками однакового (найменшого) розміру. Інтенсивність тону прийнято розділяти на 256 рівнів. Для її відтворення достатньо мати розмір комірки растра 16´16 точок.

Растрова графіка використовується в випадках, коли потрібна висока точність в передачі кольорів і напівтонів. Однак при цьому розміри файлів суттєво збільшуються з ростом роздільної здатності (одиниці, десятки і сотні Мбайт). До недоліків растрової графіки, окрім великих розмірів файлів, слід віднести пікселізацію зображень при їх збільшенні та деформацію при зменшенні.

В векторній графіці базовим елементом зображення є лінія, яка описується математично як єдиний об’єкт, тому обсяг даних для відображення об’єкта засобами векторної графіки суттєво менший, ніж в растровій графіці. Лінія характеризується формою, товщиною, кольором, типом (суцільна, пунктирна і т.п.). Замкнуті лінії мають властивість заповнення простору, що ними охоплюються, іншими об’єктами або кольором. Найпростіша незамкнута лінія обмежена двома точками, які називаються вузлами, котрі мають властивості, що впливають на форму кінця лінії і характер сполучення з іншими об’єктами. Всі інші об’єкти векторної графіки складаються з ліній. Найпростішими лініями є пряма (нескінченна), відрізок прямої, криві другого порядку (не мають точок згину – параболи, гіперболи, еліпси, кола), криві третього порядку (можуть мати точки згину), криві Безьє (основані на використанні пари дотичних, проведених до відрізка лінії в її кінцях, кути нахилу і довжина яких впливають на форму лінії).

Векторна графіка зручна для зберіганні і обробки зображень, що складаються з ліній, або можуть бути розкладені на прості геометричні об’єкти. Векторні дані легко масштабувати та виконувати над ними інші перетворення (наприклад, повертання зображення, додавання, видалення або зміну окремих елементів зображення). Поряд з цим векторні файли важко застосувати для зберігання складних фотореалістичних зображень. Векторні дані краще відображаються на векторних пристроях виводу (плотерах, дисплеях з довільним скануванням). Ефективно векторну графіку можна відобразити тільки на растрових дисплеях з високою роздільною здатністю. 

Фрактальна графіка, як і векторна, основана на математичних обчисленнях. ЇЇ базовим елементом є математична формула, виключно на основі якої будується зображення. Таким способом будують як найпростіші регулярні структури, так і складні ілюстрації, що імітують природні ландшафти і тривимірні об’єкти. 

Історія анімації

Анімацією прийнято називати відтворення руху шляхом відобра¬ження послідовності малюнків кадрів з частотою, при якій забезпечується цілісне зорове сприйняття образів (як правило, для плавного відтворення анімації необхідна швидкість, що забезпечує зміну частоти кадрів не менше 10 кадрів у секунду). Для комп’ютерної анімації частота зміни кадрів за секунду екранного часу складає 10-16, для кінематографа – 24, для системи PAL чи SECAM телемовлення – 25, для системи NTSC телемовлення – 30. Більша кількість кадрів дозволяє домогтися плавних рухів персонажів і появи об'єктів у зображенні в різні моменти часу. При недостатній кількості кадрів стають помітні розходження в послідовних зображеннях об’єктів, що приводить до їх різких переміщень. У традиційній анімації число кадрів прямо залежало від тривалості анімації в секундах. У комп'ютерній анімації на перший план виходить розмір файлу, у якому зберігаються зображення. Тому при створенні комп'ютерної анімації намагаються знайти компроміс між якістю анімації і розміром файлу, що і визначає загальну кількість кадрів анімації.

Різниця між анімацією і відео полягає в тому, що відео використовує безупинний рух і розбиває його на множину дискретних кадрів, а анімація використовує множину незалежних малюнків або графічних файлів, що виводяться в певній послідовності для створення ілюзії безупинного руху. 

Процес створення анімації дуже простий. Фактично він будується на повторенні таких етапів:

· розміщення об’єктів в заданих точках екрану;

· відображення об’єктів протягом визначеного проміжку часу;

· знищення об’єктів.

Комп’ютерна анімація відтворюється за допомогою комп’ютера на екрані комп’ютерного монітора або за допомогою відеомагнітофона на відеомоніторі при попередньому перетворенні за допомогою спеціальних апаратних засобів у відеоформат. Вона є одним з головних елементів мультимедійних проектів і презентацій. Для створення комп’ютерної анімації існує багато різноманітних програмних продуктів. 

Протягом усього свого існування люди намагалися відобразити відчуття руху у своєму мистецтві, що підтверджується наскельними зображеннями та розписами різних часів і народів (найбільш поширена спроба позначити рух - малюнки тварин, де кількість ніг перевищує справжню, наприклад, малюнок кабана з вісьмома ногами, виявлений у печерах Альтаміра у Північній Іспанії, зображення давньогрецьких колісниць і т. п.).

Дійсна анімація не може бути зроблена без розуміння фундаментального принципу роботи людського зору - інертності зорового сприйняття. Вперше цей принцип був продемонстрований у 1828 році французом Паулем Рогетом. З одного боку диску був зображений птах, а з іншого - порожня клітка. Коли диск обертався, птах з’являвся в клітці.

Розробка фотокамери і проектора Томасом Едісоном та іншими забезпечило перший реальний практичний спосіб створення анімації. Стюарт Блактон у 1906 році створив короткий фільм “Забавні вирази веселих облич”. Він малював обличчя на дошці, фотографував його і стирав, щоб намалювати наступний вираз обличчя. Уолт Дісней (1901-1966), американський режисер, художник, продюсер (дійсне ім’я - Уолтер Элайос) у 1923 році випускає серію “Аліса в країні мультиплікації”. У 1928 році випускає звуковий мультфільм “Пароплавик Віллі”, де вперше з’являється Міккі Маус. Продовжуючи серію стрічок про мишеня Міккі, Дісней починає роботу над новим циклом “Забавні симфонії”. Один з персонажів - каченя Дональд завойовує ще більшу любов публіки, ніж Міккі Маус. Будучи чудовим художником, Дісней сам знаходить теми і сюжети, пропонує зовнішній вигляд персонажів, придумує оригінальні і смішні трюки, навколо яких і будується дія. Для створення своїх фільмів Дісней використовує 12 основних принципів анімації. 

Перші експерименти з анімацією в Японії почалися ще в 1913 році, а перші анімаційні фільми з’явилися в 1917 році. Це були маленькі фільми довжиною від однієї до п’яти хвилин, і робилися вони художниками, які пробували відтворювати ранні досвіди американських і європейських мультиплікаторів. Найпершим японським анімаційним фільмом вважається “Новий альбом нарисів” Симокави Декотена. 

Історія комп’ютерної анімації тісно пов’язана з появою і розвитком спеціалізованих графічних програмних пакетів. Першим кроком в технології візуальних ефектів була, вірогідно, придумана в 1961 році Іваном Сазерлендом система Sketchpad, яка започаткувала еру комп’ютерної графіки. В цій системі за допомогою світлового пера користувачі могли створювати малюнки безпосередньо на екрані монітору. В 1967 році Сазерленд разом з Девідом Евансом розпочали роботу по створенню навчального курсу комп’ютерної графіки. Зріс інтерес до цієї галузі. В університеті штату Юта (США), де були започатковані такі дослідження, в цей час працювали: Джим Кларк – засновник компанії Silicon Graphics Inc., Ед Кетмул – один з піонерів в галузі створення фільмів за допомогою комп’ютера, Джон Вернок – засновник компанії Adobe Systems і розробник таких відомих продуктів, як Photoshop і Postscript.

Спочатку об’ємне зображення об’єктів формували на основі набору геометричних фігур (найчастіше трикутників). При цьому геометричні фігури мали однотонну заливку, а об’єкти переднього плану закривали ті, що розміщені на задньому плані. В 1971 році Генрі Гуро запропонував зафарбовувати трикутники з лінійною зміною інтенсивностей між їх вершинами. Це дозволило отримати більш плавну зміну інтенсивностей вздовж поверхні об’єктів. В 1974 році Ед Кетмул запропонував концепцію Z-буфера, що прискорило процес видалення схованих граней. Іншим винаходом Кетмула є накладання текстури на поверхню тривимірних об’єктів, що забезпечує реалістичність цих об’єктів. Ву Тонг Фонг запропонував інтерполювати відтінки всієї поверхні полігону, що забезпечує кращу згладжуваність, хоча і вимагає значно більших обчислень. Джеймс Блінн в 1976 році скомбінував розфарбовування за Фонгом і накладання текстури на поверхню об’єктів. В 1980 році Тернер Уіттед запропонував нову техніку візуалізації (трасування), яка полягає в відслідковуванні шляхів проходження світлових променів від джерела світла до об’єктива камери з врахуванням їх відбиття від об’єктів сцени. В 1986 році фірма AT&T впустила перший пакет для роботи з анімацією на персональних комп’ютерах (TOPAS), який коштував 10000 доларів і працював на комп’ютерах з процесором Intel286 і операційною системою DOS. В 1990 році фірма AutoDesk розпочала продажу продукту 3D Studio. В 1997 році компанія Macromedia придбала у компанії FutureWare невелику графічну програму для Web, з якої була започаткована нині широко відома програма комп’ютерної анімації Macromedia Flash. В 1998 році розпочався випуск додатку Maya, що коштував від 15000 до 30000 доларів. 

Методи стискання зображень

Стискання здійснюється з метою зменшення фізичного розміру блоку інформації. Стискання інформації здійснює програма-компресор, а відновлення – програма-декомпресор.

Стискання растрових і векторних даних здійснюється по-різному. В растрових файлах стискаються тільки дані зображення, а заголовок і решта даних (таблиця кольорів, кінцівка і т.п.) завжди залишаються нестисненими (вони, як правило, займають незначну частину растрового файла). Векторні файли, в яких зберігається математичний опис зображення, а не самі дані, як правило, не мають “рідної” форми стискання. Це викликано тим, що в векторному форматі дані вже представлені в компактній формі і стискання дає дуже незначний ефект. Окрім цього звичайно векторні дані читаються з незначною швидкістю і при додаванні розпаковування цей процес може стати ще більш повільним. Якщо векторний файл все ж стискається, то, як правило, стискаються всі дані, включаючи заголовок.

Більшість алгоритмів стискання забезпечують кодування без втрат, коли дані при розпаковуванні повністю відновлюються. Методи кодування з втратами передбачають відкидання деяких даних зображення для досягнення кращої міри стискання, ніж за методами без втрат. При цьому важливо, щоб втрата деякої частини даних була прийнятною або навіть доцільною. Найбільш поширеними алгоритмами стискання даних є групове кодування (RLE), алгоритм Лемпела-Зіва-Велча (LZW), кодування CCITT (Хафмена), технологія JPEG, алгоритм ART, алгоритми фрактального стискання зображень.

Алгоритм RLE зменшує фізичний розмір рядків символів, що повторюються. Такі рядки називають групами і кодують двома байтами, перший з яких визначає кількість символів в групі, а другий містить значення символу. Ефективність стискання залежить від типу даних зображення. Краще стискаються чорно-білі зображення, які містять багато білого кольору, а гірше – фотореалістичні зображення з великою кількістю кольорів. Алгоритм RLE характеризується простотою і високою швидкодією. Варіанти групового кодування розрізняються напрямом утворення рядка (вздовж осі X, осі Y та діагоналі). Найчастіше вони стискають без втрат, однак відкидання молодших розрядів в значеннях символу може суттєво збільшити міру стискання складних зображень. 

Алгоритм LZW базується на словниках. Із даних вхідного потоку він будує словник даних. Зразки даних ідентифікуються в потоці даних і співставляються з записами в словнику. Якщо зразка даних нема в словнику, то на основі цих даних в словник записується кодова фраза, яка має менший розмір, ніж самі дані. Ця ж фраза записується і в вихідний потік стиснених даних. Якщо ж зразок даних зустрічається у вхідному потоці повторно, фраза, що відповідає йому, читається із словника і записується в вихідний потік. Так як кодові фрази мають менший розмір, ніж зразки даних, відбувається стискання. Декодування здійснюється в зворотному порядку. Декомпресор читає код з потоку стиснених даних і, якщо його ще нема в словнику, додає його туди. Потім цей код переводиться в рядок, який він представляє, і записується в вихідний потік нестиснених даних. Перевагою алгоритму LZW перед іншими, які базуються на словниках, є те, що не обов’язково зберігати словник для наступного декодування. Алгоритм LZW є запатентованим і його використання при створенні нових програмних продуктів обмежується ліцензійними угодами.

Міжнародний Консультативний комітет з телеграфії і телефонії (CCITT) розробив серію комунікаційних протоколів для факсимільної передачі чорно-білих зображень по телефонних каналах і мережах передачі даних. Ці протоколи офіційно відомі як стандарти Т.4 і Т.6 CCITT, але більш розповсюджена їхня назва – стиск CCITT Group 3 і Group 4 відповідно. Іноді кодування CCITT називають кодуванням за алгоритмом Хафмена. Це простий алгоритм стиску, запропонований Девідом Хафменом у 1952 році. Стандарти Group 3 і Group 4 – це алгоритми стиску, спеціально розроблені для кодування однобітових даних зображення. Алгоритми CCITT не є адаптивними, тобто не настоюються для кодування кожного растра з оптимальною ефективністю. У них використовується фіксована таблиця кодових значень, що були обрані спеціально для представлення документів, які підлягають факсимільній передачі. Перед початком кодування здійснюється частотний аналіз коду документу і виявляється частота повтору кожного з символів. Символи, які частіше зустрічаються, кодуються меншою кількістю розрядів. При використанні кодування за схемою Хафмена треба разом із закодованим текстом передати відповідний алфавіт, але для великих фрагментів надлишковість не може бути значною. 

JPEG (Joint Photographic Experts Group – об’єднана група експертів по фотографії) є методом стиску, що дозволяє стискати дані багатоградаційних зображень (фотографій, телевізійних заставок, іншої складної графіки) з піксельною глибиною від 6 до 24 біт з задовільною швидкістю й ефективністю. На відміну від інших методів стиску JPEG не є одним алгоритмом. JPEG може налаштовуватися на відтворення дуже маленьких стиснутих зображень поганої якості, але проте придатних для більшості програм, і в той же час дозволяє робити стиснені зображення дуже високої якості, обсяг даних яких набагато менше, ніж в оригінальних нестиснених даних. JPEG, як правило, супроводжується втратами. Схема JPEG заснована на відкиданні інформації, яку важко помітити візуально. Невеликі зміни кольору погано розпізнаються оком людини, а от незначні зміни інтенсивності (світліше чи темніше) – краще. Виходячи з цього, кодування з втратами JPEG прагне до дбайливого поводження з напівтоновою частиною зображення, але більш вільно поводиться з кольором. При цьому анімація, чорно-білі ілюстрації і документи, а також типова векторна графіка, як правило, стискуються погано. В даний час JPEG стали використовувати для стиску “живого” відео, однак стандарт не містить ніяких положень щодо такого застосування. Обсяг стиснутих даних залежить від змісту зображення. Міра стиску зображення з фотографічною якістю може становити від 20:1 до 25:1 без помітної втрати якості. Звичайно ж, настільки високий показник стиску супроводжується відмінністю від оригіналу, але вона настільки незначна, що якість зображення все-таки залишається досить високою. Зображення, що містять великі області одного кольору, стискуються дуже погано. JPEG вводить у такі зображення артефакти (недоліки, вади), особливо помітні на суцільному фоні. Це значно погіршує якість зображень у порівнянні з традиційним методом стиску без втрат. Процес стиску за схемою JPEG поділяється на кілька етапів:

· перетворення зображення в оптимальний колірний простір;

· субдискретизація компонентів колірності усередненням груп пікселів;

· застосування дискретних косинусних перетворень для зменшення надлишковості даних зображення;

· квантування кожного блоку коефіцієнтів дискретних косинусних перетворень із застосуванням вагових функцій, що оптимізовані з урахуванням візуального сприйняття людиною;

· кодування результуючих коефіцієнтів (даного зображення) із застосуванням алгоритму Хафмена для видалення надлишковості інформації.

ART – це оригінальний алгоритм стиснення, що був створений і продається фірмою Johnson-Grace. Як і при роботі з алгоритмом JPEG, міра стиску в ART регулюється, а установка високого її значення може викликати втрати даних. Існує і режим кодування без втрат. Фірма Johnson-Grace продає ART як універсальний компресор для online-сервісів, а в перспективі планує адаптувати його для підтримки звуку, анімації і повномасштабного відеозображення. Хоча детальний опис цього алгоритму тримається в таємниці, Johnson-Grace випустила ряд документів описового характеру. Мета алгоритму – аналіз зображення і виявлення ряду його ключових ознак (колір, завади, межі, особливості, що повторюються), яким потім привласнюються пріоритети відповідно до відносної ваги кожної ознаки у вмісті зображення. Для класифікації і призначення пріоритетів ознакам стисненого зображення в програмі використовується нечітка логіка. Повторювані особливості виявляються і зв'язуються в зображенні оригінальним методом, розробленим самою фірмою. Компоненти зображення квантуются, при цьому низкопріоритетні ознаки ігноруються. Як і при використанні алгоритму JPEG, міра втрати інформації підвищується пропорційно росту міри стиску і компенсується певною надлишковістю. ART-зображення можуть бути багаторівневими. Це значить, що їх можна передавати поетапно по модемних лініях з низькою пропускною здатністю. Крім того, алгоритм забезпечує майже миттєве, хоча і низькоякісне, відображення на пристрої виведення клієнта. Потім, по мірі прийому даних і поступової візуалізації, якість зображення підвищується.

Фрактальне кодування засноване на тім факті, що всі природні і більшість штучних об'єктів містять надлишкову інформацію у виді однакових, повторюваних малюнків, які називаються фракталами. Процес кодування, що перетворює зображення в сукупність математичних даних, вимагає винятково великого обсягу обчислень. В залежності від роздільної здатності і вмісту вхідних растрових даних, якості зображення, часу стиснення і розміру файлу процес стиснення одного зображення може зайняти від декількох секунд до декількох годин навіть на дуже швидкодіючому комп'ютері. Декодування фрактального зображення – процес набагато більш простий, тому що вся трудомістка робота була виконана при пошуку всіх фракталів під час кодування. В процесі декодування потрібно лише інтерпретувати фрактальні коди, перетворивши їх у растрове зображення. Тому фрактальний метод доцільно використовувати тоді, коли дані зображень безупинно розпаковуються, але ніколи не стискуються. Фрактальний метод забезпечує легкість масштабування зображення без введення артефактів і втрати деталей та невеликий розмір стиснених даних але супроводжується втратами. 

Формати графічних і анімаційних файлів

Для зберігання зображень в комп’ютерній графіці використовують декілька десятків форматів файлів. Деяка частина з них стала стандартами і використовується в більшості графічних програм. За типами графічні формати можна розділити на:

· растрові формати – призначені для зберігання растрових даних;

· векторні формати – призначені для зберігання векторних даних;

· метафайлові формати – можуть зберігати як растрові, так і векторні дані;

· формати сцени – містять додатково інструкції, що дозволяють програмі візуалізації відновити зображення цілком;

· формати анімації – прості дозволяють відображати зображення в циклі одне за іншим, а більш складні зберігають початкове зображення та різниці між двома зображеннями, які послідовно відображаються;

· мультимедійні формати – призначені для зберігання даних різних типів (графіки, звуку, відео) в одному файлі;

· тривимірні формати – містять опис форми і кольору об’ємних моделей.

Детальний розгляд форматів графічних файлів приведений в [4]. Далі приведемо коротку загальну характеристику найбільш розповсюджених форматів графічних і анімаційних файлів.

Формат GIF (розширення імені файлу .GIF). GIF (Graphics Interchange Format – формат взаємообміну графікою) є растровим форматом і розроблявся для мереж з низькими швидкостями передачі даних. Він став першим графічним форматом, що підтримується Web. GIF здатен ефективно стискати графічні дані, використовуючи алгоритм LZW, який полягає в стисканні ряду однакових символів в один символ, помно¬жений на кількість повторень. Анімаційні файли GIF дозволяють в одно¬му файлі зберігати декілька зображень, які відтворюються послідовно. 

Формат GIF стандартизований в 1987 році як засіб збереження стиснених зображень з фіксованою (256) кількістю кольорів. Остання версія формату GIF89а дозволяє виконувати черезрядкове завантаження зображень і створювати малюнки з прозорим фоном. Обмежена кількість кольорів обумовлює його використання переважно в електронних публікаціях. До достоїнств динамічних файлів GIF відносять невеликий об’єм файлу за рахунок стискання (до 40%), він не вимагає постійного зв’язку з сервером і повторного звертання до сервера, його просто розмістити на сторінці. Однак його палітра не перевищує 256 кольорів, він забезпечує гірше стискання фотографій, ніж JPEG, не підтримується броузерами в повному обсязі.

Формат JPEG (розширення імені файлу .JPG). JPEG призначений для зменшення розмірів файлів растрових зображень, що мають плавні переходи кольорових тонів і відтінків. Дозволяє регулювати співвід¬ношення між мірою стискання файлу і якістю зображення. JPEG стискує зображення, зберігаючи його повну чорно-білу версію і більшу частину колірної інформації. Так як зберігається не вся колірна інформація, JPEG є форматом зі втратами, що проявляється, особливо в сильно стиснених файлах, в вигляді розмитого або випадкового розподілення пікселів. 

На відмінність від алгоритму стискання GIF, який аналізує файли по рядках, JPEG розбиває зображення на області близьких кольорів. Якщо використовувати формат JPEG для різкої графіки з великими областями одного і того ж кольору, то звичайно отримують погані результати. Прогресивні файли JPEG подібні на черезрядкові файли GIF тим, що вони визначають спосіб виводу зображення на екран при завантаженні (завантажують різні області графічного файлу одночасно). При цьому користувач може бачити, що містить зображення ще до того, як весь файл буде повністю завантажений. JPEG не дозволяє включати в файл більше одного зображення, тому анімація JPEG не дуже поширена в Web. Якщо потрібно відтворити послідовність файлів JPEG в одному і тому ж місці Web-сторінки, можна використати сценарій або додаток, що завантажується, написані на Java. Однак Java-аплет може вимагати багато часу для ініціалізації і виконання на повільних комп’ютерах. JPEG найбільше всього підходить для фотогра¬фій або графіки зі складними тінями та ефектами освітлення і використо¬вується в Web для фотографій товарів, об’ємних зображень і графіки з ефектами освітлення.

Формат PNG (розширення імені файлу .PNG). PNG (Portable Network Graphics – мережева графіка, що переноситься) є растровим, стандартизований в 1995 році і призначений для публікації зображень в Інтернеті. Розробка PNG була викликана тим, що в 1994 році фірма Unisys, винахідник методу стискання GIF, заявила, що буде вимагати плату зі всіх розробників програмного забезпечення, яке підтримує формат GIF. Потенціальні витрати, пов’язані з використанням формату GIF, разом з недоліками формату JPEG привели до необхідності розробки нового графічного формату, який був би безоплатним і поліпшив би параметри форматів JPEG та GIF. 

PNG підтримує три типи зображень – кольорові з глибиною 8 або 24 біти і чорно-білі з градацією 256 відтінків сірого. Стискання інформації здійснюється без втрат, передбачені 254 рівня альфа-каналу та черезрядкова розгортка. Вважається, що PNG забезпечує краще стискання, ніж GIF (на 10 –30 %), що залежить від якості кодувальника. Специфікація формату PNG включає можливості автоматичної корекції кольорів при перенесенні зображень між апаратними платформами і ефектів змінної прозорості. 

Формат TIFF (розширення імені файлу .TIF). TIFF (Tagged Image File Format – формат файлу ознакових зображень) є растровим і призначений для збереження зображень високої якості та великого розміру. Забезпечує зберігання чорно-білих зображень та зображень з глибиною кольору 8, 16, 24 і 32 біт. Підтримується більшістю графічних, верстальних і дизайнерських програм та переноситься між платформами IBM PC та Apple Macintosh. Починаючи з версії 6.0 в форматі TIFF можна зберігати відомості про маски (контури обтравки) зображень. Для зменшення розміру файлу використовується вмонтований алгоритм LZW.

Формат Windows Bitmap (розширення імені файлу .BMP або .DIB). Windows Bitmap (бітова карта Windows) – формат растрових зображень, що підтримується Windows–сумісними програмами. Дозволяє використовувати палітри в 2, 16, 256 кольорів або повну палітру в 16 млн. кольорів.

Формат PCX (розширення імені файлу .PCX). Растровий формат PCX використовується розповсюдженим графічним редактором Paintbrush та підтримує палітри в 2, 16, 256 кольорів або повну палітру в 16 млн. кольорів. В зв’язку з відсутністю можливості зберігати зображення, розділені на кольори, недостатністю моделей кольорів та наявністю інших обмежень в даний час вважається застарілим. 

Формат WMF (розширення імені файлу .WMF). WMF (Windows MetaFile – метафайл Windows) підтримує векторну і растрову графіку у середовищі Windows, використовуючи палітри в 65 тис. і 16 млн. кольорів. У файлі використовуються ті самі команди опису графіки, які використовує сама Windows для побудови графічних зображень. Може відкриватись як у векторних, так і растрових графічних редакторах. Однак відсутність засобів для роботи зі стандартизованими палітрами кольорів, що прийняті в поліграфії, та інші недоліки обмежують його використання.

Формат CGM (розширення імені файлу .CGM). CGM (Computer Graphics Metafile) підтримує векторну і растрову графіку з використанням повної палітри в 16 млн. кольорів та палітри зі змінною кількістю кольорів. Він орієнтований на складні та високохудожні зображення, створює компактні файли та підтримує більше одного зображення в файлі. 

Формат EPS (розширення імені файлу .EPS). EPS (Encapsulated PostScript) описує як векторні, так і растрові зображення на мові PostScript фірми Adobe, яка є універсальною. В файлі одночасно може зберігатись як векторна, так і растрова графіка, шрифти, контури обтравки (маски), параметри калібрування обладнання, профілі кольору. Для відображення векторного вмісту використовується формат WMF, а растрового - TIFF. Але екранна копія тільки в загальних рисах відображає реальне зображення. Дійсне зображення можна побачити тільки після друку, за допомогою спеціальних програм перегляду або після перетворення файлу в формат PDF в додатках Acrobat Reader та Acrobat Exchange.

Формат PDF (розширення імені файлу .PDF). PDF (Portable Docu-ment Format – формат документів, що переносяться) є апаратно незалежним і призначений для зберігання документів, однак його можливості забезпечують ефективне представлення зображень. Потужний алгоритм стискання з засобами керування підсумковою роздільною здатністю зображень забезпечує компактність файлів при високій якості ілюстрацій.

Формат PSD (розширення імені файлу .PSD). PSD (PhotoShop Document - документ програми Adobe Photoshop) є одним з потужних за можливостями зберігання растрової графічної інформації. Він дозволяє запам’ятовувати параметри пластів, каналів, міри прозорості, множини масок і підтримує 48-бітове кодування кольору, розділення кольорів і різноманітні моделі кольору. Однак відсутність ефективного алгоритму стискання інформації приводить до великого об’єму файлів. 

Формат PhotoCD (розширення імені файлу .PCD). PCD розроблений фірмою Kodak для зберігання цифрових растрових зображень високої якості. Внутрішня структура файлу забезпечує зберігання зображень з фіксованими величинами роздільної здатності, тому розміри будь-яких файлів незначно відрізняються один від одного і знаходяться в діапазоні 4-5 Мбайт. Кожній роздільній здатності присвоєний власний рівень, що відраховується від базового (Base), який складає 512´768 точок. Всього в файлі п’ять рівнів від Base/16 (168´192) до Base´16 (2048´3072). При початковому стискуванні первинного зображення використовується метод субдискретизації, практично без втрати якості. Потім обчислюються різниці Base - Base´4 і Base4 - Base´16. Підсумковий результат записується в файл. Для відновлення інформації з високою роздільною здатністю виконується зворотне перетворення. 

Фліки (розширення імені файлу .FLA; .FLI; .FLC; .FLH; .FLT; .FLZ). Фліки є форматами анімаційних файлів. Усі дані в цих файлах групуються у фрейми (frame). Фрейм - це один кадр фільму. Фрейми складаються з так званих блоків. Блоки файлу і містять у собі всю інформацію, необхідну для програвання фільму. На початку блоку, як і кожного фрейму, вказується його розмір і його тип, тому що коли тип блоку чи фрейму невідомий, то їх можна просто пропустити. 

В основі дельта-стиску, що використовується у фліках, лежить ідея зберігати тільки відмінності одного кадру від іншого. Це дозволяє програвати файли навіть на повільних відеоадаптерах, тому що потрібно виводити тільки частину зображення. Самі дані стискаються за схемою RLE. Перший фрейм містить повне зображення, відносно якого і будуються відмінності інших фреймів. 

Сімейство фліків:

· .FLI (розмір: до 320 ´ 200; палітра 256 кольорів);

· .FLC (розмір: будь-який; палітра 256 кольорів);

· .FLH (розмір: будь-який; колір: 15 біт на точку 5-5-5;

· .FLT (розмір: будь-який; колір: 24 біта на точку);

· .FLZ (розмір: будь-який; колір: будь-який; замість RLE-компресії використовується LZW- компресія, як у ZIP).

Недоліком даних форматів фільмів є відсутність звукового супроводу, який просто усунути в конкретній реалізації, ввівши при програванні фільму звуковий супровід. Також недоліком є відсутність опорних кадрів, але цей недолік також просто усунути, створивши утиліту для розміщення у файлі опорних кадрів і вказівників на ці кадри. Достоїнствами даного формату вважається його поширеність, простота створення в ньому анімаційних файлів та досить висока міра стиснення. Фліки використовуються в анімаційних програмах, комп’ютерних іграх і додатках САПР, де потрібно виконувати тривимірні операції з векторними даними. Вони найкращим чином пристосовані для зберігання анімаційних послідовностей, створених за допомогою комп’ютера або намальованих вручну.

Формат CDR (CorelDraw) використовується програмою CorelDraw, дозволяє записувати векторну і растровий графіку, текст. Файл у форматі CDR може мати кілька сторінок. 

Формат IFF (Interchange File Format) – растровий універсальний формат, який забезпечує об’єднання і збереження даних різного типу (нерухомих зображень, звуку, музики, відео і тексту). Файли цього формату практично повністю складаються з порцій – структур даних, які вміщують 4-байтовий ідентифікатор, 4-байтове значення розміру і блок даних. Порції можна вкладати одна в одну. Для стиснення використовується алгоритм RLE. На основі формату IFF розроблений тривимірний векторний і анімаційний формат TDDD (Turbo Silver 3D Data Description). 

На жаль, не існує універсального формату, який можна було б рекомендувати на всі випадки життя. Якщо ваше завдання - забезпечити обмін даними між програмами, оптимальний формат приходиться підбирати методом проб і помилок.
Урок № 2  Методи анімацій. Принципи анімацій
Методи анімацій

Методи анімації визначають спосіб утворення як елементів анімаційних послідовностей, так і самих послідовностей. Розглянемо найбільш поширені методи анімації. 

Класична анімація являє собою почергову зміну малюнків, кожний з яких намальований окремо (принцип мультфільму). Цей метод є трудомістким через необхідність окремого створення кожного малюнка. 

Лялькова анімація полягає у тому, що в просторі розміщуються об’єкти і кадр фіксує їхнє положення. Потім положення об’єктів змінюється і знову фіксується наступним кадром. 

Спрайтова анімація - це анімація, реалізована за допомогою мови програмування чи спеціального інструментального засобу. У спрайтовій анімації відсутнє поняття кадру (принцип рухливих ігор). Майже завжди базується на роботі з “прозорим” кольором. 

Морфінг полягає в перетворенні одного графічного образа в інший. Часто виконується програмно. При програмній реалізації морфінгу генерується задане число проміжних кадрів, що забезпечує плавний перехід початкового образа в кінцевий. 

Анімація кольором передбачає зміну тільки кольору об’єктів при незмінному їх положенні. Часто виконується програмно. 

3D-анімація створюється за допомогою спеціальних програм (ЗD Studio МАХ, Мауа, РоvRау, LightWave та ін.). Підсумкове зображення тут отримують шляхом візуалізації сцени, яка включає набори об’єктів, джерел світла, текстур та камер. 

Метод ключових кадрів (кеуframing) є найбільш розповсюдженим способом створення анімації. Ключовою подією може бути не тільки зміна параметрів одного з можливих перетворень об’єкта (положення, повороту чи масштабу), але також зміна кожного з параметрів, що допускають анімацію (властивості джерел світла, матеріалів і ін.). Після визначення всіх ключових кадрів система комп’ютерної анімації виконує автоматичний розрахунок подій анімації для всіх інших кадрів, що займають проміжне положення між ключовими – проміжних кадрів. 

Процедурна анімація використовується для моделювання рухів чи ефектів, які важко відтворити за допомогою ключових кадрів. У процедурній анімації розраховують поточні значення параметрів анімації, ґрунтуючись на початкових значеннях, заданих користувачем, і на математичних виразах, що описують зміну параметрів у часі. Цей метод дозволяє виконувати якісні анімації. Часто процедурна анімація використовується для створення різноманітних фізичних ефектів. 

Інверсна і пряма кінематика – методи анімації зв’язаних в ієрархічний ланцюжок об’єктів. Пряма кінематика полягає в тому, що переміщення об’єкта-батька впливає на весь ланцюг об’єктів-нащадків. Виглядає це так, начебто опорні точки дочірніх об’єктів зв’язані з опорними точками батьківського об’єкта твердими важелями. Якщо переміщається батьківський об’єкт, дочірній об’єкт також буде переміщатися, не змінюючи свого положення щодо об’єкта-предка. Якщо батьківський об’єкт повертається, то дочірній переміщається і повертається таким чином, що його положення й орієнтація стосовно батьківського об’єкта залишаються незмінними. Хоча дочірні об’єкти при перетворенні батьківського об’єкта переміщаються і повертаються, ключі анімації для них не генеруються. Перетворення дочірніх об’єктів виконується автоматично. Для інверсної кінематики рух задається переміщенням самого молодшого об’єкта-нащадка, що змушує весь інший ланцюжок переміщатися відповідно до обмежень на роботу зчленувань об’єктів. Зокрема, це можуть бути обмеження на обертання і на ковзання. Можна обмежити діапазон дії цих зчленувань будь-якими осями координат, розміром кутового сектора чи відстанню. Виконуючи настроювання параметрів зчленувань, таких як пріоритетність, наявність і сила тертя і т.п., можна домогтися побудови реалістичних рухів для складних багатоланкових об’єктів. 

Захоплення руху (Моtіоп Сарture) – новий напрямок в анімації, який дає можливість передавати природні реалістичні рухи в реальному часі. Маленькі легкі датчики прикріплюються на живого актора в тих місцях, що будуть приведені у відповідність з контрольними точками комп’ютерної моделі для введення й оцифровування руху. Координати актора і його орієнтація в просторі передаються графічній станції, і анімаційні моделі оживають. 

Програмна анімація основана є результатом виконання програми. 

Блокова анімація полягає в почерговому перемальовуванні і очистці цифрового зображення в різних його місцях - блоками. Якщо від кадру до кадру змінюється тільки маленька частина сцени - наприклад, якщо фон зображення залишається незмінним, коли об’єкт рухається по ньому - тоді альтернативний підхід складається в перемальовуванні лише тієї частини екрану, яка змінюється, і це потрібно робити швидше, ніж людське око може цей процес побачити. 

Маскова анімація є комбінацією блокової анімації і використання масок. Для виведення на екран комп’ютера об’єктів складної форми без “зачеплення” фону частіше використовують “маски”. Об’єкт описується двома прямокутними масивами чисел: маска АND (двійкове І) і маска ХОR (двійкове виключення АND). Маска АND обнуляє ті пікселі фону, які відносяться до об’єкта, залишаючи інший фон незачепленим. Накладення маски АND послідовно за маскою ХОR малює об’єкт на очищених маскою ХОR пікселях, не змінюючи інший фон. Маски АND і ХОR дозволяють виділяти (вставляти і забирати) об’єкт в прямокутній зоні екрану. Циклічно копіюючи фон з під об’єкта до невидимого буфера на екрані, малюючи об’єкт на екрані з використанням масок ХОR і АND і стираючи його при встановленні фону, програма може утворювати анімацію. 

Принципи анімацій

Якість анімації – досить відносний показник. Раніше вона оцінювалась кількістю кадрів у секунду, однак сьогодні будь-яка, навіть сама маленька студія не робить менше 8 кадрів у секунду, що в три рази менше стандарту для PAL сигналу - 25 кадрів у секунду. Чи потрібні всі 25 кадрів у секунду? Людський мозок не встигає сприймати всю послідовність з 25 кадрів, він лише схоплює рух, а для цього досить 3-5 кадрів у секунду. Виходить, якість майже не залежить від кількості кадрів у секунду, тоді від чого ж вона залежить? Раз мозок уловлює тільки рух, а не послідовність кадрів – значить від якості передачі руху. Вона у свою чергу залежить від досвіду художника і техніки, яку він використовує. Правильно намальовані кадри здаються живими навіть окремо - немов персо¬наж уже рухається, і хоча ми не бачимо руху, він відчувається підсвідомо. 

Принципи є основним інструментом анімації і повинні застосовуватися скрізь, де тільки можна. Деякі з них часом стають перешкодою, коли художник працює в емоційному пориві. Проте, коли емоції відринуть, знання цих принципів дозволить йому робити анімацію сцени інтелектуально, логічно та художньо, як і емоційно. 
Дісней для створення своїх фільмів використовує близько 12 основних принципів анімації. От основні з них. 

Стиск і розтягання (squash&stretch). Це, мабуть, одне із самих значних відкриттів Діснея за всю історію анімації. Цей принцип зробив революцію у світі анімації. Завдяки стиску і розтяганню персонажі вже не виглядали “кам'яними”. Суть принципу полягає в тому, що живе тіло завжди стискується і розтягується під час руху. Перед стрибком персонаж стискується як пружина, а в стрибку навпаки розтягнутий. Головним правилом при цьому є постійний об’єм – якщо персонаж розтягли (stretch – деформація по осі Y), те він обов'язково повинен бути стиснутий для збереження об’єму свого тіла (squash - деформація по осі X). 

Випередження (чи відкатний рух). У реальному житті для здійснення якої-небудь дії, людині часто приходиться робити підготовчі рухи. Наприклад, перед стрибком людині необхідно присісти, для того щоб кинути що-небудь, руку необхідно завести назад. Такі дії називаються відкатними рухами, тому що перед тим, як зробити щось, персонаж як би відмовляється від дії. Такі рухи підготовлюють глядача до наступної дії персонажа і додають інерцію рухам. 

Сценічність (staging). Для правильного сприйняття персонажа глядачами всі його рухи, пози і вирази обличчя повинні бути гранично прості і виразні. Цей принцип заснований на головному правилі театру. Камера повинна бути розташована так, щоб глядач бачив усі рухи персонажа, а одяг не повинний ховати його рухи, адже усе робиться для глядача. 

Від пози до пози (Pose to Pose). До відкриття цього принципу рухи малювалися наскрізь, тобто художник знав сюжет і малював кадр за кадром для виконання якої-небудь дії. Такий метод називався “прямо вперед” (straight ahead), при його використанні результат було важко передбачити, тому що сам художник ще не знав, що він намалює. Принцип “від пози до пози” передбачає попереднє компонування рухів - художник малює основні моменти і розташовує персонажа на сцені, а вже потім асистенти промальовують усі кадри руху. Цей підхід різко збільшив продуктивність, тому що заздалегідь планувалися всі рухи і результат був саме таким, яким задумувався. 

Наскрізний рух і захльост (follow through і Overlapping actions). Суть принципу полягає в тому, що рух ніколи не повинний припинятися. Існують такі елементи, як вуха, хвости, одяг, що постійно повинні знаходитися в русі. Наскрізний рух забезпечує безперервність руху і плавність переходу фаз, наприклад, з бігу в крок і навпаки. Рух окремих елементів тіла в той час, як тіло вже не рухається, називається захльостом. Захльост виражається в сценах зміни фаз руху. Якщо персонаж різко гальмує після бігу, м'які частини тіла не можуть зупинитися разом із твердими і відбувається невеликий захльост (волосся, вуха, хвости і т.д). При ходьбі рух починається зі стегон, а вже потім поширюється до щиколоток. Для здійснення такого руху художники використовують щось начебто ієрархії членів тіла. Така ієрархія дозволяє зв'язати всі рухи персонажа в окремий ланцюжок і жорстко описати правила, за якими він рухається. 

“Повільний вхід” і “повільний вихід” (Ease In & Ease out). Цей принцип прямо зв'язаний з четвертим принципом. Розробляючи виразні пози, художник вкладає всю свою майстерність, тому що саме ці моменти повинні бути довше видні глядачу. Для цього асистенти домальовують рухи так, що більше всього кадрів виявляється поруч із ключовими позами. При цьому персонаж як би проскакує рух від одного компону¬ван¬ня до іншого, повільно виходячи з пози і сповільнюючись в іншій. Як я і говорив вище: мозок не уловлює послідовність, він уловлює тільки рух. 

Рухи по дугах (arcs). Цей принцип є другим революційним відкриттям Діснея. Живі організми завжди пересуваються по дугоподібних траєкторіях. До цього застосовувався метод прямолінійного руху, у зв'язку з чим рухи виглядали механічними - як у роботів. Іноді здається, що при різких рухах цей принцип не дотримується, тому що рухи йдуть по прямій. Однак, це тільки так здається, тому що навіть у самих різких рухах траєкторії мають дугоподібний характер, хоча і більш наближений до прямої. В основному характер траєкторії залежить від швидкості руху. Якщо персонаж рухається різко, траєкторія розпрямляється, якщо ж повільно, то траєкторія ще більше загинається. 

Другорядні дії (Secondary actions). Часто для додання персонажеві більшої виразності використовують вторинні рухи. Вони служать для того, щоб акцентувати увагу на чому-небудь. Вторинні дії одержали широке поширення у світовій анімації. Завдяки їхньому використанню персонажі стають більш живими й емоційними. 

Розрахунок часу (Timing). Цей принцип дозволяє додати персонажеві вагу і настрій. Як глядач оцінює вагу персонажів? Вага персонажа складається з таких факторів, як швидкість переміщення й інерт¬ність. Для того, щоб персонаж рухався у відповідності зі своєю вагою, художник розраховує час руху і захльосту для кожного персонажа. При розрахунку часу враховуються вага, інертність, обсяг і емоційний стан героя. Настрій також передається швидкістю рухів персонажа. Так, подавлений персонаж рухається дуже в'яло, а натхннений досить енергійно. 

Перебільшення. Уолт Дісней завжди жадав від своїх працівників більшого реалізму, насправді прагнучи більше до “карикатурного реалізму”. Якщо персонаж повинний був бути сумним, він вимагав, щоб його робили похмурим, щасливого ж потрібно було робити сліпуче сяючим. За допомогою перебільшення збільшується емоційний вплив на глядачів, однак, персонаж набуває карикатурного вигляду. 

Професійний малюнок. Малюнок – основа усього. На студії Діснея досить часто зустрічаються таблички, наприклад: “Чи відчувається у твоєму малюнку вага, глибина і рівновага?”. Принцип професійного малюнка також забороняє малювати “близнюків”. “Близнюками” називають будь-які елементи малюнка, що повторюються двічі або є симетричними. “Близнюки” дуже часто з'являються мимо волі художника, він малює дві руки у тому самому положенні, не помічаючи цього. 

Привабливість (Appeal). Привабливість персонажу - шлях до успіху усього фільму. Як же визначити, чи привабливий персонаж? Привабливим може бути будь-який предмет, якщо дивишся на нього з задоволенням, виявляючи в ньому простоту, чарівність, гарний дизайн, зачарування і магнетизм. Від привабливого персонажу неможливо відірвати погляд. Навіть самий противний герой фільму повинний бути привабливим, щоб утримати глядачів біля екрану. 

До інших принципів, які є основою анімації, відносять: Обриси і Форма (Shape and Form); Анатомія (Anatomy); Модель і Персонаж (Model or Character); Вага (Weight); Лінія і Силует (Line and Silhouette); Дія і Реакція (Action and Reaction); Перспектива (Perspective); Напрямок (Direction); Напруга (Tension); Площини (Planes); Щільність (Solidity); Пульс і Ритм (Beat and Rythem); Глибина й Об’єм (Depth and Volume); Прямі і Криві (Straights and Curves); Первинні і Вторинні дії (Primary and secondary action); Деталі (Details); Текстура (Texture); Спрощення (Simplification); Позитивні і Негативні форми (Positive and negative shapes). 

Анатомія дуже важлива в малюнку, незалежно від того, чи є об'єкт уявним, чи ні. Незважаючи на те, що персонаж чи його дії можуть бути перебільшені або скарикатурені, анатомія є тим елементом, що майже не міняється. Лікоть залишається ліктем – він згинається у визначеному місці, у визначеному напрямку і має конкретні обмеження. У вас, звичайно ж, є невеликий вибір, однак навіть карикатурний герой повинний бути в міру “реальним”, щоб не втратити правдоподібність і довіру глядача. І це непроста справа – перевести знання анатомії в намальований мультиплікаційний персонаж. Для прикладу, якщо ви намалювали руку, то лікоть на ній не може згинатися в неправильному місці, незалежно від того, як добре він намальований. Знаючи анатомію, можна малювати людей, правильно вибираючи їхньої пози і не допускаючи грубих анатомічних помилок. Вибір пози при малюванні дуже важливий, адже чим зручніша поза, у якій знаходиться персонаж, тим реальніше і правдоподібніше виглядає малюнок. 

Сила ваги – один з найважливіших принципів анімації. Будь-який предмет має визначену вагу і буде діяти відповідно до неї. Дуже легко втратити увагу глядачів, намалювавши пера, що падають як цеглини, чи цеглини, що падають як пера. Порушенням цих правил може бути досягнутий деякий гумор, однак цей метод варто застосовувати тільки там, де потрібний гумор чи спеціальний ефект. Дотримання в коротких фільмах принципів законів ваги, швидкості, а також стиску і розтягнення є гарним тоном. 

Урок №3 GIF- анімація
GIF-анімація використовує можливість GIF-формату зберігати у файлі декілька зображень. Якщо в GIF-файлі міститься декілька зображень, то вони будуть показані по черзі, як невеликий фільм. Однак на відміну від звичайного фільму, у якому швидкість відтворення визначається кількістю кадрів за секунду, у GIF-файлі зберігається ряд параметрів, що визначають, яким чином і як довго кожне зображення буде демонструватися. Крім того, зображення GIF-файлу можуть бути різного розміру і розміщені в потрібній позиції екрану незалежно від зображень інших кадрів.

Кожен GIF-файл містить таблицю індексів кольорів, яку називають індексною колірною палітрою. Вона визначає, які кольори використовуються в зображенні і який індекс відповідає кожному кольору. В залежності від способу збереження для індексу потрібно до 4 байтів даних, тому зображення з 256 кольорами має палітру розміром до 1024-х байт. 

В анімованих GIF-файлах використовують два типи палітр: глобальну (Global Palette), що визначає кольори кожного зображення анімації за замовчуванням, і локальну (Local Palette), яка є унікальною для кожного окремого кадру анімації. При додаванні зображення в GIF-анімацію можна вказати, яку з палітр варто використовувати. Однак не слід прагнути до зменшення розміру файлу, використовуючи тільки глобальну палітру. Щоб забезпечити високу якість анімації, для кадрів зображень, які значно відрізняються від основних чи хоча б від попереднього кадру, варто використовувати локальну палітру. 

Існує велике розмаїття програм для створення анімаційних GIF: Ulead GIF Animator, GIFFY, GIF Construction Set 32, Microsoft GIF Animator, Alchemy GIF Anіmator, Anіmated GIF Edіtor 95 та інші. Більш детально розглянемо особливості програми Ulead GIF Animator 5. 

В Ulead GIF Animator 5 кожен кадр іменується шаром (layer), що відрізняє термінологію цієї програми від термінології програмних продуктів інших фірм. Створити послідовність кадрів можна, створюючи зображення вручну, імпортуючи послідовність файлів чи вміст цілої папки, а також використовуючи оцифровану відеопослідовність. 

У вікні програми GIF Animator 5 представлені такі основні зони: ря¬док меню, головна панель інструментів, панель властивостей, робоча зона, панель інструментів малювання, панель менеджера об’єктів, панель кадрів. 

Робоча частина містить зону поточного кадру документу, яка розділена на три вкладки: 

· Edit (Редактирование) – тут можна сформувати і редагувати анімацію, маніпулюючи і переміщуючи об’єкти, а також виділяти певні зони для застосування до них ефектів;

· Optimize (Оптимизация) – можна працювати зі стисненою анімацією для оптимізації файлів з метою більш швидкої передачі по мережі;

· Preview (Предварительный просмотр) – дозволяє попередньо перегля¬дати результати анімації.

GIF Animator надає можливість редагування об’єктів безпосередньо в програмі. Різні інструменти дозволяють обирати специфічні зони в межах кадру або навіть в межах об’єкту, щоб керувати їх установками або добавляти нові зміни до об’єктів за допомогою інструментів Paintbrush (Кисть), Text (Текст), і Fill Tools (Заливка). 

Інколи потрібно відредагувати об’єкти в зовнішньому редакторі, наприклад, Ulead PhotoImpact, или Adobe Photoshop. Для того, щоб це зробити, необхідно зберегти файл і потім відкрити його в іншому редакторі. Замість цього можна вказати образ редактора, який буде об’єднаний з GIF-аніматором, скориставшись командою: Edit -> Favorite Image Editor -> Organize Favorite Image Editor. Потім потрібно вибрати програму з стандартної панелі, відредагувати файл в іншому редакторі і зберегти його, щоб повернутися до GIF-аніматора. 

Ulead GIF Animator підтримує імпорт більшe 30 розповсюджених форматів графічних файлів, зокрема таких, як GIF, JPEG, PCX, PSD, PCT, PNG, TGA, EPS, IFF, IMG, MAC, MSP, PCD і BMP, та забезпечує широку підтримку різних відеоформатів; прямий імпорт і перетворення AVI-файлів, файлів AutoDesk animation з розширеннями .FLI, .FLC, .FLX, файлів Quick Time Movie (.QT, .MOV). 

Команда File -> Add Video (Файл -> Добавить видео) відкриває однойменне вікно, у якому можна вказати файл-джерело, виконати його перегляд і одержати повну інформацію про імпортований файл, для чого варто клацнути на кнопці Info (Информация), після чого відкривається вікно властивостей відеофайлу. При імпорті можна вибрати ділянку відеопослідовності і задати початковий і кінцевий кадри. 

Вибір кнопки Animation Wizard (Мастер анимации) у вікні Startup Wizard (Мастер запуска) чи команди File -> Animation Wizard (Файл -> Мастер анимации) запускає Майстер анімації, у трьох послідовних вікнах якого вводиться необхідна інформація. У першому вікні за допомогою кнопок Add Image (Добавить картинку) і Add Video (Добавить видео) можна додати в анімацію файли, що містять малюнки чи відеопослідовності. В другому вікні вказується тип джерела, що містить текст і графіку чи фотографічне зображення. У третьому вікні задається число кадрів у секунду і відповідно час затримки в сотих частках секунди. Результатом роботи Майстра буде створення анімації з послідовності кадрів з локальними палітрами для кожного з них. 

Існує кілька способів зберегти анімацію. Найбільш очевидним способом є створення GIF-файлу, однак при цьому варто враховувати можливості його оптимізації. Крім того, анімацію можна зберегти у файлі, що виконується, для якого не потрібно програми-програвача, а також в одному з форматів відео. 

GIF Animator дозволяє також експортувати частину кадрів анімації зі створенням нового анімованого GIF-файлу або групи окремих GIF-файлів, що містять по одному кадру. GIF Animator дозволяє легко і просто створити HTML-код для GIF-файлу, який потім може бути розміщений на відповідній Web-сторінці. При цьому потрібно, щоб GIF-файл знаходився в тій же папці, що і Web-сторінка. 

GIF-анімація, що вставляється, може містити також гіперпосилання на задану URL-адресу. 

Існують три основних способи істотного скорочення розміру анімованого GIF-файлу: скорочення колірної палітри, зменшення кількості кадрів (шарів), оптимізація окремих кадрів анімації. При цьому варто пам'ятати, що головною метою є одержання якісної анімації для Web-сторінки, а не файлу мінімального розміру. Тому варто шукати компроміс між якістю анімації і розміром файлу для його швидкої передачі по мережі. 

Найкращим способом для скорочення колірної палітри є використання глобальної палітри Global Palette для завдання кольору окремих кадрів. Якщо якісь кадри незначно розрізняються за колірною гамою, то немає необхідності створювати для них локальну палітру Local Palette, а, використовуючи вкладку General (Общие) вікна Preferences (Установки), додати ці кольори в Global Palette. Для кадрів, що мають істотні роз¬ход¬ження в кольорі, створюють свої локальні палітри Local Palette, але вида¬ляють з них кольори, спільні з кольорами глобальної палітри Global Palette. 

Іншим способом скоротити розмір файлу є видалення окремих кадрів, які не є необхідними, якщо це не приводить до значного спотворення анімації при її відтворенні. Також варто звернути увагу на розмір кадрів. Якщо анімований об’єкт займає малу частину вікна, то немає потреби зберігати для нього кадри того ж розміру, що і фон. Тому для кадрів з об’єктом можна задати менший розмір, вказавши його положення на логічному екрані, що істотно скоротить загальний розмір GIF-файлу. 

Найбільш ефективним способом скорочення розміру файлу є оптимізація. 

При оптимізації GIF-анімації здійснюється видалення надлишкових кольорів з палітри, які не використовуються в зображеннях, з’являються тільки один раз або близькі до кольорів, які часто використовуються. Також здійснюється зміна Global Palette додаванням до неї кольорів локальних палітр, що дозволяє скоротити кількість використовуваних локальних палітр, та видалення повторюваних частин зображень у кадрах. 

Команди меню Video F/X (Видеоэффекты) дозволяють легко додати до анімації різні ефекти, але при цьому варто врахувати, що їхнє використання також збільшує розмір GIF-файлу. 

Процес створення анімації з послідовності файлів включає:

· запуск GIF-аніматора і у вікні Startup Wizard (Мастер запуска) вибір самостійного створення анімації (Blank animation);

· вибір командою File -> Add Images (Файл -> Добавить картинку) відразу кілька файлів (це можна здійснити також шляхом перетягування фалів з вікна Провідника Windows на робочу область вікна GIF-аніматора);

· перехід на вкладку Preview (Предварительный просмотр) для перегляду анімації;

· перехід на вкладку Optimize (Оптимизация) і здійснення оптимізації файлу.

Процес створення анімації з відеофайлу включає:

· запуск GIF-аніматора і у вікні Startup Wizard (Мастер запуска) вибір Open an existing video file (Создание анимации из видеофайла);

· для виділеного файлу у вікні Add video (Добавить видео) у полях Subject (Тема) і Description (Описание) вказуються короткі відомості про файл;

· відкриття вікна Duration (

· Продолжительность

) і при послідовному перегляді позначення мітками початку і кінця відповідних кадрів (якщо вставляється відеофайл цілком, то вікно Duration (

· Продолжительность

) можна не відкривати); 

· клацання на кнопці Open (Открыть) у вікні Add video (Добавить видео), при цьому всі виділені кадри відеофайлу послідовно розташовуються на панелі кадрів;

· додавання до анімації ефектів;

· збереження результату.

Висока якість і малий розмір вихідного файлу зробили в даний час програму Ulead GIF Animator 5.0 однією з самих популярних у Web- дизайнерів.

Урок № 4 Базові поняття Flash-технологій
Flash-технології, або технології інтерактивної Web-анімації, були започатковані компанією Macromedia, яка розвинула графічну програму для Web (FutureSplash), придбану в 1997 році у компанії Future Wave. Орієнтація на векторну графіку, як основний інструмент розробки, дозволила реалізувати всі базові елементи мультимедія – рух, звук та інтерактивність. До основних переваг Flash можна віднести:

· невеликий розмір файлів, що пов’язано з використанням векторної графіки і потужних алгоритмів стискання інформації; 

· усунення проблем сумісності між броузерами; 

· відсутність проблеми невідповідності розмірів екрану і сторінки (якщо задати розміри об’єктів через відсотки від розмірів самого екрану, масштабуються окрім елементів векторної графіки також вмонтовані графічні зображення); 

· наявність автоматичної підтримки антиаліазингу (згладжування контурів шляхом змішування сусідніх кольорів), що забезпечує красоту зображень; 

· наявність вмонтованої мови опису сценаріїв; 

· зручність, що забезпечується простотою інтерфейсу; 

· наявність засобів експортування зображень в найбільш розповсюдже¬ні графічні формати; 

· поширеність. 

Недоліками Flash є те, що вона поки-що не підтримує тривимірну графіку, програвач анімації забирає достатньо багато ресурсів процесора, а швидкість програвання залежить від розмірів екрану (для повільних процесорів невеликою буде швидкість роботи). Окрім цього Flash поступається за можливостями створення і редагування зображень, які надають поширені програми Photoshop та CorelDraw.

У Macromedia Flash існує два принципово різних способи анімувати що-небудь. Перший – прорисовувати кожен кадр самому, використовуючи Flash тільки як засіб, що дозволяє швидко перегортати ваші зображення, і другий – змусити Flash автоматично прораховувати проміжні кадри. 

Базовими поняттями Flash є кадри (frames), символи (symbols), шари (layers) і часова шкала (timeline). 

Часова шкала – основний інструмент при роботі з анімацією в Flash. На ній відображається інформація про шари, про те, які кадри є ключовими, а які генерує Flash. За допомогою часової шкали можна зрозуміти, які кадри містять дії чи мітки. Вона доз-воляє переміщувати ключові кадри і цілі шматки анімації. 
Елементами часової шкали є:
· маркер, що вказує на поточний кадр, який відображається у вікні; 

· шари – ліворуч знаходиться перелік шарів, під яким існують кнопки, що дозволяють додавати і видаляти шари. Кожен шар можна зробити невидимим і заборонити його для редагування; 

· шкала кадрів – поле, де ви можете додавати і видаляти прості і ключові кадри. Якщо викликати контекстне меню (натиснути на праву клавішу миші) на якому-небудь кадрі, ви побачите перелік дій, які можна зробити. На шкалі відображається інформація про кадри, що є ключовими (такі кадри позначаються чорними кружечками), що містять дії (буква “а” над кружечком) чи мітку (червоний прапорець, після якого йде назва мітки). Колір теж інформує про тип кадрів. Сірий колір – це кадри, які у точності повторюють ключовий кадр (keyframe). Синювате чи зеленувате підсвічування говорить про те, що кадри згенеровані Flash. І, нарешті, білий чи “порожній” смугастий простір говорять про те, що на цих кадрах нічого немає. 

· кнопки керування тінями – це кнопки, що дозволяють відображати сусідні кадри як би через кальку, щоб бачити різницю між попередніми і наступними кадрами. Можна задавати глибину такого відображення з обох боків від маркера. 

У Flash є два особливих типи шарів: шари, що містять траєкторії руху і шари-маски. 

Є досить велика кількість прийомів, у яких використовуються шари, але в Flash без них просто не можна обійтися по одній важливій причині: в один момент часу для кожного об’єкта анімації потрібний окремий шар. Об’єктом анімації вважається фігура чи символ. 

Анімація складається з послідовності кадрів. Кадр одного шару може бути як створеним вручну, так і згенерованим Flash. В зв’язку з тим, що сцени Flash складаються звичайно з декількох шарів, підсумкові “багатошарові” кадри можуть містити як згенеровані, так і “саморобні” шари. 

Ключові кадри (keyframes) Flash не може змінювати в процесі створення анімації. Проміжні кадри між ключовими вибудовує Flash. Існує два типи проміжних кадрів – кадри, побудовані на основі зміни геометрії (shape tweening) і кадри, побудовані на зміні символів (motion tweening). Кадри також можуть бути порожніми, тобто нічого не містити. 

Символи – одне з ключових понять у Flash. Символом може бути як найпростіша фігура чи їхнє об’єднання, так і ціла анімація (movie). Це дозволяє використовувати символи як могутній механізм створення абстракцій у Flash. Наприклад, символами можна зробити елементи якогось механізму, об’єднати їх в один символ, а потім створити сцену, де цей механізм буде рухатись. Існує три види символів: анімація або відеокліп (movie clip), кнопка (button) і зображення (graphic): 

· зображення являє собою символ, що складається з єдиного кадру, звідки випливає його статична назва. Якщо символ дійсно являє собою статичний об’єкт, краще зробити його зображенням; 

· кнопка в Flash є спеціально пристосованим під функції кнопки вид символу. У ньому міститься 4 кадри: Up, Over, Down, Hit, що відповідають таким станам кнопки: 

· Up – звичайний стан кнопки; 

· Over – коли курсор мишки знаходиться над кнопкою; 

· Down – коли курсор знаходиться над кнопкою і натиснута клавіша миші; 

· Hit – активна зона кнопки (не відображається). 

· анімація – це самий “повноцінний” тип символу. У ньому може бути будь-яка кількість кадрів. Символ цього типу може сприйматися як об’єкт типу Movie у ActionScript. 

Символи можуть бути вкладеними поза залежністю від типу. Це є самим головним їхнім достоїнством. Наприклад, можна зробити кнопку, що почне рухатися, коли над нею буде “пролітати” курсор миші, просто помістивши в кадр Over символ-анімацію. Для керування символами використовується бібліотека (Library). 

Фільм Flash може складатись з довільної кількості сцен, які можуть бути організовані в послідовність. Кожна сцена може містити необмежену кількість шарів. Порядкове розміщення шарів відображено на часовій шкалі: самий верхній шар розміщується на передньому плані робочого поля, а самий нижній – на задньому плані. Кожний шар також може бути пов’язаним з порядковим розміщенням об’єктів на ньому. На нижньому рівні шару завжди розміщуються не згруповані векторні лінії і фігури. Над ними, на верхньому рівні, знаходяться растрові зображення, текст, групи і екземпляри символів. Група являє собою один або декілька об’єктів, які були виділені і “згруповані”. Екземпляри символів можуть являти собою одну або декілька копій елементу, який зна-ходиться в бібліотеці. 
В залежності від закладених в проект функціональних мож-ливостей та призначення фільми Flash можуть бути дуже різноманітними і являти собою: 

· анімацію для Web-сторінок; 

· інтерактивні форми для Web-сторінок; 

· ігри в реальному часі для багатьох користувачів; 

· Web-вузли, повністю реалізовані в програмі Flash; 

· інтерактивні художні презентації; 

· Flash-фільми, що підтримують зворотний зв’язок з глядачем; 

· мультиплікації для Web; 

· мультиплікації для телевізійних передач; 

· музикальні автомати, що працюють в діалоговому режимі; 

· різноманітні екранні заставки, автономні презентації та ін. 

Урок № 5 Основні елементи інтерфейсу програми Flash MX
Інтерфейс Flash включає рядок меню, головну панель інстру¬ментів, панель інструментів малювання, часову шкалу, робочу область, де розміщене робоче поле, строку стану, панель запуску та інструментальні панелі. Окрім цього існують контекстні меню Flash, які з’являються при натискуванні на праву кнопку миші на вибраному на часовій шкалі, в бібліотеці або на робочому полі елементі, і повторюють більшість функцій і команд різноманітних меню, панелей і діалогових вікон. В зв’язку з тим, що дія значної частини пунктів меню і команд випливає з їх назви або аналогічна пунктам меню і командам поширених сучасних програмних продуктів, роз’яснення будемо приводити тільки там, де це має свою специфіку для Flash .

Рядок меню містить такі пункти: File (Файл); Edit (Правка); View (Вид); Insert (Вставка); Modify (Изменить); Text (Текст); Control (Управление); Window (Окно); Help (Справка).

Пункт меню File (Файл) містить такі підпункти: 
· New (Создать) – створення нового документа; 

· Open (Открыть) – відкриваються файли в форматах, що сумісні з Flash: .FLA, .SPA, .SSK, SWF. Рекомендується попередньо створю¬вати резервні копії файлів, створених в молодших версіях Flash; 

· Open as Library (Открыть как библиотеку) – відкривається файл фільму Flash, бібліотеку якого передбачається використати; 

· Open as Shared Library (Открыть как совместную библиотеку); 

· Close (Закрыть); 

· Save (Сохранить); 

· Save as (Сохранить как); 

· Revert (Вернуть) – повертання до збереженого останній раз варіанту фільму; 

· Import (Импорт) – доступними для імпортування є файли в форматах: .EPS, .AI, .AIF, .DXF, .BMP, .DIB, .EMF, .SWF, .SPL, .FH7, .FT7, .FT9, .GIF, .JPG, .MP3, .PNG, .MOV, .AU, .WAV, .WMF; зі встановленою програмою QuickTime 4: .PSD, .PCT, .PNTG, QTIF, .SGI, TGA, TIF; 

· Export Movie (Экспорт фильма) – забезпечується експортування фільму в один із форматів: .AI, .GIF, .BMP, .DXF, .EMF, .EPS, .SWF, .SPL, .SWT, .JPG, .PNG, .MOV, .WAV, .AVI, .WMF; 

· Export Image (Экспорт изображения) – забезпечується експортування зображень в один із форматів: .AI, .GIF, .BMP, .DXF, .EMF, .EPS, .SWF, .SPL, .SWT, .JPG, .PNG, .WMF; 

· Publish Settings (Параметры публикации); 

· Publish Preview (Предварительный просмотр публикации); 

· Publish (Публиковать); 

· Page Setup (Параметры печати); 

· Print Preview (Предварительный просмотр); 

· Print (Печать); 

· Send (Отправить) – викликає програму електронної пошти; 

· Exit (Выход). 

Пункт меню Edit (Правка) містить такі підпункти: 
· Undo (Отменить) – відміняє дію; 

· Redo (Повторить) – відміняє відміну дії; 

· Cut (Вырезать); 

· Copy (Копировать); 

· Paste (Вставить); 

· Paste in Place (Вставить на место) – вставка здійснюється точно в те місце, звідки об’єкт був вирізаний чи скопійований; 

· Paste Special (Специальная вставка) – вставка в певному форматі, дозволяє створити зв’язок з інформацією іншого фільму; 

· Clear (Очистить) – виділені об’єкти видаляються з робочого поля без копіювання до буферу обміну; 

· Duplicate (Дублировать) – повторюються виділені об’єкти без використання буферу обміну; 

· Select All (Выделить все); 

· Deselect All (Отменить все выделения); 

· Cut Frames (Вырезать кадры); 

· Copy Frames (Копировать кадры); 

· Paste Frames (Вставить кадры); 

· Edit Symbols (Правка символов); 

· Edit Selected (Правка выделения) – редагуються виділені група або символ на окремій вкладці; 

· Edit All (Редактировать все) – повертання до редагування звичайної сцени Flash; 

· Preferences (Настройка) – містить діалогові вікна для настроювання різноманітних параметрів. 

Пункт меню View (Вид) містить такі підпункти: 
· Goto (Перейти) – містить підменю сцен поточного фільму, включаючи команди переходу до сцен: First (Первая), Previous (Предыдущая), Next (Следующая), Last (Последняя); 

· Zoom In (Увеличение масштаба); 

· Zoom Out (Уменьшение масштаба); 

· Magnification (Увеличение) – містить вісім попередньо заданих рівнів збільшення; 

· Outlines (Контуры) – глобальний еквівалент перемикача відображення в вигляді контурів; 

· Fast (Быстро) – прискорює відображення шляхом відключення згладжуваності різких меж і розмивання кольорів; 

· Antialias (Сглаживание неровностей) – розмиває межі фігур і ліній; 

· Antialias Text (Сглаживание неровностей текста); 

· Timiline (Временная шкала) – відображає або ховає часову шкалу; 

· Work Area (Рабочая область) – робить видимою область, що оточує робоче поле; 

· Rulers (Линейки) – відображує або ховає лінійки; 

· Grid (Сетка) відображує або ховає сітки та задає їх параметри; 

· Guides (Направляющие) – керує параметрами направляючих; 

· Snap to Objects (Привязать к объектам); 

· Show Shape Hints (Показать указатели формы); 

· Hide Edges (Скрыть края) – ховає межі виділення; 

· Hide Panels (Скрыть панели). 

Пункт меню Insert (Вставка) містить такі підпункти: 
· Convert to Symbol (Преобразовать в символ); 

· New Symbol (Новый символ); 

· Layer (Слой) – створює новий шар, який стає активним, безпосередньо над поточним активним шаром; 

· Motion Guide (Направляющая движения) – створює шар з направляючою руху, що з’являється над виділеним шаром; 

· Frame (Кадр) – додає новий кадр; 

· Remove Frames (Удалить кадры); 

· Keyframe (Ключевой кадр) перетворює виділений кадр в ключовий; 

· Blank Keyframe (Пустой ключевой кадр); 

· Clear Keyframe (Очистить ключевой кадр); 

· Create Motion Tween (Создать заполнение кадров с движением); 

· Scene (Сцена) – вставляє порожню сцену безпосередньо за поточною активною сценою; 

· Remove Scene (Удалить сцену) – видаляє поточну активну сцену. 

Пункт меню Modify (Изменить) містить такі підпункти: 

· Instance (Экземпляр) – викликається відповідна панель, яка викорис¬то¬вується для керування незалежними типами екземплярів символів; 

· Frame (Кадр) – викликається відповідна панель; 

· Layer(Слой) – викликається діалогове вікно для керування і редагування властивостей активного шару на часовій шкалі; 

· Scene (Сцена) – викликається відповідна панель, де можна перейменовувати сцени, змінювати порядок їх слідування, додавати нову і видаляти існуючу сцену; 

· Movie (Фильм) – викликається діалогове вікно для зміни параметрів фільму; 

· Smooth (Сгладить) – зменшує згини і нерівності кривої; 

· Straighten (Выпрямить) – випрямляє лінії і криві; 

· Optimize (Оптимизировать) – зменшує кількість кривих у фігурі, що приводить до зменшення розміру файлу; 

· Shape (Фигура) – дозволяє перетворювати лінії в заливку, розширяти і стискати заливку та пом’якшувати її краї; 

· Trace Bitmap (Трассировка растрового изображения) – використо¬вується для перетворення імпортованого растрового зображення в векторну графіку з дискретними областями кольору, що редагуються; 

· Transform (Преобразование) – забезпечує доступ до відповідних команд перетворення зображення, таких як масштабування, повертання, дзеркальне відображення; 

· Arrange (Упорядочить) – використовується для переміщення виділених об’єктів, символів і груп на передній або задній план поточного активного шару, а також на один крок вперед і назад в стеку елементів цього шару; 

· Frames (Кадры) – використовується для оберненого відтворення анімаційної послідовності, синхронізації символів, перетворення виділених кадрів в ключові, а ключові в прості; 

· Group (Группировать); 

· Ungroup (Разгруппировать); 

· Break Apart (Разделить) – використовується для перетворення в графіку груп, блоків тексту, екземплярів, растрових зображень і об’єктів OLE; 

Пункт меню Text (Текст) містить такі підпункти: 

· Font (Шрифт); 

· Size (Размер); 

· Style (Стиль); 

· Align (Выравнивание); 

· Tracking (Трекинг) – пропонується скорочений варіант керування відстанню між символами тексту; 

· Character (Знак) – викликається відповідна панель для визначення параметрів знаків; 

· Paragraph (Абзац) – викликається відповідна панель для визначення параметрів абзацу; 

· Options (Параметры) – викликається відповідна панель для визначення параметрів тексту. 

Пункт меню Control (Управление) містить такі підпункти: 
· Play (Воспроизвести); 

· Rewind (Вернуть в начало); 

· Step Forward (Шаг вперед); 

· Step Backward (Шаг назад); 

· Test Movie (Тестирование фильма); 

· Debug Movie (Отладка фильма); 

· Test Scene (Тестирование сцены); 

· Loop Playback (Циклическое воспроизведение); 

· Play All Scenes (Воспроизвести все сцены); 

· Enable Simple Frame Actions (Разрешить простые действия кадра); 

· Enable Simple Buttons (Активизировать простые кнопки); 

· Mute Sounds (Приглушить звуки). 

Пункт меню Window (Окно) містить такі підпункти: 

· New Window (Новое окно); 

· Toolbars (Панели инструментов); 

· Tools (Инструменты) – відключає для відображення панель інструментів малювання; 

· Controller (Контроллер); 

· Panels (Панели) – відкриває підменю з групами основних панелей: Info (Инфо), Fill (Заливка), Stroke (Штрих), Transform (Преобразование), Align (Выравнивание), Mixer (Миксер), Swatches (Образцы), Character (Знак), Paragraph (Абзац), Text Options (Параметры текста), Instance (Экземпляр), Effect (Эффект), Clip Parameters (Параметры клипа), Frame (Кадр), Sound (Звук), Scene (Сцена), Generator (Генератор); 

· Panel Sets (Набор панелей); 

· Save Panel Layout (Сохранить структуру панелей); 

· Close All Panels (Закрыть все панели); 

· Actions (Действия) – відкриває панель, яка використовується для присвоювання дій і написання сценаріїв ActionScript; 

· Movie Explorer (Проводник фильма); 

· Output (Вывод) – відображає вікно, яке після експорту файлу в формат SWF відображає повний звіт по кожній сцені, символу і т.п.; 

· Debugger (Отладчик); 

· Library (Библиотека); 

· Common Libraries (Общие библиотеки); 

· Generator Objects (Объекты Generator) – працює при встановленій програмі Generator; 

· Cascade (Каскад) – розміщує всі відкриті вікна накладеними один на одного зі зсувом вправо і вниз; 

· Tile (Мозаика) – розміщує всі вікна відкритих фільмів поряд. 

Пункт меню Help (Справка) містить такі підпункти: 

· What’s New in Flash 5 (Что нового во Flash 5); 

· Using Flash (Использование Flash ); 

· ActionScript Reference (Руководство ActionScript); 

· ActionScript Dictionary (Словарь ActionScript); 

· Macromedia Dashboard і Flash Support Center – ресурси для навчання; 

· Register Flash (Зарегистрировать Flash). 

Урок № 6 Робота з інструментами в Flash
Інструмент Zoom (Масштаб) має два параметри: Enlarge (Увеличить) і Reduce (Уменьшить). Кожний рівень використання цих команд змінює зображення в два рази. Окрім цього, якщо на інструменті клацнути два рази, він відобразить фільм в масштабі 100%. Створюючи на робочому полі Flash прямокутник активізованим інструментом Zoom, можна відобразити прямокутну область з максимальним для її повного відображення коефіцієнтом збільшення. Значення масштабу впливає на розмір інструмента, точність позиціонування і вирівнювання об’єктів на робочому полі.

За допомогою інструмента Hand (Рука) можна переміщувати видиму область робочого поля, а подвійне клацання на ньому дозволяє відобразити все робоче поле. 

Інструмент Lasso (Лассо) використовується для групового виділення розрізнених проміжків зображення або областей неправильної форми. Після виділення ці області можна перемістити, змінити їх розмір або форму, повернути. В нижній частині панелі інструментів в групі Options (Параметри) вибирається один з трьох режимів інструмента Lasso: Polygon Mode (Режим многоугольника), Magic Wand (Волшебная палочка) і Magic Wand Properties (Свойства волшебной палочки). Параметр Magic Wand (Волшебная палочка) використовується для виділення областей однакового кольору на растровому зображенні, яке було розділено (розглядається Flash в вигляді набору окремих проміжків різного кольору). 

Інструмент Arrow (Стрелка) використовується для виділення і переміщення об’єкта або декількох об’єктів по робочому полю, а також для зміни форми ліній і фігур. При виборі інструмента Arrow (Стрелка) в групі Options (Параметри) з’являється п’ять опцій: Snap to Objects (Привязка к объектам), Smooth (Сгладить), Straighten (Выпрямить), Rotate (Вращать), Scale (Масштабировать). Текстові блоки і групи виділяються і переміщуються як єдині елементи. Однак при переміщенні об’єкта, який не згрупований, можна перемістити тільки виділену його частину. Інструмент Arrow (Стрелка) може бути використаний також для дублювання елементів. Для цього потрібно переміщувати об’єкт при натиснутій клавіші .

Інструмент Pen (Перо) використовується для точного малювання траєкторій, які складаються з прямих ліній і згладжених кривих. Для малювання викривленого проміжку кривої потрібно клацнути ліві кнопку миші і перетягнути курсор миші, при цьому довжина і напрям переміщення визначає глибину згину і форму поточного сегмента. Як прямі, так і викривлені ділянки, можна змінювати і редагувати, керуючи їх точками. В нижньому правому кутку курсору інструмента Pen (Перо) відображаються маленькі значки: 

x – коли курсор знаходиться над робочим полем; 

+ – коли курсор знаходиться над траєкторією, клацанням можна додати ще одну вузлову точку; 

ˆ – коли курсор знаходиться над існуючою точкою, клацанням можна перетворити її в кутову точку; 

-- коли курсор знаходиться над кутовою точкою, клацанням можна видалити її; 

о– коли курсор переміщується над вже створеними точками або ділянками траєкторії, клацанням можна завершити фігуру або замкнути траєкторію. 

Переміщення інструменту Pen (Перо) при натиснутій клавіші імітує використання інструменту Subselect (Частичное выделение). При редагування траєкторії виділені точки відображаються як порожні кружечки, а невиділені – заповненими квадратиками. 

Інструмент Subselect (Частичное выделение) використовується для переміщування та редагування окремих вузлових точок і дотичних, а також для переміщування окремих об’єктів. Видаляючи вузлові точки можна спрощувати фігури і, таким чином, зменшувати розмір файлу. 

Інструмент Pencil (Карандаш) використовується для малювання ліній і фігур. Параметр Pencil Mode (Режим карандаша) визначає три режими обробки ліній: Straighten (Выпрямить), Smooth (Сгладить), Inc (Чернила). Параметр Inc дозволяє відключити обробку ліній і відповідає малюванню вручну. При випрямленні і згладжуванні проходить розпізнавання приблизних форм і їх автоматична корекція (кінці ліній, що знаходяться рядом, об’єднуються). 

Інструмент Line (Линия) дозволяє будувати прямі лінії, які визначаються початковою і кінцевою точками. Тип і товщина лінії можуть бути задані за допомогою панелі Stroke (Штрих). При натиснутій клавіші лінії мають кут нахилу 45 або 90 градусів. 

Інструмент Oval (Овал) дозволяє будувати овали шляхом зміщення курсору по діагоналі. При натиснутій клавіші буде побудоване коло. Тип і товщина контуру овалу можуть бути задані за допомогою панелі Stroke (Штрих). 

Інструмент Rectangle (Прямоугольник) дозволяє будувати прямокутники шляхом зміщення курсору по діагоналі з одного кутка в інший. При натиснутій клавіші буде побудований квадрат. Тип і товщина контуру овалу можуть бути задані за допомогою панелі Stroke (Штрих). Інструмент має додатковий параметр Round Rectangle Radius (Радиус скругления углов прямоугольника). 

Інструмент Brush (Кисть) використовується для зафарбовування за допомогою мазків пензля і заповнення замкнутих фігур, утворюючи заповнені кольором фігури з контуром нульової товщини. Заповнення може бути суцільним кольором, градієнтне або растровим зображенням. Параметр Brush Mode (Режим кисти) містить п’ять режимів малювання: Paint Normal (Обычное закрашивание), Paint Fills (Закрашивание заливок объекта), Paint Behind (Закрашивание позади объекта), Paint Selection (Закрашивание выделенной заливки), Paint Inside (Закрашивание внутри контура). Параметр Brush Size (Размер кисти) містить десяток чітко визначених розмірів пензля і використовується для завдання розмірів всіх форм пензля (для видовженої форми діаметр відноситься до самої широкої її ділянки). Ширина мазка в пікселях залежить як від розмірів пензля, так і від масштабу. Параметр Brush Shape (Форма кисти) містить десять профілів пензля, створених на основі кола, еліпса, квадрата, прямокутника і ліній. Параметр Lock Fill (Блокировка заливки) блокує кут, розміри і початкову точку поточного градієнтного заповнення, щоб воно як би займало всю сцену, але при цьому проявлялось тільки там, де здійснюється зафарбовування за допомогою мазків пензля. 

Інструмент Dropper (Пипетка) використовується для копіювання кольору і стилю існуючих олівцевих ліній, мазків пензля і заливок. 

Інструмент Inc Bottle (Чернильница) використовується для зміни кольору, стилю і товщини існуючого контуру. Його зручно використати для застосування створених стилів до інших ліній. При використанні цього інструменту змінюються всі виділені лінії. 

Інструмент Paint Bucket (Заливка) використовується для заливки замкнутих ділянок кольором, градієнтним заповненням або растровим зображенням. Атрибути заливки можна скопіювати інструментом Dropper (Пипетка) з колекції власних стилів заливки, створених за межами робочого поля або на спеціальній палітрі, збереженій в однокадровому фільмі Flash, а потім використати для множини інших об’єктів. Параметр Gap Size (Размер зазора) містить чотири вказівки як заповнювати не повністю замкнуті контури: Don’t Close Gaps (Не закрывать зазоры), Close Small Gaps (Закрывать небольшие зазоры), Close Medium Gaps (Закрывать средние зазоры), Close Large Gaps (Закрывать большие зазоры). Поведінка цього параметру залежить від значення масштабу. Параметр Lock Fill (Блокировка заливки) аналогічний однойменному параметру інструмента Brush (Кисть). Параметр Transform Fill (Преобразование заливки) використовується для настроювання розміру, кута нахилу і центра градієнтного заповнення або заливки растровим зображенням. Щоб скористатись цим параметром, спочатку його активізують, а потім клацають на потрібній градієнтній заливці чи заливці растровим зображенням. Після цього можна виконати три види перетворення: настроювання центральної точки заливки, обертання заливки і зміну її розміру. Заливка білим кольором хоча і подібна до стирання, однак залиту фігуру можна виділити, перемістити, видалити або змінити її форму. 

Інструмент Eraser (Ластик) використовується для стирання непотрібних елементів зображення. Параметри Eraser Mode (Режим Ластика) і Eraser Shape (Форма Ластика) являють собою відповідні списки, а кнопка Faucet (Кран) використовується для очищення замкнутих ділянок заливки. Параметр Eraser Mode (Режим Ластика) в списку має п’ять пунктів: Erase Normal (Обычное стирание), Erase Fills (Стирание заливки), Erase Lines (Стирание линий), Erase Selected Fills (Стирание выделенных заливок), Erase Inside (Стирание внутри объектов). Подвійне клацання на інструменті Eraser (Ластик) швидко видаляє всі об’єкти з робочого поля. 

Зміна типу і кольору лінії стосується ліній або кривих, що намальовані за допомогою інструментів Pen (Перо), Line (Линия), Pencil (Карандаш), Oval (Овал), Rectangle (Прямоугольник). 

Урок № 7 Бібліотека, символи і екземпляри в Flash MX
Символи є елементами, які можна використовувати багатократно в вигляді екземплярів, що дозволяє зменшити розмір файлу фільму. Окрім цього зміни символу відображаються на кожному його екземплярі. Символи, імпортовані звуки, растрові зображення і фільми в форматі QuickTime Flash зберігає в бібліотеці. З бібліотеки символ можна просто перетягнути на робоче поле. Хорошим тоном вважається перетворення в символ практично кожного елемента фільму. 

Бібліотеку поточного фільму можна відкрити командою Window -> Library (Окно -> Библиотека). Загальні бібліотеки вибираються командою Window -> Common Libraries (Окно -> Общие Библиотеки) і містять: Buttons (Кнопки), Graphics (Графика) Leaming Interactions (Изучение интерактивности), Movie Clips (Видеоклипы), Smart Clips (Интерактивные клипы), Sounds (Звуки). 

Меню параметрів бібліотеки включає команди: New Symbol (Создать символ), New Folder (Создать папку), New Font (Создать шрифт), Rename (Переименовать), Move to New Folder (Переместить в новую папку), Duplicate (Дублировать), Delete (Удалить), Edit (Правка), Edit with (Редактировать в приложении), Properties (Свойства), Linkage (Связывание), Define Clip Parameters (Задать параметры клипа), Select Unused Items (Выделить неиспользуемые элементы), Update (Обновить), Play (Воспроизвести), Stop (Остановить), Expand Folder/Collapse Folder (Раскрыть папку/Закрыть папку), Expand All Folders/Collapse All Folders (Раскрыть все папки/Закрыть все папки), Shared Library Properties (Свойства библиотеки совместного использования), Keep Use Counts Updated (Постоянно обновлять счетчик использования), Update Use Counts Now (Обновить счетчик использования сейчас). 

Створити символ можна таким чином: 

· Insert -> New Symbol (Вставка -> Новый символ); 

· ввести назву і вибрати тип символу; 

· в режимі редагування задати зміст символу; 

· Edit -> Edit Movie (Правка -> Правка фильма). 

Для перетворення готових елементів в графічний символ після їх виділення можна скористатись командою Insert -> Convert to Symbol (Вставка -> Преобразовать в символ).

Відеокліпи являють собою фільми, які розміщуються всередині основного фільму. До них можна додавати анімацію, дії, звуки, інші символи і навіть інші відеокліпи. Вони мають власну часову шкалу, яка запускається незалежно від основної часової шкали. На відмінність від графічних символів з анімацією, для відтворення відеокліпу на часовій шкалі основного фільму потрібен тільки один (початковий) ключовий кадр. Однак відео-кліп відтворюється в файлах з форматом .SWF, тому в процесі роботи не можна поди-витись вставлений відеокліп за допомогою “прочісування” часової шкали. Відеокліп можна створити із порожнього символу, однак найпростіше для цього використати готову анімацію:

· виділити всі кадри кожного шару готової анімації на часовій шкалі основного фільму; 

· скопіювати анімацію, скориставшись контекстним меню або командою Edit -> Copy Frames (Правка -> Копировать кадры); 

· Insert -> New Symbol (Вставка -> Новый символ), вибрати тип Movie Clip (Видеоклип); 

· виділити перший кадр на часовій шкалі створеного символу і вставити скопійовані кадри, скориставшись контекстним меню або командою Edit -> Paste Frames (Правка -> Вставить кадры); 

· повернутись до основного фільму командою Edit -> Edit Movie (Правка -> Правка фильма); 

· видалити кадри на часовій шкалі основного фільму командою Insert -> Remove Frames (Вставка -> Удалить кадры). 

Кнопка в Flash є спеціально пристосованим під функції кнопки вид символу і має стани: Up – звичайний стан кнопки; Over – коли курсор мишки знаходиться над кнопкою; Down – коли курсор знаходиться над кнопкою і натиснута клавіша миші; Hit – активна зона кнопки. Для створення простої кнопки можна скористатись процедурою:

· Insert -> New Symbol (Вставка -> Новый символ), вибрати тип Button (Кнопка);

· створити графічне зображення для початкового стану кнопки;

· додаючи ключові кадри, створити графічні зображення для інших ста¬нів кнопки (при цьому в кадрі Hit задається ефективна зона дії кнопки).

До кнопки можна додавати анімації, надписи і звуки. 

Символи можна редагувати в вікні створення символу, в новому вікні, на місці (в контексті всього фільму в режимі Edit in Place (Правка на месте), в бібліотеці. 

Такі властивості екземплярів символів, як яскравість, відтінок, коефіцієнт прозорості і тип можна змінювати. Також можна змінювати масштаб екземпляру, нахиляти його і повертати. Але будь-які зміни початкового символу відображаються на кожному екземплярі, навіть якщо властивості екземпляру були змінені. За допомогою панелі Effect (Эффект) можна задавати параметри: None (Нет), Brightness (Яркость), Tint (Оттенок), Alpha (Коэффициент прозрачности), Advanced (Сложный). За допомогою панелі Instance (Экземпляр) можна замінити екземпляр одного символу на інший символ. 

Важливим інструментом для розшифрування фільмів, аналізу їх структури і пошуку в них потрібних елементів є панель Movie Explorer (Проводник фильма). Настроювання цієї панелі можна здійснити за допомогою діалогового вікна Movie Explorer Settings (Установки проводника фильма), яке відкривається кнопкою Customize Which Items to Show (Настройка отображения элементов). Меню параметрів панелі Movie Explorer (Проводник фильма) співпадає з контекстним меню і містить параметри: Goto Location (Перейти к месторасположению), Goto Symbol Definition (Перейти к определению символа), Select Symbol Instances (Выделить экземпляры символа), Find in Library (Найти в библиотеке), Panels (Панели), Rename (Переименовать), Edit in Place (Правка на месте), Edit in new Window (Правка в новом окне), Show Movie Elements (Показать элементы фильма), Show Symbol Definitions (Показать определения символов), Show All Scenes (Показать все сцены), Copy Text to Clipboard (Копировать текст в буфер обмена), Cut (Вырезать), Copy (Копировать), Paste (Вставить), Clear (Очистить), Expand Branch (Развернуть сегмент), Collapse Others (Закрыть остальные), Print (Печать).

ПР № 1 Знайомство з інтерфейсом Macromedia Flash MX
Теоретичні відомості

Як і в кінофільмах, Flash кліпи являють собою набір кадрів, що змінюються в часі. Вікно робітника (Stage) є областю, у якій Ви створюєте кадри кліпу, або безпосередньо їх малюючи, або імпортуючи ззовні. Flash може імпортувати звуки у файли з компресією MP3. Це дозволяє створювати прекрасний звуковий супровід для кліпів. При цьому розміри файлів виходять досить малими. 

Для того, щоб експортувати кліп у кожній з численних форматів, а також, щоб створити супутній HTML файл, досить лише однієї команди Publish (Опублікувати). Властивості кожного формату по-окремості настроюються до процедури публікації. 

За допомогою команди Create Motion Tween ви можете моментально створювати об'єкт, що рухається. Об'єкти з заданим шляхом руху (motion tweened objects) автоматично "прикріплюються" до шляху руху, намальованому в шарові зі шляхом (motion guide layer). Крім того, до цього шару можна "прикріпити" кілька шарів, чи відкріпити кожен з них. Те ж саме стосується шарів з масками. Обновлені елементи керування шарами дозволяють з легкістю сховати, показати, зафіксувати і дезафіксувати кожної із шарів. Якщо вам важко відрізнити на шарах один об'єкт кліпу від іншого, переключитеся в режим Outline colors (Колірні контури об'єктів). Монтажну лінійку можна розташувати у своєму власному вікні, або прикріпити її до кожної зі сторін вікна додатка.
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Інспектори Object і Transform допоможуть вам переглядати і змінювати положення, масштаб, обертати і розтягувати виділені об'єкти. 

Іспектор Scene полегшує роботу з безліччю епізодів, з яких може складатися Flash-кліп. За допомогою інструментів Circle і Rectangle ви можете швидко створювати прості об'єкти. За допомогою інструмента Round rectangle radius modifier ви можете зробити кути прямокутника округленими. Символи можна редагувати як в окремому вікні, так і прямо в епізоді. 

При створенні і редагуванні кліпів, звичайно працюють у наступних основних областях: 

· робочому полі (Stage) - прямокутної області, у якій відбувається відтворення кліпу; 

· вікні монтажної лінійки (Timeline), у якому створюється анімація графіки в часі; 

· вікні бібліотеки (Library), у якій знаходяться елементи кліпу, призначені для багаторазового використання, такі елементи називаються символами; 

· режимі редагування символів, де вони створюються і редагуються. Кліпи являють собою набір кадрів, що змінюються в часі. 

На монтажній лінійці (Timeline) Ви синхронізуєте анімацію в часі і розташовуєте графічні елемент на різних шарах. Монтажна лінійка показує кожен кадр ролика. Шари виконують роль пачки прозорості так що графічні елементи, розташовані на різних шарах, у підсумку утворять цільне зображення.

Інструменти, що знаходяться на панелі інструментів (Toolbox), дозволяють малювати, виділяти, офарблювати і змінювати графічні об'єкти. Інші інструменти змінюють вид робітника полючи (Stage). Характеристики більшості інструментів можуть бути змінені, це викликано специфікою їхнього застосування при редагуванні, малюванні елементів.

Монтажна лінійка (Timeline) призначена для організації і керування зміною змісту кліпу в часі в шарах і кадрах. Найбільш важливими її компонентами є кадри (frames), шари (layers) і відтворююча голівка (playhead). Ви можете керувати Монтажною лінійкою (Timeline) змінюючи зовнішній вигляд кадрів і перетаскуючи її з основного вікна додатка, виділяючи її в окреме чи вікно фіксуючи в будь-якої крайки вікна додатка. Коли шарів більше, ніж може бути показане на Монтажній лінійці (Timeline), у її правій частині з'являється скролінг. Можлива зміна її розмірів і тим самим кількості одночасно показуваних шарів і кадрів.

Кожен FLA-файл має свою бібліотеку, що може містити символи, растрову графіку, звукові і відео файли. Для перегляду й організації змісту бібліотеки, призначене вікно Library (Бібліотека). Коли в бібліотеці вибирається елемент, у вікні, розташованому в її верхній частині, з'являється його зображення. Якщо обраний елемент є анімованим чи є звуковим файлом, то для його відтворення можна скористатися Контролером (controller). Для зручності організації змісту бібліотеки, усередині її можна створювати папки. Всі елементи розміщені в таблиці, що знаходяться в бібліотеці, що складається з наступних стовпчиків: ім'я елемента, його тип, скільки разів він використовується у файлі, а також дату його останньої модифікації. Можна відсортувати елементи в бібліотеці по будь-якому стовпчику. 

Практична частина

Порядок виконання роботи
1. Вивчення інтерфейсу середовища Macromedia Flash. 

2. Виконання процедури налаштування робочого поля. 

3. Варіанти роботи з панеллю інструментів. 

4. Переміщення Монтажної лінійки. 

5. Збільшення та зменшення розмірів поля з назвою шару. 

6. Збільшення та зменшення кількості наявних шарів. 

7. Виклик вікна бібліотеки. 

8. Зміна ширини колонок. 

9. Зміна розміру вікна бібліотеки. 

10. Аналіз результатів і висновки. 

Методичні вказівки
Для початку запустимо сам Macromedia Flash . 

Для запуску програми зайдіть у меню Start (Пуск) системи Windows. У папці Програми відшукайте ярлик Macromedia Flash і натисніть на ньому лівою кнопкою миші. Після того як програма завантажилася перед вами з’явиться робоче середовище програми, почнемо з нуля. 

Задамо розмір робочого поля і колір фону:
1. Виберіть Modify(Изменить) → Документ→Размеры. 

2. В діалоговому вікні Movie Properties встановіть розмір 550 пікселів на 400 пікселів. 

3. Задайте колір фону, натиснувши на кнопці Фоновый цвет. 

4. Натисніть кнопку OK. 

Для вибору інструмента зробіть нижченаведену дію:
Натисніть на кнопку з зображенням інструмента, яким хочете скористатися. У залежності від обраного інструмента, у нижній частині панелі, з'явиться набір кнопок з доступними для нього функціями. 

Переміщення Монтажної лінійки (Timeline):
Натиснувши мишкою на верхню частину монтажної лінійки, перетягнете її в будь-яке місце чи екрана до краю робочого вікна, щоб зафіксувати її там. Якщо хочете уникнути фіксації, при перетаскуванні тримаєте натиснутої клавішу Control. 

Для збільшення чи зменшення розміру поля з назвою шару:
Зміщуйте границю, що розділяє праву і ліву частини монтажної лінійки. 

Збільшення чи зменшення кількості показуваних шарів:
Зміщуйте границю, що розділяє монтажну лінійку і робоче поле (Stage). 

Для виклику вікна бібліотеки (Library):
Виберіть Window (Окно) → Library(Библиотека). 

Зміна ширини колонок:
Розмістіть курсор між заголовками стовпчиків і перетягніть границю. Порядок стовпчиків змінювати не можна. 

Зміна розміру вікна бібліотеки (Library):
Перетягніть нижній правий кут. Щоб показати всі стовпчики у вікні бібліотеки, натисніть кнопку Wide State. Щоб зменшити ширину вікна, залишивши тільки колонку Name (Ім'я), натисніть кнопку Narrow State. 

ПР № 2 Створення елементів статичної графіки в середовищі Flash MX
Теоретичні відомості

Використання інструментів малювання Flash (drawing tools) необхідно для створення малюнків. Ви можете також імпортувати малюнки з будь-яких векторних програм, таких як Macromedia FreeHand, Adobe Illustrator, і растрові зображення з Adobe Photoshop чи будь-яких інших програм. Малювати в Flash легко, якщо ви зрозумієте основні принципи, такі, як використання інструментів, виділення, зв'язування і розбивка. Виберіть різні інструменти з панелі інструментів малювання. У залежності від обраного інструмента зовнішній вигляд панелі може змінитися і можуть з'явитися випадаючі меню в нижній частині панелі. Ці зміни показують що може робити обраний інструмент. Наприклад, при виборі Олівця ви можете вибрати товщину, колір і стиль ліній і ви можете вибрати автоматичне заокруглення (smoothed) чи навпроти загострення (straightened). 

Олівець малює лінії і криві як і звичайний олівець. Flash може зробити лінії прямими, чи закруглити криві. Flash розпізнає основні геометричні обриси автоматично, але ви можете використовувати інструменти зміни для того, щоб створити необхідні криві. На додаток до цього ви можете вручну змінити форму ліній у будь-який час. У ліній є три властивості : колір, товщина і стиль. 

Олівець малює прямі з областю заливання, як звичайний олівець. Фарба для олівця може бути простим кольором, чи градієнтом створеним з готового файлу (bitmaps). В доповнення до звичайних мазків кісті, використовуйте різні опції для Олівця. Наприклад ви можете малювати між уже готовими елементами, чи тільки в заповненій області. Ви можете вибрати кілька розмірів і форм кісті. 

Flash не має будь-яких засобів для зміни форми ліній. Проте ви можете змінювати лінію в будь-якій частині, використовуючи інструмент Стрілка. Стрілка буде змінюватися відповідно до того, яку зміну ви можете зробити на даному відрізку лінії, мазка кісточки чи заливання. 

В верхній частині вікна програми знаходиться стрічка заголовка. В якій міститься назва програми і відкритого файлу. Під стрічкою заголовка міститься головне меню програми, яке призначене для керування програмою і створення фільму. 
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Для того, щоб створити новий файл в програмі Flash MX потрібно натиснути на меню File -> New. Для збереження створеного файлу натисніть меню File -> Save as. 

В лівій частині вікна програми знаходиться панель інструментів (Tools), яка дозволяє вибирати різні інструменти для створення і редагування графіки. Розглянемо основні елементи цієї панелі: 

Лінія. Натисніть на панелі інструментів кнопку “Лінія” (Line), після цього ви можете проводити мишкою прямі лінії. Помістіть курсор миші в те місце, де буде початок лінії і натисніть ліву клавішу миші. Після цього не відпускаючи клавішу переведіть мишку в місце, де буде кінець лінії і відпустіть клавішу. Все, пряма лінія створена. Якщо ж Вам потрібно провести лінію під кутом, кратним 45°, то під час проведення лінії тримайте натиснутою клавішу Shift. Ви можете задавати колір лінії, використовуючи верхній селектор кольору, який знаходиться в області Colors. 

Прямокутник і еліпс. Щоб вибрати інструмент прямокутник або еліпс натисніть відповідні кнопки на панелі інструментів. Прямокутник створюється наступним чином: помістіть курсор миші в місце, де буде його лівий верхній кут, натисніть ліву клавішу миші. Після цього не відпускаючи цю кнопку перетягніть мишку в місце, де буде правий нижній кут прямокутника і відпустіть ліву кнопку миші. Прямокутник буде створено. Еліпс створюється аналогічним чином. Якщо ж вам потрібно намалювати квадрат або коло, то під час малювання утримуйте клавішу Shift на клавіатурі. Колір еліпса або прямокутника задається використовуючи нижній селектор кольору в області Colors. Прямокутник може мати округлені кути. Для цього служить модифікатор, який вмикається в області Options.

Олівець. Цей інструмент дозволяє малювати лінії будь-якої форми. Працює він як звичайний олівець. Натисніть в інструментарії відповідну кнопку і намалюйте довільну лінію. Ви можете задавати колір лінії, використовуючи верхній селектор кольору, який знаходиться в області Colors. Для регулювання згладжуванням лінії використовуйте “модифікатор згладжування ліній”, який знаходиться в області Options. Дане меню має три пункти, які задають режими згладжування:

· Straighten - сильне згладжування, готові лінії будуть прямими, а наближенні геометричні фігури перетворюються в точні фігури. 

· Smooth - середнє згладжування, готові лінії будуть кривими. 

· Ink - згладжування практично відсутнє. 

Якщо вам потрібно намалювати достатньо точну фігуру з прямих ліній, виберіть Straighten згладжування. Якщо ваша геометрична фігура має криві лінії, виберіть Smooth згладжування. Для точного малювання складних кривих слід вибрати режим Ink. 

Перо. Інструмент, при допомозі якого можна малювати як прямі, так і криві лінії, точно вказавши початкову і кінцеву точки і радіус кривизни. Для того, щоб вибрати інструмент “перо”, натисніть в інструментарії відповідну кнопку. Помістіть курсор миші в місце, де буде знаходитись початок прямої і натисніть ліву кнопку миші. Далі помістіть курсор в кінцеву точку прямої і знову натисніть ліву кнопку миші. Пряму проведено. Якщо ви продовжите натискати мишкою в різних місцях на робочій області програми, то зможете побудувати ламану лінію. При створенні останньої її точки натисніть мишкою два рази на ліву клавішу. Початкова точка кривої лінії створюється так само, як початкова точка прямої. Після цього натискаємо ліву клавішу мишки на робочій області, де повинна бути кінцева точка, але не відпускаємо її. Далі перемістіть курсор в будь-якому напрямку, при цьому зміниться форма кривої. Головне правило - переміщуйте мишку в тому напрямку, в якому крива має бути ввігнута. Колір ліній, намальованих при допомозі інструмента “перо” ви можете задавати, використовуючи селектор кольору в області Colors панелі інструментів.

Кісточка. За допомогою “кісточки” можна наносити мазки різної форми і товщини. Щоб вибрати цей інструмент, натисніть в інструментарії відповідну кнопку. Використання “кісточки” аналогічно інструменту “олівець”. Якщо вам потрібно провести строго вертикальний або горизонтальний мазок, тримайте натиснутою клавішу Shift. Колір мазка вибирається при допомозі нижнього селектора, який знаходиться в області Colors інструментарію. Форму і розмір “кісточки” можна змінити в області Options інструментарію. В меню модифікатора “режим малювання” доступно п’ять пунктів:

· Paint Normal - звичайне малювання, коли замальовуються будь-які лінії і будь-яка заливка. 

· Paint Fills - замальовуються тільки заливка і порожні області, лінії не замальовуються. 

· Paint Behind - замальовуються тільки порожні області, заливка і лінії не замальовуються. 

· Paint Selections - замальовується тільки виділена при допомозі “стрілки” заливка, невиділені заливки і лінії залишаються не зафарбованими. 

· Paint Inside -замальовується тільки заливка, яка знаходиться в межах або за межами замкнутого контуру. Лінії не зафарбовуються. 

“Відерце з фарбою”. Даний інструмент використовується для створення заливок. Заливкою називається особливий графічний примітив, який заповнює замкнутий контур, утворений лініями. Інколи Flash створює заливки автоматично, наприклад, коли ви малюєте прямокутник, еліпс. В інших випадках заливку графічного об’єкта вам потрібно створити самостійно. Для того, щоб вибрати “відерце з фарбою” натисніть в панелі інструментів відповідну кнопку. Використовувати цей інструмент надзвичайно просто: виберіть “відерце з фарбою”, наведіть курсор мишки на замкнену фігуру (переконайтесь, щоб фігура була дійсно замкнена) і натисніть ліву кнопку мишки. В області Options виберіть потрібний пункт роботи інструмента :

· Don’t Close Gaps -весь контур повинен бути замкнутий. 

· Close Small Gaps - Flash закриває тільки маленькі розриви. 

· Close Medium Gaps - Flash закриває проміжки середніх розмірів. 

· Close Large Gaps - Flash закриває більші розриви.

Крім того, в панелі інструментів є ще такі інструменти: “стрілка виділення” (стрілка чорного кольору), “додаткова стрілка виділення”(стрілка білого кольору), “складне виділення (ласо)”, за допомогою яких можна виділяти не тільки фігури, а й фрагменти фігур. “Додаткова стрілка виділення”, наприклад, дає можливість змінити розташування вершини прямокутника. 

Інструмент “гумка” використовується для знищення ліній і заливок. Форму і режим роботи “гумки” можна вибрати в області Options. В меню модифікатора “стирання” доступно п’ять пунктів:

· Erase Normal - звичайний режим, коли стираються будь-які лінії і заливки. 

· Erase Fills - стираються тільки заливки, лінії не стираються. 

· Erase Lines - стираються тільки лінії, заливки не стираються. 

· Erase Selected Fills - стираються тільки виділені при допомозі “стрілки” заливки. Не виділені заливки і лінії не стираються. 

· Erase Inside -стираються тільки заливки, які знаходяться в межах замкнутого контуру. 

Практична частина

Порядок виконання роботи
1. Використання інструментів Олівець, Лінія, Овал та Прямокутник.

2. Робота з інструментом Brush. 

3. Встановлення атрибутів лінії і заливання.

4. Часткове та повне видалення, видалення зміщенням.

5. Створити свій малюнок на основі отриманих знань.

6. Аналіз результатів і висновки.

Методичні вказівки
Запустимо Macromedia Flash. З лівого боку розташована панель інструментів, на якій знаходяться звичайні засоби для малювання, які мі зараз і розглянемо. Основними з них є: Олівець, Лінія, Овал та Квадрат. Для початку необхідно створити новий фільм. Для цього потрібно вибрати File -> New.

Для малювання олівцем: 

1. Виберіть інструмент Pencil (олівець) у панелі інструментів. 

2. Виберіть режим малювання лінії (drawing mode):

· Straighten (випрямлення) дозволяє вам виводити прямі лінії і перетворювати подоби трикутників, овалів, кіл, прямокутників, і квадратів у ці звичайні геометричні форми. 

· Smooth (згладжування) дозволяє вам виводити гладкі вигнуті лінії. 

· Ink (чернетка) дозволяє вам виводити лінії як є (без згладжування і випрямлення). 

3. Виберіть атрибути лінії. 

4. Малюйте на сцені. Тримаєте при малюванні клавішу Shift для того що б ваші лінії були горизонтальні чи вертикальні. 

Для малювання прямих ліній, чи овалів прямокутників:
1. Виберіть Line(лінія), Oval(овал) чи Rectangle(прямокутник). 

2. Виберіть атрибути лінії і заливання. Для інструмента Line(лінія) ви не можете встановлювати атрибути заливання. 

3. Для інструмента Прямокутник, визначите округлені кути, для чого виберіть опцію Round Rectangle Radius( радіус округлення кутів) і введіть значення радіуса кута. Значення = 0 створює кути без округлень. 

4. Малюйте на сцені. Якщо ви використовуєте інструмент прямокутника, то після того як ви намалювали прямокутник, утримуючи праву клавішу миші, використовуйте клавіші стрілок "нагору" і "вниз", щоб корегувати радіус округлених кутів. Для овалу і прямокутника: утримуйте натиснутої клавішу Shift що б намалювати правильне геометричне Коло при Oval і Квадрат при Rectangle Для інструмента Line: утримуйте натиснутої клавішу Shift при малюванні, для того що б вивести лінію з кутом кратним 45. 

Зафарбовування інструментом Brush (кисть):
1. Виберіть інструмент Brush (кисть). 

2. Виберіть режим зафарбовування: 

· Paint Normal (Звичайне розфарбовування); для зафарбовування на тім же рівні поверх ліній і заливань. 

· Paint Behind (Зафарбовування за об'єктом); фарбує в порожніх областях сцени, залишаючи лінії і заливання недоторканими. 

· Paint Fills (Зафарбовування заливань об'єкта); зафарбовує заливання і порожні області, залишаючи недоторканими лінії. 

· Paint Selection (Зафарбовування виділеного заливання); зафарбовує виділене заливання. 

· Paint Inside (Зафарбовування усередині контуру) зафарбовує тільки те заливання в який поставили штрих спочатку (за умови, що ви після проведення першого штриха, не відпускали праву клавішу миші). Лінії при виборі цього режиму не зафарбовуються. Якщо ви при цьому режимі зафарблюєте порожні області, штрих кісті не торкає будь-які існуючі заповнених областей. 

3. Виберіть розмір кісті, форму кисті і колір фарби в панелі опцій інструмента Brush (кість). 

4. Зміщайте кість по сцені для малювання. Утримання клавіші Shift при малюванні кістю дозволяє вам проводити строго горизонтальні чи вертикальні штрихи. 

Установка атрибутів лінії і заливання: 
1. Виберіть інструмент чи зафарбовування малювання. 

2. Для установки кольору лінії чи кольору заливання, зробіть наступне. Виберіть інструментальний засіб Paint bucket (відро з фарбою) чи Ink bottle (пляшка чорнила), а потім виберіть колір заливання чи лінії використовуючи опцію Fill Color(колір заливання) чи Line color (колір лінії). Виберіть Window > Colors і виберіть колір у вкладці Solid (тверді кольори). Якщо Ви використовуєте інструментальні засоби Rectangle (прямокутник) чи Oval (овал), натисніть кнопку зверху, поруч із зображенням штриха (Stroke color focus), для вибору кольору лінії чи таку ж кнопку внизу, поруч зображенням зафарбованого квадрата (Fill Color focus), для вибору кольору заливання. 

3. Щоб встановити ширину лінії і стиль, виберіть ширину лінії і тип у панелі інструментів. 

Для швидкого видалення усього що знаходиться на сцені:
Двічі клацніть інструмент Eraser (гумка). Не видаляються зі сцени об'єкти, що знаходяться в заблокованих і в невидимих шарах. 

Для видалення області з заливанням чи повного видалення всіх сегментів лінії : 

1. Виберіть інструмент Eraser (гумка), а потім натисніть кнопку Faucet (кран). 

2. Виділіть на сцені лінію чи область із заливанням, що хочете видалити. 

Для стирання зміщенням:
1. Виберіть інструмент Eraser(гумка). 

2. Виберіть режим стирання.

· Erase Normal(звичайне стирання) - стираються всі лінії і заливання на цьому ж рівні, по яких ви проводите гумкою. 

· Erase Fills(стирання заливання) - стираються тільки заливання, не торкаючись лінії. 

· Erase Lines(стирання ліній)- стираються тільки лінії, не торкаючись заливання. 

· Erase Selected Fills(стирання виділених заливань) - стираються тільки виділені перед початком даної операції заливання. Лінії не зачіпаються, навіть якщо вони виділені. 

· Erase Inside(стирання усередині) - стираються тільки ті заливання, з яких ви почали дану операцію. Якщо ви почали стирати усередині контуру, який не має заливання, то ніщо не буде стерто. Лінії не зачіпаються при цьому режимі. 

3. Виберіть форму гумки в опції Eraser shape. 

4. Переконайтесь що кнопка Faucet (кран) не натиснута. 

Для прискорення виділення об'єктів і їхнього зміщення на сцені: 
1. Виберіть інструмент Arow (стрілка) і виділите на сцені елементи, що ви хочете згрупувати. 

2. Виберіть Modify (Изменить) -> Group (Группировать). 

Завдання :
	1. Змінити квадрат, як показано на малюнку
	[image: image2.jpg]




	2. Вирізати частину еліпса, як показано на малюнку
	[image: image3.jpg]




	3. Змінити квадрат, як показано на малюнку
	[image: image4.jpg]




	4. Змінити коло, як показано на малюнку
	[image: image5.jpg]




	5. На основі отриманих знань створити свій об’єкт, наприклад: автомобіль, з використанням всіх засобів для малювання.


	Варіанти завдань:
№ варіанту

Малюнок

Колір

1

Автомобіль

Свій вибір

2

Літак

Свій вибір

3

Вантажівка

Свій вибір

4

Потяг

Свій вибір

5

Корабель

Свій вибір

6

Ракета

Свій вибір

7

Мотоцикл

Свій вибір

8

Тролейбус

Свій вибір

9

Автобус

Свій вибір

10

Велосипед

Свій вибір

11

Дирижабль

Свій вибір

12

Трамвай

Свій вибір

13

Човен

Свій вибір

14

Каток

Свій вибір

15

Танк

Свій вибір


	Контрольні запитання:
1. Перерахуйте елементи панелі інструментів програми Flash MX. 

2. Які особливості використання інструмента “олівець”?

3. Які особливості використання інструмента “перо”?

4. В яких випадках використовується інструмент “кісточка”?

5. Для чого використовується інструмент “відерце з фарбою”?

6. Які особливості використання інструменту “гумка”?


ПР № 3 Використання кольору при створенні статичних графічних об'єктів. Властивості ліній
Тема: Використання кольору при створенні статичних графічних об’єктів. Властивості ліній.

Мета: Навчитись змінювати кольори графічних об‘єктів.

Теоретичні відомості:

Для роботи з кольором необхідно відкрити селектор кольору. Для цього клікніть на відповідну піктограму в області Colors.
Більша частина селектору кольору зайнята набором квадратів, які представляють доступні для вибору кольори - так звана палітра. Для того, щоб вибрати необхідний колір, помістіть курсор мишки над відповідним квадратом і натисніть ліву клавішу мишки. Також, ви можете вибрати колір, просто “взявши” його з будь-якої точки екрана. Виберіть в панелі інструментів “піпетку”, натисніть в потрібну точку екрана, і колір цієї точки буде вибраний селектором. 
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Якщо ви вибрали інструмент “прямокутник”, “перо” або “еліпс”, то в верхньому правому кутку вікна селектора кольору з’явиться ще одна кнопка - кнопка відключення кольору [image: image7.jpg]


. В нижній частині області Colors знаходяться дві кнопки, які дають додаткові можливості вибору кольору. Кнопка [image: image8.jpg]


- задає для лінії чорний, а для заливки білий колір. Кнопка [image: image9.jpg]


змінює місцями кольори лінії і заливки.
Крім існуючих кольорів, програма Flash MX надає інструмент, який дозволяє створювати нові кольори і додавати їх в палітру. Мова йде про так званий змішувач кольорів. Щоб викликати його на екран виберіть в меню Window пункт Color Mixer. 

[image: image10.jpg]==




В нижній частині змішувача знаходяться два поля вибору кольору. Клікніть на потрібну точку центрального поля, щоб задати сам колір. Після цього клікніть по правому полю, щоб задати його яскравість. І вибраний колір з’явиться у вибраному селекторі. Вибрати потрібний колір можна по іншому: переміщуючи повзунок в панелі змішувача кольорів напроти літер R (червоний), G (зелений), B (синій). Також можна змінити прозорість Alpha.
Для зміни зовнішнього вигляду вже створених вами ліній можна скористатись редактором властивостей. 
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Якщо вам необхідно змінити решту параметрів лінії - клікніть в Properties(Свойства) на кнопку Custom( Другое).  На екрані з’явиться вікно Stroke Style (Стиль Штриха).
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Прапорець Sharp Corners вмикає або вимикає загострення кінців ліній. В списку Type вибираємо тип лінії (Solid - звичайна лінія, Dashed - пунктирна лінія, Dotted - точкова лінія, Ragged - імітація лінії, проведена вручну, Stipple - лінія, яка складається з чорнильних п’ятен, Hatched - лінія, яка складається з поперечних рисок). Якщо вибрано пункт Dashed, в діалоговому вікні з'являється два додаткових поля. В лівому вводиться довжина штрихів, а в правому - відстань між ними. Якщо вибрано пункт Dotted, з’являється поле введення відстані між окремими точками. Якщо вибрано пункт Ragged, в діалоговому вікні з'явиться три додаткових списка. В списку Pattern задається тип лінії, в списку Wave Height задається хвилястість, а в списку Wave Length - довжина хвилі.
Якщо в списку Type вибрано пункт Stipple, з’явиться три додаткових списка - Dot Size (задається розмір плям), Dot Variation (задається різниця в розмірах точок), Density (задається, як близько один до одного знаходяться окремі плями).
І, нарешті, при виборі в списку пункту Hatched в діалоговому вікні Line Style з’явиться шість додаткових пунктів: Thickness (товщина штрихів), Space (відстань між штрихами), Jiggle (зсув штрихів один відносно одного), Rotate (поворот штрихів), Curve (кривизна штрихів), Length (зміна розмірів сусідніх штрихів). Задавши потрібний тип лінії натисніть кнопку ОК.
Для зміни кольору контуру фігури можна скористатися інструментом . Для того щоб змінити колір контуру, скористайтесь верхнім селектором кольору в області Colors. Після чого клікніть в будь-якому місці фігури. 

Практична частина.
Для виконання  роботи необхідно намалювати побригадно завдання, яке складається з завдання розміру робочого поля, примітивного малюнку, і визначення його кольору 
Варіанти завдань: (в дужках вказана довжина радіусу, або сторони).

	
№ варіанту 

	Розмір робочого вікна

	Малюнок

	Колір


	1

	110x85

	Коло (40) , Квадрат (50)

	Свій вибір


	2

	120x90

	Квадрат (50), Ромб (35)

	Свій вибір


	3

	300x250

	Пряма (25), Коло (40)

	Свій вибір


	4

	450x300

	Прямокутник (75, 40),

	Свій вибір


	5

	550x440

	Трикутник (45), Коло (60)

	Свій вибір


	6

	460x350

	Ромб (55), Овал (50, 20),

	Свій вибір


	7

	570x430

	Овал (50, 10), Ромб (35),

	Свій вибір


	8

	380x380

	Коло (40), Трикутник (45)

	Свій вибір


	9

	290x400

	Прямокутник (75, 55),

	Свій вибір


	10

	100x370

	Квадрат (50), Коло (70)

	Свій вибір


	11

	110x110

	Пряма (25), Овал (50, 10)

	Свій вибір


	12

	120x420

	Трикутник (45),  Коло (20)

	Свій вибір


	13

	150x550

	Ромб (35),  Трикутник (45)

	Свій вибір


	14

	540x540

	Овал (10, 50), Пряма (25) 

	Свій вибір


	15

	500x300

	Трикутник (45), Овал (50, 10)

	Свій вибір



	


Контрольні запитання:
1. Для яких інструментів використовується кнопка відключення кольору?
2. Як застосовується інструмент піпетка?
3. Як змінити колір контуру фігури?
4. Як змінити властивості лінії в програмі Flash MX?
5. Яким чином можна створити свій власний колір і додати його в палітру кольорів? 

ПР № 4 Використання заливок
Теоретичні відомості
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Крім простих видів заливки, Flash може створювати і більш складні. Зокрема, градієнтні заливки. Градієнтною називають такий вид заливок, при якому колір плавно змінюється від одного значення до іншого. Наприклад, від синього до білого (див. малюнок). 

Вид заливки можна вибрати в вікні Color Mixer. Параметр None означає, відсутність заливки, Solid - звичайна заливка, Linear - лінійна градієнтна заливка, Radial - радіальна градієнтна заливка, Bitmap - заливка графічним зображенням (див. малюнок).
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Щоб створити лінійну чи радіальну градієнтну заливку, відкрийте змішувач і виберіть у списку заливок відповідно пункт Linear або Radial. Після цього змішувач змінить свій вигляд. Нижче списку видів заливок знаходиться лінійка задання ключових кольорів заливок. По цій лінійці переміщаються два покажчика, що задають потрібні кольори. Ви можете вибирати той чи інший покажчик, просто клацнувши по ньому мишею; обраний покажчик має не білу, а чорну стрілку. Вибравши покажчик, ви можете задати відповідний ключовий колір, вказавши його в розташованому правіше селекторі кольору, або скориставшись двома розташованими нижче панелями, Ну і, звичайно, можна переміщувати покажчики, "захоплюючи" їх мишею, щоб підібрати потрібну відстань між ключовими кольорами.

Задання ключових кольорів для лінійної і для радіальної заливки виконується однаково. Різний тільки результат. Крім градієнтних заливок із двома ключовими кольорами, ви можете створити і багатобарвні заливки. Наприклад, білий колір плавно змінюється до чорного, а потім - знову "біліє".

Щоб створити таку заливку, вам потрібно додати до лінійки кольору новий покажчик - для проміжного кольору. Для цього виберіть потрібне місце на лінійці і клацніть мишею трохи нижче неї, на рівні основних покажчиків. На лінійці з'явиться новий покажчик. Ви також можете переміщувати його і змінювати ключовий колір. Щоб знищити створений вами покажчик, просто опустіть його вниз мишкою. Знищити два початкових покажчики, створених самою програмою, неможливо.

Flash підтримує градієнтні заливки, що мають до восьми кольорів включно.

Може статися так, що в процесі роботи ви створите яку-небудь дуже вдалу заливку і забажаєте зберегти її на майбутнє. У цьому випадку виберіть у додатковому меню змішувача пункт Add Swatch. Після цього створена вами градієнтна заливка буде додана в нижню частину вікна селектора кольору, де ви зможете її в будь-який момент вибрати.

Можливо, також в якості заливки використати вже існуюче растрове зображення. Єдина вимога, зображення має бути збережене у форматі, який підтримує Flash. Імпортуємо потрібний графічний файл. Для цього виберіть пункт Import у меню File. Знищіть малюнок який з‘явився клавішею Del. Виберіть в списку видів заливок пункт Bitmap. У вікні, що звилося натисніть на потрібний графічний файл. Далі, при створенні, наприклад, фігури “еліпс” або “прямокутник” заливка прийме вигляд растрового зображення. Заливку можна змінювати. Для цього використовується на панелі інструментів “трансформатор заливки” [image: image13.jpg]


. 

Практична частина

Завдання:
1. Завантажити програму Flash MX.

2. Створити фігури з поданими нижче заливками:
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3. Створити фігури з поданими нижче заливками:
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4. Зберегти створені заливки.

Контрольні запитання
1. Що таке “градієнтна заливка”?

2. Які види “градієнтної заливки” ви знаєте і чим вони відрізняються?

3. Яким чином можна зберегти створену заливку?

4. Що таке “графічна заливка”?

5. Для чого використовується “трансформатор заливки”?

ПР № 5 Робота з графічними фрагментами
Теоретичні відомості
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Графічні об’єкти, інколи, потрібно вирівняти. Наприклад, по верхній стороні листа, або по правій стороні самого правого об’єкта. Можливі також інші дії щодо вирівнювання графіки.

Вирівнювання графіки виконується за допомогою панелі Align. Для того, щоб вона з’явилась на екрані, виберіть пункт Align (Выравнивание) в меню Window (Окно) (див. малюнок). Розглянемо чотири групи кнопок, які містяться в цій панелі.

Група кнопок Align виконує вирівнювання:

· Left - вирівнювання по лівій границі самого лівого виділеного фрагмента;

· Center Vertical - вирівнювання по центральній вертикальній осі всієї виділеної групи об’єктів;

· Right - вирівнювання по правій границі самого правого виділеного фрагмента;

· Top - вирівнювання по верхній границі самого верхнього виділеного фрагмента;

· Center Horizontal - вирівнювання по центральній горизонтальній осі всієї виділеної групи об’єктів;

· Bottom - вирівнювання по нижній границі самого нижнього виділеного фрагмента.

Група кнопок Distribute виконує переміщення фрагментів графіки так, щоб їх границі або центри знаходились на рівній відстані один відносно одного.

· Розподіл верхніх границь - переміщення фрагментів по горизонталі таким чином, щоб їх верхні границі знаходились на однаковій відстані одна відносно одної;

· Розподіл центрів по вертикалі;

· Розподіл нижніх границь;

· Розподіл лівих границь - переміщення фрагментів по вертикалі таким чином, щоб їх ліві границі знаходились на однаковій відстані;

· Розподіл один відносно одного;

· Розподіл центрів по горизонталі.

Група кнопок Match Size задає розміри для виділених фрагментів. Перерахуємо кнопки зліва направо:

· Всі фрагменти повинні мати однакову ширину;

· Всі фрагменти повинні мати однакову висоту;

· Всі фрагменти повинні мати однакову ширину і висоту;

Група кнопок Space задає однакову відстань між виділеними фрагментами. Перерахуємо кнопки зліва направо:

· Вертикальна відстань між фрагментами повина бути однаковою;

· Горизонтальна відстань між фрагментами повина бути однаковою.

Кнопка To Stage дозволяє примінити вирівнювання не до групи об’єктів, а до всієї робочої області листа.

Програма Flash MX дозволяє переміщувати і змінювати розміри графічних об’єктів. Виділіть будь-який графічний об’єкт. В нижньому кутку редактора властивостей знаходяться чотири поля введення. В полі W i H задаються відповідно ширина і висота виділеного фрагмента, X i Y - координати фрагмента.

Виберіть пункт Info в меню Window. Крім вже знайомих полів введення, в цій панелі знаходиться перемикач точки відліку, який дозволяє вибрати точку виділеного фрагмента, відносно якої будуть відраховуватись координати.

Якщо потрібно виконати дзеркальне відображення графіки виберіть пункти Flip Horizontal (Перевернуть по горизонтали) або Flip Vertical підменю Transform ( Трансформация) меню Modify( Изменить).

Познайомимось з одним із найпотужніших інструментів Flash - “трансформатором”. Для того, щоб вибрати “трансформатор” натисніть в інструментарії кнопку [image: image25.jpg]


. Для зміни розмірів графічного фрагмента мишкою при ввімкненому “трансформаторі” виберіть кнопку “зміна розміру” [image: image26.jpg]


. Вигляд графічного об’єкта змінився. Він ніби вписаний в прямокутник, на сторонах і кутах якого розміщені невеликі квадрати - маркери зміни розмірів. Обертання і зсув виділеного графічного фрагмента можливі при ввімкненому інструменті “трансформатор” і модифікаторі “обертання і зсув” [image: image27.jpg]


. Можна, також, вибрати пункт Rotate and Skew в підменю Transform меню Modify. Якщо потрібно швидко повернути виділений фрагмент на 90 градусів використайте меню. Пункт Rotate 900 CW в підменю Transform меню Modify повертає об’єкт на 90 градусів за годинниковою стрілкою, а пункт Rotate 90 градусів CWW - проти.

З появою Flash MX стало можливим змінювати форму графічного об’єкта. Для цього слід вибрати модифікатор “огинаюча” [image: image28.jpg]


інструмента “трансформатор”.

За допомогою модифікатора “огинаюча” можливо змінювати тільки “звичайну” графіку. Екземпляри, групи і текстові блоки, а також градієнтні заливки не можуть бути змінені. Для того, щоб використати цей інструмент натисніть кнопку . Якщо при вибраному інструменті “трансформатор” не ввімкнений жоден модифікатор, то фактично всі вони ввімкнені одночасно. Тому, в цьому випадку, говорять про вільну трансформацію. При якій ви можете будь-як змінювати виділений графічний об’єкт. 

Практична частина

Завдання:
1. Завантажте програму Flash MX.

2. Намалюйте три будь-яких графічних об‘єкта (наприклад еліпс, трикутник, прямокутник) і використовуючи панель Align вирівняйте їх відносно листа.

3. Поверніть трикутник на 90 градусів за годинниковою стрілкою, а прямокутник на 90 градусів проти годинникової стрілки.

4. Намалюйте за вибором малюнок, використайте панель Align, при розташуванні об‘єктів на екрані.

Контрольні запитання:
1. При допомозі якої панелі виконується вирівнювання графічних об'єктів?

2. Перерахуйте групи кнопок панелі Align.

3. Як виконати дзеркальне відображення графіки в програмі Flash MX?

4. За що відповідає кнопка Space на панелі Align?

5. Як можна повернути графічний об’єкт на 900 в програмі Flash MX?

6. Які дії можна виконати з графічним об’єктом, якщо при вибраному інструменті “трансформатор” не ввімкнений жоден модифікатор?

ПР № 6 Створення простих мультиплікацій. Покадрова анімація в Macromedia Flash
Тема: Створення простих мультиплікацій. Покадрова анімація  в   Macromedia Flash.
Мета: Навчитися використовувати засоби створення простих мультиплікацій  за допомогою покадрової анімації.

Теоретичні відомості.

Анімація в програмі Flash створюється шляхом зміни змісту послідовно розташованих кадрів. Можна переміщати об'єкти по робочому полю, збільшувати чи зменшувати їх, обертати, змінювати колір, змусити їх поступово з'являтися, чи зникати, чи змінювати свою форму. Зміни можуть відбуватися незалежно одне від одного, й одночасно зі змінами в інших шарах. Наприклад, можна змусити об'єкт поступово з'являтися на робочому полі обертаючись. 
Програма Flash MX дозволяє створювати анімацію двома способами. Перший вид анімації - це покадрова, другий - трансформаційна.
Покадрова анімація (Frame-by-frame)  - це анімація, яка являє собою набір зображень різних фаз руху - кадрів, які змінюють один одного з великою швидкістю (при цьому всі зміни в кожнім кадрі задаються вручну).
Трансформаційна анімація (tweened)  - автоматична. Від покадрової вона відрізняється тим, що не описує кожен кадр послідовності окремо, а одразу задає поведінку того чи іншого графічного примітива. Кадри, створені користувачем називаються основні. Створені програмою кадри - допоміжні. При цьому способі вручну задаються тільки тривалість анімації (завданням числа кадрів)), а також початкові і кінцеві форми і взаєморозташування об’єктів (у ключових кадрах), а всі проміжні значення генеруються (інтерполюються) самою програмою Flash. 
Покадрова (Frame-by-frame) анімація збільшує розмір файлу набагато більше ніж tweened анімація. 
Вікно робочого поля (Stage) є областю, у якій Ви створюєте кадри анімації, або безпосередньо їх малюючи, або імпортуючи ззовні. 
На монтажній лінійці (Timeline) ви синхронізуєте анімацію в часі і розташовуєте графічні елементи на різних шарах. Монтажна лінійка показує кожен кадр ролика. Шари виконують роль пачки прозорих паперів, так, що графічні елементи, розташовані на різних шарах, у підсумку утворять цільне зображення.
У бібліотеці (Library) ви зберігаєте й організуєте створені в Flash символи, а також імпортовані файли, включаючи звукові. Символи можуть складатися з графічних елементів, чи кнопок анімаційних кліпів. Бібліотека дозволяє вам організовувати ваш архів у вигляді папок, контролювати, як часто той чи інший елемент використовується в кліпі, і сортувати їх у залежності від типу.
Ключовий кадр (Keyframe) - це кадр де ви визначаєте зміни у формі і взаєморозташуванні об'єктів, що беруть участь в процесі анімації. При створенні покадрової анімації кожен кадр є ключовим. Ключові кадри, що містять які-небудь об'єкти, відображаються в тайм-лайн заштрихованими чорними крапками. Порожні ключові кадри відображаються як незаштриховані кружки. Перший кадр кожного шару (Layer) завжди ключовий. Зміст простих кадрів кожного шару (якщо тільки вони не беруть участь у tweened анімації) завжди цілком повторює зміст попереднього ключового кадру. 
Покадрова анімація змінює зміст ролика в кожнім кадрі і найкраще підходить для створення складної анімації, у якій об'єкти замість простого переміщення змінюються в кожнім кадрі. Покадрова анімація збільшує розмір файлу більше ніж автоматична (tweened). 
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Після того, як ви створюєте новий кадр, чи ключовий кадр, ви можете перемістити його в інше місце поточного шару, чи в інший шар, видалити його і зробити з ним інші зміни. Тільки ключові кадри доступні для редагування. Важливим моментом при створенні анімації є вибір частоти кадрів (fps). Якщо задати занадто низьку частоту, то рух об'єктів буде відбуватися ривками, а якщо занадто завищити її значення, це призведе, по-перше до погіршення сприйняття деталей і по-друге до деякого зменшення його тривалості. Звичайно вибирають частоту в межах 12 кадрів у секунду для досягнення найкращих результатів у мережі Інтернет. Взагалі говорячи, 12 fps є практично стандартом для QuickTime і AVI роликів, у той час як стандартна частота зміни кадрів у кіно - 24 fps. Тому не варто задавати занадто високу частоту зміни кадрів. Оскільки ви визначаєте тільки одну частоту кадрів для усього Flash ролика, найкраще встановити її до початку створення анімації.
Розглянемо процес створення покадрової анімації на основі прикладу, який зображено на рисунку. 
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Наш фільм буде містити п’ять кадрів. Задайте частоту кадрів рівну 6, для цього виберіть в меню Modify пункт Document, введіть в поле введення Frame Rate число 6 і натисніть ОК. Далі намалюємо перший кадр, він буде виглядати як показано на Рис.1.
Зверніть увагу на верхню частину вікна Flash. Там знаходиться шкала з кадрами, при допомозі якої створюється анімація, і покадрова, і трансформаційна. В ній схематично зображено послідовність намальованих нами кадрами. Якщо натиснути мишкою на потрібний кадр, то його вміст з’явиться на екрані. При створенні покадрової анімації всі кадри будуть основними. Один основний кадр у нас вже є - це перший кадр. Тепер нам потрібно просто додавати нові кадри до вже створених, формуючи таким чином послідовність кадрів. 
Алгоритм нашої роботи буде таким:
Малювання зображення для нового кадра;
Перехід до наступного кадра (просто натисніть на кадр лівою клавішою миші в шкалі з кадрами);
Якщо не кінець фільма, то перехід до першого пункту.
Основний кадр, який містить зображення, на шкалі з кадрами відображається темно-сірим прямокутником з чорною крапкою. Порожній основний кадр відображається білим прямокутником з чорною рамкою.
Для того, щоб створити новий основний кадр, виділіть перший порожній кадр правіше останнього основного кадра і виберіть пункт Keyframe в меню Insert, або пункт Insert Keyframe в контексному меню виділеного порожнього кадра. Новий основний кадр буде створено. При цьому вміст попереднього основного кадра копіюється в новостворений. Таким чином, вам не потрібно буде малювати кожен кадр з початку, а тільки підправити попереднє зображення. Якщо ж вам потрібно створити порожній основний кадр, виберіть пункт Blank Keyframe в меню Insert. Інколи потрібно, щоб в деякий момент часу зображення не рухалось. Для цього потрібно розтягнути відповідний основний кадр. Переглянути новостворений фільм в середовищі Flash можна натиснувши <Enter>. Також ви можете вибрати пункт Play меню Control. Для зациклювання фільма ввімкніть пункт Loop Playback в меню Control. Для управління фільмом виберіть пункт Controller в підменю Toolbars меню Window. Для перегляду фільма в окремому вікні виберіть пункт Test Movie в меню Control. 
Flash MX дає можливість вносити зміни в створений фільм. Розглянемо яким чином це можна зробити. Отже, якщо вам потрібно вставити основний кадр в середину послідовності кадрів, потрібно звільнити місце в послідовності кадрів. Flash розтягне попередній кадр, створивши допоміжний, який в свою чергу, можна перетворити на основний. Виділіть допоміжний кадр і виберіть пункт Insert Keyframe. Перетворити допоміжний кадр в основний можна іншим чином: виділіть потрібний кадр і виберіть підменю Frames меню Modify або в контексному меню виділеного кадра пункти Convert to Key Frames або Convert to Blank Key Frames. Перший пункт перетворює кадр в основний і копіює в нього зображення з розтягнутого. Другий пункт - перетворює кадр в порожній основний. Зворотня операція перетворення основного кадра в допоміжний (тобто, знищення основного кадра, зробивши його частиною розтягнутого) також можлива. Для цього виділіть потрібні основні кадри і виберіть пункт Clear Keyframe в меню Insert. Знищувати непотрібні кадри можна використовуючи пункт Remove Frames в меню Insert. Пункти Cut Frames і Copy Frames меню Edit дозволяють відповідно переміщувати і копіювати виділені кадри в буфер обміну. Пункт Paste Frames меню Edit вставляє кадри з буфера обміну. В меню Edit пункт Clear Frames знищує вміст виділеного кадра. 
Кожна сцена (Scene) у Flash ролику може складатися з будь-якого числа шарів. Програма Flash не задає в одному шарі різні анімаційні ефекти для кількох об'єктів - шари потрібні для того, щоб розділити різні, але одночасні анімаційні завдання для кожного з об'єктів, що зміщується, чи змінюються. Дуже важливо запам'ятати, що якщо ви хочете неоднаковим образом змінити форму, чи координати декількох об'єктів з використанням автоматичної анімації в одному шари, то між ключовими кадрами початку анімаційних дій завжди повинний міститися порожній ключовий кадр (Blank Keyframe). А якщо вам хочеться зробити різні анімаційні дії з декількома об'єктами одночасно, то кожний з них повинний бути в окремому шари. Як правило, фоновий (звичайно самий нижній) шар містить один чи кілька статичних об'єктів, а додаткові шари містять по одному анімованому об'єкту кожний. 
Будь-який достатньо довгий і складний фільм поділяється на окремі сцени -завершені епізоди, які в достатній мірі не залежать один від одного. Кожна сцена повинна мати унікальне ім’я. Нумерація кадрів з використанням сцен виконується таким чином: наприклад, якщо в фільмі є дві сцени по 10 кадрів кожна, то перша сцена буде містити з 1 по 10 кадр, друга - з 11 по 20.
Для управлінням сценами - створенням, зміною, знищення, впорядкування - існує панель Scene. Для вивидення її на екран, виберіть 
пункт Scene в меню Window. 
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Для того, щоб додати нову порожню сцену, натисніть кнопку Add Scene [image: image32.jpg]


. Для дублювання існуючих сцен виділіть потрібну сцену і натисніть кнопку Duplicate Scene [image: image33.jpg]


. Для знищення непотрібної сцени виділіть її і натисніть кнопку Delete Scene [image: image34.jpg]


.
Якщо переглядати створений фільм в середовищі Flash (вибраний пункт Play в меню Control), майте на увазі, що за замовчуванням демонструється зміст поточної сцени. Для перегляду всіх сцен виберіть пункт Play All Scenes в меню Control. При перегляді фільма в окремому вікні (вибраний пункт Test Movie в меню Control) завжди демонструються всі сцени фільма. Якщо ж ви бажаєте переглянути в окремому вікні тільки поточну сцену, виберіть пункт Test Scene в меню Control. 

Практична частина.
Порядок виконання роботи 

1. Створіть новий файл.
1. Задайте файлу параметри.
2. Створіть ключовий файл із зображенням.
3. Покадрова анімація.
4. Копіювання кадру та послідовності кадрів.
5. Зміна швидкості анімації.
6. Аналіз результатів і висновки. 

Методичні вказівки. 
Створення нового кліпу й установка його параметрів 
Щоразу при запуску Flash, він створює новий файл. Використовуючи вікно діалогу властивостей можна задати його розмір, частоту кадрів, колір фону й інші параметри кліпу. 
Для створення нового кліпу й установки його властивостей: 
1) Виберіть File > New.
2) Для завдання частоти кадрів, введіть ту кількість кадрів анімації, що повинна бути показана в секунду. Для більшості комп'ютерних анімацій, особливо застосовуваних на сторінках Web, цілком достатньо вказати в межах 8 - 12 fps (кадрів у секунду).
3) Щоб вказати розмір у пикселах, введіть значення ширини і висоти. За замовчуванням, розмір кліпу встановлений у 550 на 400 пікселів. Мінімальною величиною є 18 х 18 пікселів; максимальною - 2880 х 2880 пікселів. Для установки розміру робочого поля, яке має рівні відступи навколо елементів, що знаходяться на ньому, натисніть на кнопку Contents. Для такої мінімізації розміру, попередньо розмістіть весь зміст робочого поля в його верхньому лівому куті. Для завдання величини робочого поля рівної максимально доступної області друку, натисніть на кнопку Printer. Ця область друку визначається форматом папера, обраним на даний момент в області Поля (Margins) діалогового вікна Параметри сторінки (Page Setup), зменшеним на величину полів.
4) Для використання сітки, вкажіть розмір осередків (Grid Spacing), кнопкою Grid color (Колір сітки) встановіть колір і включіть перемикач Show grid (Показати сітку).
5) Для завдання кольору фону кліпу, виберіть колір Права кнопка миші > Свойства документа( Document Properties) > Фоновы цвет (Back ground Color)
7) Виберіть одиниці виміру зі списку - Единицы измерения(Ruler Units).
Для створення покадрової анімації: 
1) Натисніть мишкою на назві шару, щоб зробити його поточним і визначить кадр, де вам хочеться почати анімацію. 
2) Якщо цей кадр не ключовий, виберіть з меню Insert > Keyframe (чи просто натисніть F6), щоб зробити його ключовим.
3) Створіть зображення для першого кадру послідовності (воно може складатися з будь-якого числа об'єктів будь-яких типів). Тут можна сміливо використовувати будь-які інструментальні засоби малювання, вставляти графіку і текст із буфера обміну, чи імпортувати файли.
4) Натисніть на наступний кадр (правіше) у цьому ж шари, і виберіть Insert > Keyframe, чи натисніть правою кнопкою миші і виберіть Insert Keyframe з випливаю чого меню правої кнопки (чи почніть використовувати для цієї мети F6). При цьому з'явиться новий ключовий кадр, причому його вміст буде цілком повторювати зміст попереднього ключового кадру.
5) Змініть вміст цього нового ключового кадру, щоб задати зміни які будуть відбуватися по ходу анімації. 
6) Повторюйте кроки 4 і 5 доти поки вам не здасться, що анімація нарешті довершена і рух, задуманий вами, сформовано. Часто буває корисно періодично відтворювати вже готову частину для того, щоб подивитися що ж там таке виходить.
7) Для того щоб подивитися, що там вийшло, виберіть Control > Play чи натисніть кнопку Play на Контролері  або  Enter  або Ctrl + Enter. 
Для копіювання кадру і його змісту вибираємо кадр, чи послідовність кадрів (можна навіть у декількох шарах), і з меню Edit > Copy Frames . Для розміщення скопійованих кадрів в іншім місці в анімації (чи не в анімації, чи взагалі всередині одного із символів) вибираємо кадр із якого почнеться вставка, чи послідовність кадрів яка буде замінена в процесі вставки, і з меню Edit > Paste Frames. Щоб перемістити кадри і їх зміст, вибираємо у тайм-лайн кадр, чи послідовність кадрів і перетаскуємо їх у бажане місце в тайм-лайн. Щоб змінити довжину анімованої послідовності, перетаскуємо перший чи останній ключовий кадр із її складу, вправо, чи вліво. Щоб змінити довжину анімованої послідовності при покадровій анімації, змінюємо різницю в змісті сусідніх ключових кадрів при її створенні (а для зменшення швидкості анімації такого типу без зміни глобальних параметрів ролика (частоти кадрів) можна вставити після кожного (чи не кожного) ключового кадру, простій).
 Завдання: 
1. Завантажте програму Flash MX.
2. Створіть фільм, з п’яти кадрів поданий на рисунку
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Перегляньте створений фільм в середовищі Flash.
3. Створіть фільм, з семи  кадрів  - довільний вибір. 
Контрольні запитання
1. Які види анімації можна створювати, використовуючи програму Flash MX.
2. Що таке покадрова і трансформаційна анімація?
3. Як змінити частоту кадрів в фільмі?
4. Що таке основні і допоміжні кадри?
5. Яким чином перетворити основні кадри в допоміжні і навпаки?
6. Які операції можна виконувати з кадрами?
7. Що таке сцени, і для чого вони використовуються?
8. Які дії можна виконувати з сценами?

ПР № 7 Трансформаційна (Тwееnеd) анімація в Macromedia Flash
Тема: Трансформаційна ( Тwееnеd ) анімація в Macromedia Flash.
Мета: Ознайомлення з трансформаційним видом анімації Навчитися використовувати принцип створення twееnеd–анімації.

Теоретичні відомості
Трансформацією руху називається такий вид трансформації графічного елемента, коли він змінює місцезнаходження, зовнішній вигляд або колір. 
Flash може створювати два типи tweened анімації. В першому, який називається Motion tweening (анімація типу "рух") найкраще задати позицію і розмір об'єктів у ключовому кадрі початку анімації, а в кінцевому задати зміни позиції, розміру, кольору і прозорості об'єктів чи змусити їх обертатися. В другому, який називається Shape tweening (анімація типу "перетворення" чи зміна форми) у ключовому кадрі початку анімації задається початкова форма об'єкта, а в ключовому кадрі кінця анімації - кінцева форма. Flash інтерполює значення координат, розміру, чи форми об'єктів для всіх проміжних кадрів, створюючи анімацію. 
Tweened анімація - ефективний спосіб створити плавний рух, чи зміна об'єктів не занадто збільшуючи розмір файлу. Тут, на відміну від покадрової анімації, Flash оперує тільки з відмінностями наступного кадру від попереднього і не промальовує заново весь об'єкт у кожнім кадрі. По цьому ж принципу "Shape" для складних об'єктів збільшує розмір кінцевого ролику більше чим "Motion". 
Автоматична (Тweened) анімація в тайм-лайн відображається в такий спосіб: 
Автоматичний рух (Motion-tweening) - ключові кадри відзначені чорною крапкою, а проміжна ланка tweened-структури зображення чорною стрілкою на синім фоні. [image: image36.jpg]




Ключові кадри автоматичної зміни форми (Shape-tweening) відзначені чорною крапкою і проміжна ланка tweened-структури зображена чорною стрілкою на зеленому фоні. [image: image37.jpg]




Пунктирна лінія вказує на проблеми з анімацією. [image: image38.jpg]



Окремі ключові кадри відзначені чорними крапками. Ясно-сірі кадри після ключового кадру містять те ж саме, що і ключовий кадр без яких-небудь змін. 
Порожній ключовий кадр позначається маленьким чорним кружком. Маленький символ а вказує на те, що ключовому кадру була призначена дія з діалогового вікна властивостей кадру (Properties Frame). [image: image39.jpg]
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Червоний прапорець вказує на те, що ключовий кадр містить мітку, чи коментар.
Якщо в процесі анімації вам необхідно змінювати властивості об'єктів використовуйте анімацію типу рух (motion tweening) . Використовуючи цей тип анімації, Flash може автоматично змінювати позицію і розмір об'єктів, обертати і спотворювати їх. Крім того Flash може змінювати колір об'єктів, чи змушувати їх поступово з'являтися, чи зникати (зміною прозорості (alpha)). Анімаційній зміни всіх цих властивостей піддаються тільки об'єкти типу Символ (Symbol). Відповідно об'єкти типу Текст і типу Малюнок не мають "властивостей" у меню правої кнопки і відповідно не можуть їх змінювати. Якщо ви вирішили застосувати анімацію типу рух до малюнка, вам доведеться спочатку перетворити його в символ (F8). І якщо вам хочеться зробити з об'єктом типу текст щось більше чим просте переміщення-обертання (наприклад змінити його колір, чи прозорість) то вам теж прийдеться спочатку перетворити його в символ. 
Якщо ви створюєте анімацію типу рух з меню властивостей кадру, вам доведеться виконати перетворення в символ вручну. Якщо ж ви створюєте анімацію з меню 
Insert > Create Motion Tween, то всі об'єкти з виділеного в цей момент ключового кадру автоматично перетворяться в один символ з ім'ям Tween і цифрою номера. 
Якщо ви використовуєте анімацію типу рух для об'єкта типу символ, можна змусити його зміщуватися по нелінійному шляху (це стає можливим через те, що в символі крім властивостей є ще і центр).
В процесі створення анімації часто використовуються символи, що складаються більш ніж з одного кадру. В основній сцені часто використовують складні анімовані і багатошарові символи. Для того щоб анімація, створена при редагуванні окремого символу, належним образом відображалася в основному ролику, необхідно робити проце дуру Синхронізації.
Крім звичайних шарів у Flash маються деякі спеціальні види шарів. Один з таких спеціальних видів називається "Motion guide". Використовуючи цей тип шару в якості "ведучого" можна змусити символи в шари, рухатися по будь-якому заданому (наприклад криволінійному чи круговому) шляху.
Використовуючи анімовану зміну форми об'єктів можна добитися ефектів подібних трансформації (morphing), змушуючи один об'єкт повільно перетворюватися в іншій. З використанням цього типу анімації Flash може також повільно змінювати розташування, розмір і колір об'єктів. Але в цьому випадку не відбувається руху зі збереженням форми, а тільки повільне "перетікання" об'єктів з одного положення в інше. Варто мати на увазі що анімовані дії зі зміною форми можна робити тільки з об'єктами типу Малюнок. Втім об'єкти типу Текст і типу Символ легко можна перетворити в Малюнок використовуючи дію Break Apart (Ctrl+b). 
На відміну від анімації типу рух, тут Flash може займатися зміною форми відразу декількох об'єктів типу Малюнок в одному шарові. І все-таки розташування кожного об'єкта в окремому шару звичайно призводить до кращих результатів. Дуже цікавих результатів можна досягти при анімованій зміні форми з використання Контрольних точок.
Використання Контрольних точок дозволяє керувати більш складними процесами по зміні форми об'єкта і дозволяє досягти неймовірних результатів. Контрольні точки ідентифікують ділянки, що повинні співпадати в початкових і кінцевих формах об'єкта. Наприклад якщо спробувати зробити анімовану зміну малюнка виразу обличчя, можна використовувати Контрольні точки і відзначити кожне око. Тоді, замість перетворення обличчя в аморфну плутанину в процесі анімації, кожне око залишається на своєму місці і буде змінюватися окремо від інших ділянок малюнка. 
Максимальне число Контрольних точок - 26. 
Контрольні точки відображаються жовтим у стартовому кадрі, і зеленим в останньому. Якщо ж вони розташовані не на лінії зі змінюваного об'єкта - позначення відбувається червоним кольором. 
Для досягнення найкращих результатів анімованої зміни форми, використовуйте наступні рекомендації: 
При перетворенні однієї складної форми в іншу, створюйте проміжні форми і здійснюйте перетворення не відразу з початкової форми в кінцеву, а з початкової в проміжну (потім в іншу проміжну і т.д.), і вже з проміжної в кінцеву. 
Дотримуйте послідовності Контрольних точок у ключових кадрах, наприклад якщо маються 3 Контрольні точки в одному рядку, вони повинні бути розташовані в тім же самому порядку у всіх ключових кадрах анімації зі зміною форми. Якщо ж вони в одному ключовому кадрі читаються праворуч як ABC, а в іншому як ACB, нічого гарного не вийде. Контрольні точки працюють найкраще, якщо розмістити їх по черзі, проти годинникової стрілки, починаючи з лівого верхнього кута об'єкта.
Для прикладу візьмемо фільм, створений в попередній практичній роботі.
Наш фільм буде складатися з двох сцен. Перша сцена буде містити назву фільма. Друга сцена міститеме, власне, саму анімацію.
Відкрийте файл створеного нами фільма в середовищі Flash MX і створіть в ньому нову порожню сцену. Перемістіть її на початок списка. Назва фільма повинна з’являтись на початку фільма. Створіть текстовий блок, помістіть його в центрі робочого листа і напишіть: МІЙ ПЕРШИЙ ФІЛЬМ.
Перейдемо до створення трансформації руху. Спочатку створемо два основних кадра, а вже потім - анімацію.
Виберіть перший кадр анімації і перемістіть назву фільма вверх, поки вона не вийде за границі листа. Те, що знаходиться за границями листа, не з’являється при перегляді готового файла, однак, реально існує. Цим можна скористатися, щоб зробити який-небудь елемент невидимим, а потім вивести на екран. Таким чином підемо і ми: спочатку назва фільму буде знаходитись за межами робочого листа, а потім плавно з’явиться в його центрі.
Використовуйте панель Align для того, щоб вирівняти назву точно по центру.
Створимо другий основний кадр. Виділіть на шкалі кадрів кадр № 6. Створіть новий основний кадр, вибравши пункт Keyframe в меню Insert. Перший основний кадр відразу ж розтягнеться, заповнюючи весь вільний простір від початку послідовності до другого основного кадра. Виділіть другий основний кадр і перемістіть назву фільма в середину листка. Знову виділіть перший основний кадр. Зверніть увагу, що при цьому Flash автоматично виділила все, що знаходиться на робочому листі. Відкрийте редактор властивостей (properties). В списку Tween виберіть пункт Motion.
Увага: анімація створюється для всього листка, тому в одному “слою” може знаходитись тільки один анімований елемент.
Натисніть мишкою по робочому листі і натисніть <Enter>. Анімація працює.
Ускладнемо наш фільм. Непогане враження складає ефект поступової появи на екрані, або навпаки зникнення графічного фрагмента. Підемо таким шляхом і ми. Нехай назва фільма, закінчивши рух, поступово зникне з екрану.
Для цього одразу після завершення першої анімації впритул потрібно додати другу. Тобто, щоб другий основний кадр першої послідовності став першим основним кадром для другої. 
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Виділимо другий основний кадр першої анімації на шкалі кадрів і виберемо в меню Insert пункт Create Motion Tween. Далі вставимо в кадр № 12 новий основний кадр. Виберіть пункт Alpha в списку, який розташований в правому верхньому куті редактора властивостей. В поле введення з регулятором введем значення 0%. - повна прозорість. Натисніть <Enter> - результат з’явиться на екрані.
Розглянемо редактор властивостей, коли вибрано основний кадр анімації.
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В верхньому лівому куті редактора, нище напису Frame знаходиться поле введення Frame Label. За допомогою якого можна задати ім’я кадра.
Прапорець Scale відповідає за маштабування елементу анімації.
Використовуючи поле введення з регулятором Easing ви можете задати ступінь уповільнення руху елемента при завершенні анімації. Значення від 1 до 100 - рух елемента почнеться швидко, а потім уповільнеться; значення від -1 до -100 - рух елемента почнеться повільно, а потім прискориться. Значення 0 означає, що елемент завжди буде рухатись рівномірно.
Список Rotate задає напрям обертання анімованого елемента, якщо воно було задіяне. Доступні чотири пункти:
None - елемент не буде обертатися взагалі, навіть якщо було задано обертання;
Auto - елемент буде обертатися в тому напрямку, в якому було задано обертання;
CW - елемент завжди буде обертатися в напрямку за годинниковою стрілкою;
CCW - елемент завжди буде обертатися в напрямку проти годинникової стрілки.
Трансформація руху застосовується тільки для екземплярів, груп і текстових блоків.
Трансформація форми - це плавна зміна форми графічного фрагмента. На відміну від трансформації руху вона може застосовуватись до “звичайної графіки”. Для перетворення графічного фрагмента в “звичайну графіку” виберіть пункт Break Apart меню Modify. На відміну від трансформації руху, трансформація форми може застосовуватись відразу для кількох графічних фрагментів.
Трансформація форми створюється аналогічно трансформації руху: задаються основні кадри, де анімація починається і закінчується, змінюється форма графічного об’єкта або його положення на листі. 
Виділіть перший основний кадр анімації і виберіть в списку Tween редактора властивостей пункт Shape. Трансформація форми буде створена.
Очевидно, трансформація руху підходить в тих випадках, коли використовуються екземпляри, групи або текстові блоки. А екземпляри потрібні, коли ваша графіка містить багато однакових елементів.
Якщо ж ваша графіка не містить однакових фрагментів, краще використати трансформацію форми. І, звичайно, без неї не обійтися, коли потрібно змінити форму графічного об’єкта. 

Практична частина.
Порядок виконання роботи 
1. Створення нового анімованого файлу.
2. Задання файлу параметрів.
3. Створення анімованого зміщення об’єкту.
4. Синхронізація анімованого символу.
5. Анімована зміна форми.
6. Задання контрольних точок.
7. Аналіз результатів і висновки.
Методичні вказівки 
Запустіть програму Macromedia Flash .
Створення нового кліпу та Задання йому параметрів
Щораз при запуску Flash, він створює новий файл. Використовуючи вікно діалогу властивостей можна задати його розмір, частоту кадрів, колір фону та інші параметри кліпу. 
Для створення анімованого зміщення об'єкта, чи групи об'єктів потрібно проробити наступне: 
1) Виберіть порожній ключовий кадр і створіть у ньому потрібні об'єкти, чи перетягніть символи з вікна Library (чи Window > Library).
2) Виберіть Insert > Create Motion Tween. (Ключовий кадр з об'єктами в цей момент повинний бути виділеним). Якщо в цьому ключовому кадрі містяться кілька об'єктів (чи один об'єкт але не типу символ) всі вони будуть згруповані в автоматично створеному символі з ім'ям Tween x.
3) Вставте потрібне вам число простих кадрів. Наприклад якщо ви задумали зробити всі анімаційні дії протягом 20 кадрів, просто перейдіть мишкою в цьому шари тайм-лайн на 20 кадрів правіше і натисніть F5.
4) Змістіть цей, тільки що створений, об'єкт типу символ ближче до бажаної кінцевої позиції. Самий останній простий кадр цього шару автоматично перетвориться в ключовий.
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5) Щоб задати властивості анімації можна просто двічі натиснути на кадрі в якому вона починається, чи вибрати з меню правої кнопки на цьому кадрі Properties-Tweening. Якщо в процесі анімації змінюються розміри об'єктів, поставте галочку у віконці "Tween Scaling". Якщо вам хочеться щоб об'єкт, чи група об'єктів згрупованих в один символ, не просто перемістилася з заданого вами початкового положення в задане вами ж кінцеве, ви можете змусити об'єкт обертатися в процесі переміщення. За це відповідає розділ "Rotate" у меню властивостей анімації типу рух. В цьому розділі можна вибрати в яку сторону буде відбуватися обертання (по годинній стрілці, чи проти) і скільки разів об'єкт зробить повний оберт на 360 градусів. Віконце в "Orient to Path Direction" використовується при створенні анімації типу рух по заданому шляху. Движок який розташований трохи нижче відповідає за сталість, чи мінливість швидкості руху об'єктів. Якщо перемістити його лівіше (ближче до "In"), то рух буде починатися повільніше і його швидкість буде повільно наростати ближче до кінця і навпаки. 
В Flash дуже часто застосовуються об'єкти у вигляді анімованих чи багатокадрових символів. Для того щоб анімація створена при редагуванні окремого символу належним образом відображалася в основному ролику, вибирайте "Synchronize Symbols". Щоб автоматично прив'язати символ до заданого шляху переміщення використовується опція "Snap to Guide".
6) Для анімованої зміни кольору і прозорості символу задайте бажані початкові і кінцеві значення кольору і (чи) прозорості.

Для того щоб синхронізувати анімаційний символ потрібно: 
1) Виділити всі кадри в яких беруть участь анімовані символи (включаючи ключові кадри початку і кінця анімації з використанням анімованого символу) у тайм-лайн основної сцени.
2) Натиснути правою кнопкою миші на виділеній області, і вибрати "Synchronize Symbols". 
Вибрати з меню Modify > Frame. У діалоговому вікні властивостей кадру (Properties Frame), вибрати закладку Tweening, і поставити галочку у віконці "Synchronize Symbols".

Для завдання анімованої зміни форми: 
1) Натисніть на назві шару, щоб зробити його поточним і вставте ключовий кадр у тім кадрі, де ви хочете, щоб почалася анімація. 
2) Створіть об'єкт типу "малюнок" (чи перетворіть об'єкти інших типів у "малюнок") у ключовому кадрі початку анімації) і використовуючи будь-який інструмент із панелі інструментів, задайте його початкову форму. Flash не може анімовано змінити форму символів, текстових блоків, чи растрових зображень.
3) Створіть другий ключовий кадр пропустивши бажане число кадрів після першого ключового кадру
4) В цьому новому ключовому кадрі створіть новий об'єкт типу "малюнок" чи зміните об'єкт у цьому новому ключовому кадрі. Крім зміни форми, можна також змінити колір і координати об'єкта в другому ключовому кадрі.
5) Двічі натисніть на першому ключовому кадрі в послідовності, щоб відкрити діалогове вікно властивостей кадру (Properties Frame). Чи виберете ключовий кадр на початку послідовності у меню - Modify > Frame.
6) В закладці Properties(Свойства) діалогового вікна властивостей кадру, виберіть Shape з Tween (Пара) вибрати Shape.
7) Вибір значення для опції "Blend Type": якщо обрано "Distributive", вийде анімація, у якій проміжні форми є більш округленими і більш неправильними. Якщо вибрати "Angular", вийдуть більш вугловаті проміжні форми анімації з максимальним збереженням кутів і прямих ліній. Опція "Angular" буде працювати тільки при анімованому перетворенні об'єктів з гострими кутами і прямими лініями.

Для завдання контрольних точок потрібно: 
1) Вибрати перший ключовий кадр в анімованій послідовності. 
2) Вибрати з меню Modify > Transform > Add Shape Hint, чи натиснути Ctrl+H (Windows) чи Command+H (Macintosh). Контрольні крапки з'являються як червоні кола з буквою де-небудь недалеко від центра анімованого об'єкта.
3) Пересунути контрольну крапку в потрібну вам область об'єкта.
4) Вибрати останній ключовий кадр в анімованій послідовності. В останньому ключовому кадрі контрольні крапки з'являються де-небудь на об'єкті як зелене коло.
5) Пересунути контрольну крапку в ту область об'єкта, що повинна відповідати контрольній крапці з аналогічною буквою з першого ключового кадру.
6) Протестувати свій ролик і звернути увагу як саме контрольні крапки змінюють процес анімації. Зміщуйте контрольні крапки для досягнення найкращих результатів. 
7) Повторюйте цей процес, щоб додати додаткові контрольні крапки. Нові контрольні крапки будуть відзначатися наступними буквами англійського алфавіту.
8) При роботі з контрольними крапками, можна також робити наступне: 
Щоб бачити контрольні крапки, виберіть з меню View > Show Shape Hints. Для відображення контрольних крапок, ключовий кадр і шар, які їх містять, повинні бути виділеними в тайм-лайн. Щоб видалити контрольну крапку, перетягніть її за межі робочої області, чи використовуйте меню правої кнопки на контрольній крапці. Щоб видалити всі контрольні крапки, виберіть з меню Modify > Transform > Remove All Hints.

Завдання : 
1. Завантажити програму Flash MX.
2. Створити фільм за таким сценарієм: Літери “Flash MX” повільно рухаються до центру листа, змінюючи колір. Потім зникають з екрану.
3. Створити фільм за таким сценарієм: Рухаючись по екрану коло трансформується в квадрат і змінює колір.

Контрольні запитання
1. Які види трансформаційної анімації ви знаєте?
2. Яким чином створюється анімація руху?
3. Яким чином створюється анімація форми?
4. В яких випадках використовується анімація руху?
5. В яких випадках використовується анімація форми?

ПР № 8 Робота з шарами в Macromedia Flash
Теоретичні відомості

Шар - можна розглядати як листок прозорої плівки, який знаходиться на робочому листі Flash. Можна малювати на шарі, використовуючи інструменти малювання. Крім того, можна легко перейти до іншого шару, щоб працювати з намальованою на них графікою.

Шари можна представити як прозорі плівки, складені в стповпчик одна на одну. Якщо в шарові нічого нема, то крізь нього видно шари, розташовані під ним. Коли створюється новий Flash-кліп, у ньому міститься тільки один шар. До цього шару можна додати ще кілька шарів і з їхньою допомогою організувати розташування зображень і їх анімацію в кліпі. Кількість шарів у кліпі обмежується тільки обсягом пам'яті вашого комп'ютера. Збільшення кількості шарів не приводить до збільшення розміру файлу, у якому буде записаний кліп все залежить від графіки в цих шарах. Ви можете малювати і редагувати об'єкти на одному шари і при цьому не торкати об'єктів на інших шарах. Крім того, є можливість створювати так звані "опорні шари" (guide layers), що спрощують процес малювання і редагування. Також, для створення "витончених" ефектів можна створювати шари-маски (mask layers). 
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Для звуків і дій (actions) використовуються свої окремі шари. Це дозволяє швидко знаходити всі дії (actions) чи звуки, коли вам знадобиться їх редагувати. При створенні нового шару він з'являється над поточним виділеним шаром. Створений тільки що шар стає поточним. Малювання і створення фігур відбувається в активному шарі. Щоб зробити той чи інший шар активним, необхідно його вибрати. Піктограма "олівець", що з'являється поруч з назвою шару, позначає, що даний шар є активним. Активним у будь-який момент може бути тільки один шар. Редагувати об'єкти можна на будь-якому видимому (visible) і не зафіксованому (locked) шарі. Щоб захистити шар від змін, його можна зафіксувати, а щоб робоче поле не “засмічувалось” об'єктами, той чи інший шар можна зробити невидимим. На будь-якому рівні можна представити об'єкти у вигляді контурів (outlines), при цьому можна задавати колір контуру і змінювати висоту будь-якого шару. Лівіше вже відомої шкали кадрів розміщується список шарів (див. малюнок).

За замовчуванням Flash створює один шар з назвою Layer 1. Але ви можете додати шари, натиснувши кнопку Insert Layer [image: image44.jpg]
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Під час роботи шари можна ховати і знову виводити на екран. Сховані шари теж можна експортувати, але їх редагування вже буде не можливе. Крім того, можна зробити так, що контури всіх об'єктів, що належать до одного і того ж слою, будуть пофарбовані в однаковий колір. Це допомагає визначити, якому шару належить той чи інший об'єкт. Червоний символ X позначає, що шар є схованим.
За замовчуванням нові шари при створенні одержують ім'я з номерів, по-порядку їхнього створення. Намагайтеся перейменовувати шари, щоб їх назви відображали їх зміст.

За допомогою діалогового вікна Layer Properties (Властивості слою) ви можете задати властивості відображення і редагування слою. Багато з цих властивостей можна задати також і за допомогою Монтажної лінійки (Timeline).

Порядок, у якому розташовуються шари на Монтажній лінійці (Timeline) визначає, як об'єкти перекривають одне одного на Робочому полі (Stage). Об'єкти, що розташовані на верхніх шарах на Монтажній лінійці, виводяться поверх тих об'єктів, що розташовані на нижніх шарах.
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Для полегшення процесу малювання ви можете використовувати опорні шари. З їх допомогою можна виводити фонову квадратну сітку, або створити власні допоміжні засоби на кожному з рівнів і перетворювати його в опорний рівень. Опорні шари позначаються за допомогою піктограми "лінійки", котра виводиться перед назвою слою. Опорний шар не виводиться, коли Flash-кліп готується до публікації.

Для одержання ефекту "відблиск" чи "перехід", можна створити прорізи, через які буде видний вміст лежачих знизу шарів. 

Кілька шарів можна з'єднати разом, прикріпити до однієї маски й одержувати в такий спосіб дуже складні ефекти. Для створення маски, що рухається, крім шляхів можна використовувати різні типи анімації. Єдине, ви не можете створювати шар-маску в кнопках. 
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Шар-маска ховає усе, що розташовано на шарах, що прив'язані до шару-маски, за винятком тих ділянок, де ви використовуєте заливання об'єкта. Фігура, що залита кольором, чи текст на шари-масці утворять проріз, через який видно вміст шарів, що знаходяться під шаром-маскою. Шар-маска може містити одну єдину фігуру, екземпляр чи текст. Шари-маски дозволяють одержувати приблизно той же ефект, що і операція Paste Inside у програмі FreeHand. 

Створимо невеличкий фільм, який демонструє як можна анімувати відразу кілька графічних елементів. А саме: нерухомий фон і два рухомих елементи - квадрат і коло. Створимо три шари. Надамо їм зрозумілі імена. Наприклад, коло, квадрат і фон, розмістимо їх зверху вниз.

Спочатку створимо нерухомий фон. Колір фона задається за допомогою селектора кольору Background Color Document Properties. Якщо ж ви бажаєте для фону робочого листа створити градієнтну або графічну заливку, розмістіть в самому нижньому шарі прямокутник розмірами, як робочий лист, і задайте для нього потрібну заливку.

Отже, створіть фон блакитного кольору. Далі виділіть шар “квадрат” і намалюйте на робочому листі квадрат або прямокутник. Перетворіть його в графічний символ. Для цього виділіть його (контур і заливку) і виберіть в меню Insert пункт Convert to Symbol. Ввімкніть перемикач Graphic і натисніть ОК. Після цього Flash створить новий символ і автоматично замінить виділений квадрат екземпляром цього символу. В шарі “коло” намалюйте еліпс і, аналогічно, перетворіть його в символ.

Виділіть шар “квадрат”. Перемістіть квадрат в верхню точку траєкторії. Виберіть пункт Create Motion Tween в меню Insert. Створіть новий основний кадр №10 на шкалі кадрів і перемістіть квадрат в нижню точку траєкторії.

Для того, щоб нерухомий фон з'явився в усіх кадрах анімацій, розтягніть кадр на всю анімацію (виділіть на шкалі кадрів місце, де закінчується анімація і виберіть пункт Insert Frame в контекстному меню). Виділіть шар “коло”. Перемістіть квадрат в ліву точку траєкторії. Виберіть пункт Create Motion Tween в меню Insert. Створіть новий основний кадр №10 на шкалі кадрів і перемістіть квадрат в праву точку траекторії. Натисніть - анімація працює. 

Список шарів складається з чотирьох колонок:
· Ім’я шару;

· Видимість шару (помічена зображенням ока);

· Блокування шару (помічена зображенням замка);

· Відображення змісту шару різними кольорами (помічено чорним прямокутником).

Видимість шару - дозволяє забрати з робочого листа на деякий час шар разом з його змістом. Блокування шару - графіка, яка знаходиться в шарі недоступна для зміни.

Відображення змісту шару різними кольорами - відображає зміст шару схематично і розфарбовує його різними кольорами.

Для організації шарів в ієрархічну структуру Flash пропонує папки. Використовуючи їх ви можете “розкласти” по окремим “поличкам” шари, в яких знаходяться різні графічні елементи.

Для створення папки, натисніть кнопку Insert Layer Folder . Помістіть шар в папку звичайним перенесенням курсору мишки.
Можна перетворювати шар в папку і навпаки. Для цього натисніть двічі по значку, який знаходиться лівіше імені шару, або виберіть пункт Layer в меню Modify. На екрані з’явиться діалогове вікно Layer Properties. Ввімкніть перемикач Folder в групі Type і натисніть ОК. Майте на увазі, що зміст шару при цьому зникне. Для того, щоб перетворити папку в шар, виберіть перемикач Normal.

Flash містить функції для розподілу виділених графічних елементів по різних шарах. Якщо, наприклад, потрібно “розкидати” кожну літеру деякого слова по окремим шарах, то потрібно виконати наступне: введіть потрібне слово в перший шар. Розбийте його на окремі символи (виберіть пункт Break Apart в меню Modify). Після цього виберіть пункт Distribute to Layers в меню Modify. 

Практична частина

Порядок виконання роботи
1. Створення нового шару.

2. Вибір одного чи декількох шарів.

3. Видалення шару.

4. Створення копії шару.

5. Перейменування шару, та зміна його властивостей.

6. Перетворення звичайного шару в опорний та навпаки.

7. Створення слою – маски, та робота з ним.

Методичні вказівки

Запустіть програму Macromedia Flash.

Створення шару:
Виберіть пункт Insert > Layer. Натисніть на кнопці New Layer, що розташована внизу монтажної лінійки.

Щоб вибрати шар:
Натисніть кнопкою миші на назві шару на Монтажній лінійці (Timeline). Далі натисніть мишею на кадрі на Монтажній лінійці (Timeline). Виберіть об'єкт на робочому полі (Stage). 

Щоб вибрати кілька шарів:
Утримуючи клавішу Shift, натисніть мишею по назвах потрібних шарів на Монтажній лінійці. 

Щоб видалити шар:
1. Виділіть шар.

2. Перетягніть мишею шар на кнопку Trash (Мусорка).

Щоб створити копію шару:
1. Натисніть мишею на назві шару, щоб виділити його цілком. 
2. Виберіть Edit > Copy Frames. 

3. Створіть новий шар, натиснувши на кнопку New Layer (Новий шар). 

4. Перейдіть на новий шар, потім виберіть Edit > Paste Frames.

Щоб зафіксувати, чи розфіксувати шар: 
Скористайтеся одним із наступних способів: Натисніть на стовпці Lock (Фіксація), що розташований праворуч від назви шару. Щоб розфіксувати шар, натисніть мишею в цьому місці ще раз. Щоб зафіксувати всі шари натисніть піктограму Замок. Щоб розфіксувати всі шари, натисніть ще раз по цій піктограмі. Щоб зафіксувати, чи розфіксувати кілька шарів, натисніть кнопку на миші і проведіть курсор по стовпці Lock (Фіксація). Щоб зафіксувати всі шари, крім одного, натисніть мишею, натиснувши клавішу Alt (Windows) чи Option (Macintosh), у стовпці поруч з назвою шару, який треба залишити незафіксованим. Щоб розфіксувати ці шари, натисніть мишею ще раз, утримуючи натиснутої клавішу Alt чи Option.

Щоб сховати чи показати шар:
Скористайтеся одним з наступних способів: Натисніть мишею в стовпці Eye (Око) праворуч від назви того шару, який потрібно сховати. Шар буде схований. Щоб показати даний шар, натисніть мишею в цьому місці знову. Щоб сховати всі шари, натисніть мишею на піктограмі Eye (Око). Щоб показати всі шари, натисніть мишею на цій піктограмі ще раз. Щоб сховати, чи показати кілька шарів, протягнете курсор миші по стовпцю Eye (Око). Щоб сховати всі шари, крім зазначеного, утримуйте нажатою клавішу Alt (Windows) чи Option (Macintosh) і натисніть мишею в стовпці Eye (Око), праворуч від потрібного шару. Щоб показати всі шари, натисніть мишею ще раз, утримуючи нажатою клавішу Alt чи Option.

Щоб представити вміст шару у вигляді контурів:
Скористайтеся одним з наступних способів: натисніть мишею в стовпці Outline (Контур), біля назви шару. Всі об'єкти в цьому шару будуть представлені у вигляді контурів. Щоб відключити це представлення, натисніть мишею в цьому місці ще раз. Щоб представити всі об'єкти на всіх шарах у вигляді контурів, натисніть мишею на піктограмі Outline (Контур). Щоб відключити це представлення на всіх шарах, натисніть мишею на цій піктограмі ще раз. Щоб показати об'єкти у виді контурів на всіх шарах, крім зазначеного, пригорніть клавішу Alt (Windows) чи Option (Macintosh) і натисніть мишею в стовпці Outline (Контур), праворуч від потрібного шару. Щоб відмінити цей режим відображення, натисніть мишею ще раз, утримуючи нажатою клавішу Alt чи Option.

Для перейменування шару:
Двічі натисніть на назві шару, а потім наберіть нову назву.

Для зміни властивостей шару:
1. Двічі натисніть мишею на піктограмі шару, властивості якого ви будете змінювати.

2. У вікні є наступні настройки:
- Name (Ім'я) Дозволяє задавати ім'я шару. 
- Show (Показ) - дозволяє включати чи виключати вивід шару.
- Lock (Фіксація) - дозволяє фіксувати чи розфіксовувати шар. 
- Normal - тут задається тип шару. Тип Normal привласнюється шару за замовчуванням. Даний тип дозволяє вам малювати на шарові і анімувати об'єкти, розташовані на ньому.
- Guide - даний тип дозволяє створювати сітки, фони та інші об'єкти, що допомагають вирівнювати малюнки на інших шарах. Ви можете зв'язати кілька шарів із шаром типу Guide. Guided - це шар типу normal, що зв'язаний з опорним шаром (із шаром типу Guide). До опорного шару (шару типу Guide) можна прив'язати кілька звичайних шарів (шарів типу Normal). 
- Mask - за допомогою даного типу ви можете створювати прорізи, через котрі будуть видні нижні шари. Шари-маски використовуються для створення таких ефектів, як відблиски, плавні переходи та ін. До шару-маски можна прив'язати кілька шарів. Masked - це шар типу Normal, що зв'язаний із шаром-маскою. 
- Layer Height (Висота шару) - використовується в тих випадках, коли необхідно краще розглянути графіки звукових файлів.

Щоб змінити порядок розташування шарів: 
Перетягніть шари на потрібні місця на Монтажній лінійці (Timeline).

Щоб перетворити шар в опорний:
Притисніть клавішу Control (Macintosh) чи натисніть правою кнопкою миші і виберіть у контекстному меню пункт Guide. 

Щоб опорному шару повернути назад тип Normal:
Виберіть шар, і в контекстному меню виберіть пункт Guide. 

Примітка: Розмістіть всі свої опорні шари під іншими шарами. У такий спосіб ви не зможете випадково перетягнути який-небудь звичайний шар на опорний, перетворить його тим самим у шар створення руху.

Щоб створити шар-маску: 
1. Створіть шар, на якому розташуєте об'єкти, що ви хочете показувати через прорізи маски.

2. Виділіть тільки що створений шар і виберіть команду Insert > Layer. Над даним шаром з'явиться ще один новий шар. Шар-маска завжди закриває шар, що розташований безпосередньо під ним, тому шари потрібно створювати завжди у визначеному місці. 

3. ігнорує будь-яку інформацію, що стосується растра, градієнтів, прозорості, кольору і стилю ліній, що стосуються об'єктів на шари-масці. Будь-яка фігура з заливанням буде повністю прозора, а незалита - непрозора.

4. Натисніть правою кнопкою мишки (Windows), притиснувши клавішу Control (Macintosh) на назві шару-маски. З контекстного меню виберіть пункт Mask. Flash фіксує шар-маску і шар, до якого буде ця маска застосована. Щоб відредагувати маску, чи замаскований шар, необхідно розфіксувати їх. При цьому дія маски відключається. Щоб знову його включити, зафіксуйте маску, чи шар, що маскується. 

Щоб прив'язати шари до шару-маски:
Виберіть один з наступних способів: Перетягнете існуючий шар під шар-маску, під маскою буде зображений з відступом. Створіть новий шар під шаром-маскою. Виберіть Modify > Layer і потім Masked у діалоговому вікні Layer Properties (Властивості шару). Натисніть мишкою на шар, утримуючи клавішу Alt (Windows) чи Option (Macintosh).

Щоб від’єднати шари від шару-маски: 
Виділіть шар, що ви бажаєте від’єднати і зробіть наступне: Перетягніть шар, розташувавши його над маскою, або Виберіть Modify > Layer і потім Normal. Притисніть клавішу Alt (Windows) чи Option (Macintosh) і натисніть по шар мишкою

Завдання:
1. Завантажте програму Flash MX.

2. Створіть фільм, описаний у теоретичній частині.

3. В середині робочого листа створіть текстовий блок з написом “Flash MX”.

4. Створіть фільм, в якому літери хвильоподібно з’являються і зникають на екрані.

5. Створіть дві папки, в першу помістіть приголосні літери, в другу - голосні

Контрольні запитання
1. Що таке шар?

2. Перерахуйте переваги, які надають шари.

3. Яким чином можна створити фон-градієнтну заливку?

4. Що потрібно виконати, щоб фон супроводжував весь фільм?

5. Як змінювати параметри шару.

6. Яким чином можна перетворити шар в папку і навпаки?

ПР № 9 Направляючі і маскуючі шари
Теоретичні відомості

При створенні анімації, інколи, потрібно, щоб який-небудь елемент рухався по деякій траєкторії. Такою траєкторією може бути пряма, крива, коло або складний контур. Для цього можна використати спеціальний шар - направляючий.

Відкрийте новий документ Flash, помістіть на робочий лист прямокутник і створіть просту анімацію, яка переміщує його зліва на право.

Для того, щоб створити направляючий шар і прив’язати до нього об’єкт, виберіть шар в якому знаходиться анімований об’єкт, і виберіть пункт Motion Guide (Направляющая движеня) в меню Insert (Вставить). Створений направляючий шар з’явиться над виділеним шаром. Перейдіть на направляючий шар і намалюйте потрібний шлях руху об’єкта. Виділіть анімований об’єкт і перемістіть його так, щоб його точка фіксації “приклеїлась” до лінії шляху. Flash автоматично виконає “приклеювання”, якщо в редакторі властивостей ввімкнути прапорець Snap. “Сховайте” направляючий шар. Для цього натисніть мишкою на чорній крапці, яка знаходиться в другій колонці списку шарів.

В редакторі властивостей (Свойства-Properties) знаходиться ще один прапорець - Orient to Path. Якщо він ввімкнений, то Flash буде автоматично орієнтувати графіку по лінії шляху.

Найпростіший спосіб прив’язати до направляючого шару інші шари з анімацією - це перетягти шар з анімацією під направляючий шар. Відв’язати шар з анімацією від направляючого шару - перетягти шар з анімацією таким чином, щоб він знаходився вище направляючого шару.

Дуже часто на web сторінках зустрічаються зображення, по яким “ковзає” промінь - кругла світла пляма, яка висвічує зображення частинами. Шар, на якому знаходиться світла пляма називається шаром маскою. А шар, в якому знаходиться зображення - замаскованим шаром.

Маска - це отвір в непрозорому маскуючому шарі. Через який можна бачити все, що знаходиться під цим шаром. Отвір може бути будь-яким графічним фрагментом: геометричною фігурою, екземпляром (але не кнопкою), текстовим блоком.

Створіть новий файл з будь-яким графічним зображенням. Розташуйте над цим шаром інший і намалюйте в ньому зображення, яке буде маскою. Наприклад, коло. Перетворіть намальоване графічне зображення в символ. Анімуйте його. “Розтягніть” єдиний основний кадр шару, який містить замасковане зображення так, щоб він покрив всю анімацію. Виділіть шар-маску і виберіть в контекстному меню пункт Mask. Таким чином можна замаскувати кілька шарів. Головна вимога при цьому, щоб вони знаходились нижче шару-маски.

“Витягнути” замаскований шар не складно - розташуйте їх над шаром-маскою. 

Практична частина

Завдання:
1. Завантажте програму Flash MX.

2. Створіть фільм, результатом якого був би рух квадрата по заданій траєкторії.

3. Створіть фільм, результатом якого був би рух променя по напису “Macromedia Flash MX”.

Контрольні запитання:
1. Шари якого виду ви знаєте?

2. Яким чином створюється направляючий шар?

3. Яким чином створюється шар-маска?

4. Яку дію виконує прапорець Orient to Path в редакторі властивостей, коли створюється направляючий шар?

5. В якій послідовності розташовується шар-маска і замаскований шар?

ПР № 10 Імпорт звуку. Редагування звуків. Накладання звуку на мультиплікацію в Macromedia Flash
Теоретичні відомості

Flash дозволяє використовувати звуки в декілька способів. Ви можете додати звук, який буде грати постійно, незалежно від того, що відбувається на сцені, чи ви можете синхронізувати звук з анімацією. Озвучування мультиплікацій робить їх більш привабливими. Робіть плавне збільшення, чи зменшення гучності звуку щоб саундтреки виглядали більш вишукано. 

В Flash застосовуються два типи звуків: подійний і потоковий. Подійний звук повинний бути завантажений цілком, перш ніж він почне відтворюватися і буде грати, поки його не виключать. Потоковий звук починає грати як тільки скачає досить даних для перших декількох кадрів. Синхронізується з лінією часу (Timeline). Додавання звуку до кліпу має на увазі створення окремого шару (Layer) для звуку, додавання звуку, і настроювання звуку робиться в закладці Sound у властивостях кадру (Frame Properties). 

Інтенсивність звукового потоку (sampling rate) і ступінь його стиску (compression ratio) значно впливають на якість і розмір файлу кліпу. Контролюйте якість і розмір окремих звукових фрагментів за допомогою діалогового вікна Sound Properties, чи змінюйте установки для всіх звуків в кліпі в діалоговому вікні Publish Settings.

Для того, щоб імпортувати в документ Flash звуковий файл, виберіть пункт Import в меню File. Або вибрати пункт Import to Library в меню File. На екрані з’явиться стандартне діалогове вікно відкриття файла Windows. Знайдіть потрібний файл і написніть кнопку відкриття файла.

Імпортовані звукові файли поміщуються в бібліотеку у вигляді символів-звуків. Звуки займають значну кількість дискового простору та ОЗУ(RAM). Звичайно краще використовувати 22 кГц 16-бітний моно звук (стерео займає в 2 рази більше місця, ніж моно). Flash може імпортувати 8 чи 16-бітні звуки з інтенсивністю потоку (sample rate) 11 кГц, 22 кГц, чи 44 кГц. Flash може конвертувати звуки зі зниженням інтенсивності потоку при експорті. Потрібна тільки одна копія звукового файлу, щоб використовувати цей звук у будь-якій кількості місць в кліпі. Примітка: Звуки, записані у форматах, не кратних 11 кГц (наприклад 8, 48, чи 96 кГц) конвертуються коли імпортуються в Flash, при цьому звук буде гратися з якістю нижче чи вище оригінального (все залежить від того, яка з частот знаходиться ближче).

Можна використати стандартну бібліотеку звуків, вибравши пункт Sounds в підменю Common Libraries меню Windows.

Додавання звуків у кліп виробляється шляхом створення шару (layer) для звуку, вставки звуку в шар, і встановленням опцій у закладці Sound діалогового вікна Frame Properties. Використовуйте інструменти редагування звуку в закладці Sound діалогового вікна Frame Properties щоб визначити початок звуку, або для контролю сили звуку. 

Flash може змінювати місце з якого звук починає і закінчує грати. Це корисно для зменшення розмірів звукових файлів шляхом видалення невикористаних секцій. Ви можете асоціювати звуки з різними станами кнопки. Т.я. звуки містяться разом із символами, вони працюють для всіх образів (instances) символу.

Інтенсивність потоку(sampling rate) і ступінь компресії звуку значно впливають на розходження в якості і розмірі кінцевого файлу. Чим більше ви стискаєте звук і зменшуєте інтенсивність потоку, тим менше буде розмір і якість звучання. Експериментуйте, щоб одержати кращий результат. 

Керування якістю і розміром окремих звуків виробляється установкою експортних настроювань (export settings) у діалоговому вікні Sound Properties. Якщо експортні настройки для звуку не визначені, Flash експортує звук використовуючи звукові настройки в діалоговому вікні Publish Settings. Для перевизначення всіх експортних налаштувань для всіх звуків у кліпі, встановіть звукові настройки в діалоговому вікні Publish Settings. Ця опція корисна, якщо ви хочете створити більший високоякісний аудіокліп для власних нестатків і менший кліп для розміщення в Інтернеті. Примітка: В Windows ви також можете експортувати всі звуки із кліпа як WAV- файл, використовуючи File > Export Movie.

Встановлення опцій компресії звуку:
Використовуйте опції в закладці Export Settings діалогового вікна Sound Properties щоб вибрати опції компресії звуку. Опції залежать від методу компресії, що вибирається. 

· Default - використовує компресію за замовчуванням у діалоговому вікні Publish Settings коли ви експортуєте кліп. Немає додаткових опцій для цієї установки.

· ADPCM - встановлює компресію для 16-бітних звукових даних. Використовуйте ADPCM коли ви експортуєте короткі випадкові звуки, наприклад як звук натискання на кнопку. Додаткові опції: конвертувати стерео в моно(Convert Stereo to Mono), інтенсивність потоку(Sample Rate), і ADPCM якість(ADPCM bits). 

· Convert Stereo to Mono – мікшує звук стерео в моно. На моно звуки не впливає. 

· Sample Rate - встановлює інтенсивність потоку для експортованого файлу. Висока інтенсивність дає кращий по якості звук, але більший по розміру файл. Низька інтенсивність зменшує використання дискового простору. Опції інтенсивності: 5 кГц просто для мови; 11 кГц нижча якість, що рекомендується, для коротких уривків музики . Це чверть стандартної CD-якості; 22 кГц використовується звичайно для публікації в Інтернеті. Половина стандартної CD-якості; 44 кГц стандартна CD-якість. Flash не може поліпшити якість звучання. Якщо звук записаний з якістю 11 кГц моно, Flash буде експортувати його як 11 кГц моно, навіть якщо ви зміните інтенсивність потоку на 44 кГц стерео. 

· ADPCM Bits - визначає кількість бітів, використане при ADPCM кодуванні. Велика ступінь стиску дає малі розміри файлів, але гірший по якості звук. 2 біти найменша, нижча опція якості; 5 біт велика, краща опція якості. 

· MP3 - дозволяє експортувати звуки з використанням MP3 стиску. Використовуйте MP3 коли Ви експортуєте довгі, потокові звуки, такі як музичні доріжки. Додаткові опції: препроцессінг (Preprocessing), бітрейт (Bit Rate), і якість (Quality). 

· Bit Rate - визначає максимальний бітрейт звуку закодованого MP3-кодером. MP3 Bit Rate показується, коли вибрано MP3 кодування як опцію компресії. При експорті музики встановлюйте бітрейт 16 Kbps, чи вище для кращого результату. Опція Convert Stereo to Mono недоступна для бітрейта 16Kbps і нижче.

· Quality - дозволяє вибирати між швидко(Fast), середньо(Medium), чи краще(Best). Використовуйте Fast якщо ви збираєтеся розмістити свій витвір в Інтернеті. Використовуйте Medium чи Best якщо не збираєтеся цього робити, а хочете запускати кліп з диска, чи CD. 

· RAW - експортує звук без стиску. Ви можете вибрати Convert Stereo to Mono і sample rate коли обрана ця установка.

Крім інтенсивності потоку (sampling rate) і ступеня стиску, є кілька способів ефективного використання звуку в кліпі зі збереженням малого розміру файлу: залишіть точки початку і кінця звучання (in/out points), щоб не поміщати "тишу" у кінцевий файл. Ви можете урізноманітнити музичне оформлення кліпу шляхом застосування різних звукових ефектів (таких як: volume envelopes, зациклення (looping), і in/out points) до звуків у різних ключових кадрах (keyframes). Ви можете одержати масу звуків, використовуючи тільки один звуковий файл. Використовуйте зациклення (looping) для заповнення загальної звукової теми і програвайте її повторно. Зациклюйте звуки для теми другого плану (background music).

Кліпи, що ви експортуєте як QuickTime чи Windows AVI файли використовують звуки не так, як Shockwave Flash кліпи; тому розмір файлу Flash-кліпу відрізняється від розміру файлів QuickTime чи AVI кліпів. Принципи експорту звуку у відео містять у собі: Використовуйте стільки звуків, скільки хочете, не піклуючись про розмір файлу. Звуки поєднуються в один саундтрек коли ви експортуєте в QuickTime чи Windows AVI. Кількість звуків не впливає на кінцевий розмір файлу. 

Використовуйте синхронізацію потоку (stream synchronization) щоб анімація йшла синхронно саундтреку коли ви переглядаєте її в редакторі. Якщо Ваш комп'ютер не настільки швидкий, щоб малювати кадри анімації синхронно зі звуком, Flash буде пропускати деякі кадри.

Розглянемо деякі приклади роботи з звуком. 

Помістіть в шар екземпляр символа-звука. Створіть послідовність кадрів потрібної довжини. Для цього виділіть порожнє місце на шкалі з кадрами, де має закінчуватися послідовність з кадрами, і виберіть пункт Frame в меню Insert.

В редакторі властивостей знаходиться набір елементів, за допомогою яких задаються додаткові параметри звуку. (див. малюнок)
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В списку Sound можна вибрати звук, який буде програватись в данній послідовності кадрів. Пункт None - відміняє програвання звуків.

За допомогою списка Effect можна задати спецефекти звуку. Він містить вісім пунктів:

· Left Channel або Right Channel звук буде звучати відповідно через ліву або праву колонку комп’ютера;

· Fade In - гучність звука плавно збільшується, Fade Out - гучність звука плавно зменшується;

· Fade Left to Right або Fade Right to Left - звук плавно “перетікає” відповідно з лівої на праву або з правої на ліву колонку комп’ютера;

· Пункт Custom дозволяє задати зміну гучності і місце знаходження джерела звука в просторі;

· В списку Sync можна задати яким чином буде програно звук (Event, Start - звук почне програватися як 

· тільки Flash програє перший кадр; Stop - зупинка програвання звуку; Stream - звук буде програно синхронно з анімацією);

· Loop - використовується для задання кількості повторів звука.

[image: image66.jpg]a0
7 ACTIONS +LABELS 3
7 Lo6o &0
3 BUTTONS &0
7 CONTENT &io
7 CONTACT - THANK + + «
? OUTLINES A=
(0]2) =

Hidden layer

Objects on layer
displayed as outlines

Active layer

Locked layer



В програмі Flash MX можна редагувати звуки. Натиснувши кнопку Edit, з’явиться діалогове вікно Edit Envelope (див. малюнок).

Редагування виконується за допомогою двох великих графіків, які знаходяться в верхній і нижній частинах діалогового вікна.

Верхній графік - це графік гучності. На ньому схематично зображено звук. Зміну гучності можна задати за допомогою такзванних огинаючих. Це тонка чорна лінія. Змінюючи огинаючі, можна досягти ефекту зниження або зростання звуку. Для перенесення будь-якої точки огинаючої, натисніть на ній мишкою і перетягніть в потрібне місце. Маркери, які знаходяться на початку та в кінці графіка звуку відповідають за місце початку і завершення звуку.

Аналогічне зображення представлено на нижньому графіку. Але воно є схемою позиціювання звука в двовимірному просторі. Верхня половина - лівий канал стереозвука, нижня - правий. Вибравши пункт Properties в контексному меню вікна бібліотеки відкриємо вікно Sound Properties. Розглянемо основні кнопки цього вікна.

· Import - імпорт іншого звуку на місце поточного;

· Test, Stop - програвання або зупинка звуків;

· Update - оновлення імпортованого звуку.
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При експорті фільма, який містить імпортований звук, Flash перетворює його в свій формат, і стискає звук, інакше файл буде дуже великим. Розглянемо, яким чином можна керувати цим процесом.

Найкраще це виконувати в вікні Sound Settings (див. малюнок).

Список Compression містить п’ять пунктів (алгоритмів стиснення):

· Default - параметри звука залишаться без змін;

· ADPCM - алгоритм, при якому звук не сильно стискається, але може бути програний на “слабких”ПК.

· MP3 - алгоритм стиснення MPEG;

· RAW - звук взагалі не буде стиснено;

· Speech - алгоритм для кодування мови.

Прапорець Convert Stereo to Mono дозволяє перетворювати стерео звук в моно, при цьому масив данних зменшиться вдвічі.

Список Sample Rate - задає частоту оцифровки звука. Чим більша частота, тим краща якість звуку. ADPCM Bits - регулює ширину потоку даних звука. 

Практична частина

Порядок виконання роботи
1. Імпорт звукових файлів.

2. Додавання звуку в кліп.

3. Використання елементів керування для редагування звуку.

4. Робота з ярликом для додавання звуку в шар.

5. Редагування звуку за допомогою інструментів редагування звуку.

6. Додавання звуку в кнопку.

7. Експортне налаштування звуку.

8. Аналіз результатів і висновки.


Методичні вказівки
Запустіть програму Macromedia Flash .

Щоб імпортувати звук:
1. Виберіть File > Import.

2. В діалоговому вікні виберіть і відкрийте потрібний AIFF чи WAV файл.

Примітка: Якщо ви хочете додати ефекти до звуків у Flash, краще імпортувати 16-бітні звуки. Якщо у Вас мало пам'яті (ОЗУ), робіть свої звукові кліпи маленькими чи працюйте з 8-бітними звуками замість 16-бітних.

Щоб додати звук у кліп:
1. Імпортуйте його.

2. Виберіть Insert > Layer щоб створити шар для звуку. Ви можете розміщати звуки в необмеженій кількості шарів. Кожен шар буде являти собою окремий звуковий канал. Звуки всіх шарів складаються, коли ви програєте свій ролик.

3. Натисніть на кадрі звукового шару де ви хочете мати початок звучання. 

4. Виберіть з бібліотеки відповідний файл звуку і перетягніть в робоче поле документу.

5. Виберіть в Properties(Свойства) - Sound ім'я звукового файлу щоб зв'язати його з цим шаром. Якщо потрібного файлу немає в списку, значить ви його не імпортували. 

6. Виберіть опцію синхронізації подій (event synchronization):
- Event синхронізує звук відповідно до настання події. Звук при настанні події починає грати коли його стартовий кадр вперше виявиться поточним і грається цілком, незалежно від лінії часу (timeline), навіть якщо кліп зупиниться. Звуки при події мікшиуються коли ви публікуєте свій ролик.
- Start - те саме, що і Event, за винятком того, що якщо звук вже грає, новий образ (instance) звуку стартує.
- Stop зупиняє звук. 
- Stream синхронізує звук для відтворення на Web-сайті. Flash змушує анімацію програватися в одночасно з потоковим звуком. Якщо Flash не може малювати кадри досить швидко, він пропускає деякі з них. На противагу звуку якійсь події потоковий звук зупиняється, якщо зупиняється анімація. Також про потоковому звуці програється така кількість кадрів, яку він займає. Потокові звуки мікшуються коли ви публікуєте свій ролик. 

7. Введіть кількість циклів в поле Loop щоб вказати, скільки разів звук повинний крутитися; для тривалого відтворення введіть дуже велике число.

8. Використовуйте елементи керування у вікні Sound для редагування звуку. Виберіть з наступних опцій.
- None не застосовує ніяких ефектів до звукового файлу. Виберіть цю опцію тільки якщо хочете забрати застосовані до цього звукові ефекти. 
- Left Channel/Right Channel грає звук тільки в правому, чи лівому каналі.
- Fade Left to Right/Fade Right to Left створює ефект "перебігання" звуку зліва-направа і навпаки.
- Fade In поступово збільшує амплітуду звуку під час звучання.
- Fade Out поступово зменшує амплітуду звуку під час звучання.
- Custom дозволяє Вам створити свій власний ефект. Використовуйте вікно Sound для зміни звукової хвилі.


Для використання ярлика для додавання звуку:
1. Зробіть звуковий шар активним.

2. Перетягніть звук з вікна перегляду бібліотеки (library) прямо на сцену . Flash розташує звук у поточному кадрі з властивостями за замовчуванням.


Щоб редагувати звук за допомогою інструментів редагування звуку: 
1. Додайте звук у кадр, чи виділите кадр, що вже містить звук і виберіть виберіть закладку Sound - Edit у діалоговому вікні Properties. 

2. Зробіть що-небудь з наступного: Щоб змінити точки початку і кінця звучання, тягніть Time In і Time Out лінійки в діалоговому вікні Sound Frame Properties. 


Для зміни обсягу звучання, тягнете envelope handles на envelope lines для зміни рівнів в окремих точках відтворення звучання. Envelope lines показують силу звуку при програванні. Натисніть на лініях щоб створити до 8 envelope handles. Щоб видалити envelope handle, просто витягніть його за межі вікна. Щоб висвічувалась більша чи менша частина звукової доріжки у вікні, натисніть Zoom In/Out кнопки. Для переключення одиниць виміру між секундами і кадрами, натисніть Seconds і Frames кнопки.
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Щоб стартувати, чи зупинити звук у ключовому кадрі:
1. Додайте звук в кліп в шар. Для синхронізації звуку з подією на сцені, виберіть початковий ключовий кадр, що з’єднаний з ключовим кадром події на сцені. Ви можете вибрати кожну з опцій синхронізації.

2. Створіть keyframe у лінії часу (Timeline) звукового шару в кадрі де Ви хочете зупинити звук. Образ (instance) звукового файлу показується в лінії часу.

3. Натисніть двічі на кінцевому ключовому кадрі і виберіть закладку Sound діалогового вікна Properties.

4. Виберіть той же звук зі спливаючого меню Sound.

5. Виберіть Stop зі спливаючого меню Synchronization. Коли Ви програєте кліп звук перестає грати, коли він досягає кінцевого ключового кадру (keyframe). Перетаскування із шрифтом: програвання повторює потоковий звук поточного кадру. Це корисно для впорядкування звуків у кліпі.


Для додавання звуків в кнопку:
1. Виберіть кнопку в бібліотеці (library).

2. Виберіть Edit з Properties. 

3. В лінії часу (Timeline) кнопки додайте шар для звуку. 

4. В цьому шари створіть один ключовий кадр (keyframe) для кожного стану кнопки, якому Ви хочете привласнити звуки. Наприклад, щоб при натисканні кнопки щось пролунало, створіть keyframe у кадрі з ім'ям Down.

5. Додайте звук до нового keyframe і виберіть Event зі спливаючого меню Synchronization. Для призначення різних звуків кожному keyframe кнопки, використовуйте різні шари і звукові файли для кожного keyframe. Також Ви можете використовувати той самий звуковий файл для різних кадрів кнопки, але змінений за допомогою різних звукових ефектів.


Завдання:
1. Завантажити програму Flash MX.

2. Вставте будь-який звук з “бібліотеки звуків”

3. Зробіть так, щоб ваш звук програвався тільки лівою колонкою комп’ютера.

4. Зробіть так, щоб ваш звук програвався тільки правою колонкою комп’ютера.

5. Створіть ефект зростання гучності звука та “перетікання” від лівої до правої колонки комп’ютера. 

6. Відредагуйте звук за власним смаком.


Контрольні запитання
1. Яким чином можна імпортувати звук в програму Flash MX?

2. Що таке “бібліотека звуків”?

3. Яким чином вставити звук з “бібліотеки звуків”?

4. Як можна відредагувати звук в програмі?

5. Чому, інколи, доцільно перетворити стерео звук в моно? Як це зробити?

ПР № 11 Використання тексту в Macromedia Flash
Теоретичні відомості

Теоретичні відомості Ви можете включати текст у Flash-кліпи. Для роботи з текстом доступні різні операції, такі як вибір шрифту, розміру кегля, стилю написання, інтервалу, кольору символів і типу вирівнювання. Можна трансформувати текст, як об'єкт - обертати, маштабувати, зміщувати і дзеркально відбивати його, зберігаючи можливість редагування символів. Можна перекласти текст у графічний вид і працювати з кожним символом окремо, як з малюнком. 

Існує можливість використовувати текст доступний для редагування під час відтворення кліпу. Це дозволяє користувачу заповнювати форми, робити різні установки, тобто набагато підвищує інтерактивність Flash-кліпу. 

Можливе використання Type 1 PostScript®, TrueType® і растрових (bitmap) шрифтів у Flash-кліпах. Flash експортує текст у кінцевий кліп із усіма його внутрішніми системними установками. В той же час у FLA-файлі можливі випадки, коли файл створений на одній платформі може невірно читатися на інші, крім того для правильного його відображення, аудиторія повинна мати використовувані в файлі шрифти, навіть знаходячись на тій же самій платформі. 

Можна уникати цих потенційних конфліктів, використовуючи спеціальні шрифти, що називаються вбудованими шрифтами (device fonts). В Flash є три таких убудованих шрифти: _sans, _serif і _typewriter . Коли текст набраний ними, Flash Player на локальному комп'ютері користувача підставляє той шрифт, що найбільше близько походить до вбудованого шрифту. Вбудовані шрифти особливо корисні для використання в текстових полях, для великих блоків тексту, у яких не потрібно згладжування (anti-aliasing), а так само для створення меншого по розміру кліпу, тому, що не містять ніяких внутрішніх настройок. Переведення тексту в графічне представлення також усуває конфлікти, але збільшує розмір файлу. 

Не всі шрифти, які відображені в Flash можуть експортуватися з кліпом. Найкращий спосіб перевірити коректність експорту, включити View -> Antialias Text. Якщо текст після цього залишається з "зазубринами", значить Flash не розпізнає структуру шрифту і не буде нормально експортувати текст. 

Для додаткової обробки, використовуйте можливості пакета FreeHand для маніпуляцій з текстом і експортуйте його як SWF файл. 

Для створення текстового об'єкта на робочому полі (Stage), використовуйте інструмент "Text Tool" (Текст). Можна створити текстовий об'єкт у вигляді одного рядка, що подовжується в міру введення туди нових символів (лінія тексту), чи у вигляді блоку заданої ширини, всередині якого відбувається автоматичний перенос слів (блок тексту). У верхньому правому куті лінії тексту знаходиться круглий маркер, в блоці тексту - квадратний маркер. 

В доступних для редагування текстових полях (Text field) квадратний маркер розташований у нижньому правому куті, вказуючи на можливість зміни вертикального розміру поля. 
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Текстові поля (Text field) дозволяють розташовувати в кліп текст доступний для редагування безпосередньо в процесі відтворення кліпу. Це робить можливим одержання від користувачів інформації при заповненні ними форм. Крім того текстові поля можуть використовуватися для динамічної заміни не доступного для редагування тексту. Наприклад, для відображення спортивних результатів, цін на акції, чи прогнозу погоди. 

При створенні текстового поля йому привласнюється змінна. Змінна має фіксоване ім'я і значення, що може змінюватися. Можна використовувати команди (actions), щоб передати її значення іншим частинам кліпу, додатку на стороні сервера, для збереження в базі даних, чи клієнтському скрипту. Змінна може змінювати своє значення, зчитуючи його з додатка на сервері або з кліпу. 

Flash дозволяє керувати наступними атрибутами тексту: вибір шрифту, розмір кегля, міжстроковий інтервал, кернінг, тип вирівнювання і колір. При створенні нового текстового елемента, Flash використовує поточні текстові атрибути. Для їхньої зміни необхідно спочатку виділити текстовий елемент. 

Кернінг (kerning) - процес зміни (як правило зменшення) інтервалу між деякими парами символів для поліпшення їхнього візуального сприйняття. Більшість шрифтів вже містять у собі потрібну інформацію, що автоматично зменшує відстань між деякими парами символів, такими як TA чи VA. За замовчуванням Flash використовує цю інформацію шрифту про кернінг, але мається можливість відключення автоматичного кернінгу і його зміни. 

Міжлітерний інтервал (letter spacing) - відстань між окремими символами тексту. Можлива його зміна, як між окремими символами, так і одночасно у всьому текстовому об'єкті. 

Текстові об'єкти можна трансформувати точно так само, як і інші об'єкти: маштабувати, обертати, зміщувати і дзеркально відображати текст для одержання потрібних ефектів. При маштабуванні тексту як об'єкта, збільшення, чи зменшення розміру символів не відображається у вікні встановлення кегля шрифту на панелі інструментів. 

Текст у перетвореному текстовому об'єкті можна редагувати, хоча серйозні перетворення можуть ускладнити читання. 

Створення текстових блоків відбувається за допомогою інструмента “текст”. Для того, щоб вибрати його клікніть кнопку “А” в панелі інструментів. Помістіть курсор мишки в тому місці, де буде знаходитись його лівий верхній кут, і натисніть ліву клавішу мишки. Далі, не відпускаючи кнопку, перемістіть мишку в місце, де буде знаходитись правий кут текстового блоку і відпустіть ліву клавішу. Наберіть потрібний текст. 

Форматування тексту в програмі Flash MX, а саме, вибір шрифту і кольору, виконується за допомогою редактора властивостей (Propertis) (див. рис.) 
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Одразу помітний список шрифтів, в якому можна вибрати потрібний вид шрифту. Правіше від даного списка знаходиться поле вибору розміра шрифту. Ще правіше легко знайти селектор кольору шрифту, а також кнопка “В” - вибір “жирного” шрифту і кнопка “І” - курсив. Для того, щоб змінити параметри всього тексту в блоці, його потрібно виділити при допомозі “стрілки виділення”. Прапорець Kern - вмикає або вимикає кернінг. Спеціальне управління простором між символами. При вмиканні даного параметра текст виглядає більш рівнішим. Поле “AV” - це поле трекінга. Тобто додатковий простір між символами. Правіше поля “трекінг” знаходиться поле, в якому можна задати введення верхніх і нижніх індексів:

· Normal - звичайне положення тексту; 

· Superscript -верхній індекс; 

· Subscript - нижній індекс. 

В нижній частині редактора властивостей знаходиться поле для введення URL. Дане поле введення дозволяє перетворити виділений фрагмент тексту в гіперпосилання. Для цього просто введіть потрібну інтернет-адресу. В списку Target вказується куди саме буде завантажено Web-сторінку. Доступні чотири пункти:

· _blank - Web-сторінка завантажиться в окреме вікно браузера.; 

· _parent - Web-сторінка завантажиться в “батьківський” набір фреймів; 

· _self - Web-сторінка завантажиться в поточний фрейм; 

· _top - Web-сторінка завантажиться в поточне вікно браузера, замінивши при цьому весь набір фреймів. 

Вирівнювання тексту в абзаці можливе за допомогою чотирьох кнопок:

· Align Left - вирівнювання по лівому краю; 

· Align Center - вирівнювання по центру; 

· Align Right - вирівнювання по правому краю; 

· Justify - вирівнювання по ширині. 

[image: image68.jpg]


Нижче цих кнопок знаходиться кнопка Format (див. рис.). При натисканні на яку з‘явиться невелике діалогове вікно, в якому можна задавати такі параметри: Indent - задає значення відступу абзаца; Line Spacing - задає відстань між стрічками по вертикалі; Left Margin і Right Margin - задають відповідно відступ зліва і з права тексту від границь текстового блоку. Змінив параметри, натисніть кнопку Done.

Кнопка, за допомогою якої можна задати напрямок тексту, має вигляд: [image: image49.jpg]


. При натисканні на яку з‘являється три пункти:

· Horizontal - горизонтальний текстовий блок; 

· Vertical, left to right - вертикальний текстовий блок з напрямком тексту зліва на право; 

· Vertical, right to left - вертикальний текстовий блок з напрямком тексту з права на ліво; 

Слід зазначити, що за допомогою програми Flash MX можна створювати спеціальні текстові поля: поле введення і динамічні текстові блоки. Для цього в панелі Propertis (редактор властивостей) потрібно вибрати відповідно пункт Input Text або Dynamic Text.

Поле введення - це невеличкий текстовий редактор, який знаходиться в вікні Windows програми і призначений для введення тексту. Ви можете помістити на свій Web-сайт форму з полем введення, в яку відвідувач сайта повинен буде ввести, наприклад, своє прізвище, або код. 

Програма Flash MX надає можливість працювати з символами тексту як з графічними об‘єктами. Для цього виділіть текстовий блок і виберіть пункт Break Apart з меню Modify. Тепер можна використовувати всі знайомі прийоми для зміни форми і кольору графіки. 

Аналогічні операції, хід виконання яких було описано вище з використанням меню Propertis “із статичним текстом” можна виконати використовуючи підменю Text головного меню програми. 

Практична частина

Порядок виконання роботи
1. Створення тексту. 

2. Створення текстового поля. 

3. Встановлення властивостей текстового поля. 

4. Редагування тексту. 

5. Виділення символів у текстовому об'єкті. 

6. Вибір шрифту, розміру тексту і стилю. 

7. Встановлення розмірів поля, відступів та міжстрічкового інтервалу. 

8. Вибір кольору тексту. 

9. Вирівнювання тексту. 

10. Перетворення тексту в графіку. 

Методичні вказівки
Запустіть програму Macromedia Flash.

Створення тексту: 
1. Виберіть інструмент "Text Tool" (Текст). [image: image50.jpg]



2. У нижній частині панелі інструментів встановіть потрібні атрибути тексту. 

3. Зробіть одне з нижченаведеного: 

Для створення лінії тексту клацніть у потрібному місці робочого поля і введіть текст. Для створення блоку тексту натисніть ліву кнопку миші і перемістіть покажчик на потрібну відстань (ширину блоку) після чого можна вводити текст. 

Примітка: Якщо створена лінія тексту, то при введенні символів можливий вихід правого краю об'єкта за кордон робочого поля (Stage). В цьому випадку просто зробіть перетворення рядка і продовжуйте введення, чи виберіть View > Work Area, щоб зробити маркер доступним. 

Зміна ширини будь-якого типу текстових об'єктів: 
Перетягніть маркер на потрібну відстань. 

Видалення заданої ширини текстового блоку: 
Двічі натисніть по маркері. 

Створення текстового поля (Text field):
1. Виберіть інструмент "Text Tool" (Текст). 

2. Натисніть на кнопку Text Field в нижній частині інструментальної панелі. 

3. Натисніть і протягніть покажчик миші, щоб зазначити бажану ширину і висоту текстового поля. 

Перетворення простого текстового об'єкта в текстове поле (Text field): 
1. Виберіть інструмент "Text Tool" (Текст). 

2. Натисніть на текст всередині простого текстового об'єкта. 

3. Натисніть на кнопку Text Field. Перетягніть маркер в потрібне місце для завдання необхідної ширини і висоти текстового поля. Навколо цього текстового об'єкта з'явиться суцільна чорна лінія, яка говорить про те, що це текстове поле. 

4. Встановіть властивості текстового поля. Встановлення властивостей текстового поля (Text field) 

5. Мишкою виділіть текстове поле і виберіть Modify > Text Field для відкриття вікна діалогу властивостей текстового полючи (text field). 

Вікно діалогу властивостей текстового поляи містить наступні установки: 
· Variable (Перемінна) - визначає ім'я перемінної текстового поля. 

· Draw Border and ground (Відображення рамки і фону) - показується границя і фон текстового поля. 

· Password (Пароль) - символи, що вводяться користувачем, відображаються у вигляді зірочок. У цьому режимі зміст текстового поля не може бути скопійований в процесі відтворення кліпу. 

· Multiline (Багатостроковість) - дозволяє переводити рядок, чи робити перенос слів у текстовому полі. 

· Word Wrap (Перенос) - автоматично переводить рядок, коли в процесі введення текст досягає правого краю поля. 

· Restrict Text Length To (Обмеження довжини тексту) - обмежує кількість символів, що вводяться користувачем. 

· Disable Editing (Блокування редагування) - забороняє користувачу змінювати текст, що знаходиться в полі. Ця опція використовується для висновку динамічно змінюваного тексту. 

· Disable Selection (Блокування виділення) - забороняє користувачу виділити текст, що знаходиться в полі. 

· Outlines (Установка шрифту) - вказання способу збереження та експорту використовуваного в полі шрифту. Можливе застосування наступних опцій: не включати в кліп установки шрифту, включати всі встановки, включати тільки визначені типи символів (верхній регістр, нижній регістр, числа, пунктуація, букви). Вибір цих параметрів допомагає зменшувати розмір вихідного SWF-файлу. 

Редагування тексту
Для редагування тексту в Flash використовуються традиційні методи роботи з текстом - вирізання (Cut), копіювання (Copy) і вставка (Paste). Включивши інструмент "Text Tool" (Текст), натисніть всередині текстового об'єкта і виділіть потрібні символи. Включивши інструмент "Arrow" (Стрілка), двічі натисніть по текстовому об'єкті. 

Виділення тексту
Для редагування тексту, чи окремих символів, необхідно спочатку виділити їх. 

Виділення символів у текстовому об'єкті: 
1. Включивши інструмент "Text Tool" (Текст), натисніть в потрібному місці текстового об'єкта. 

2. Зробіть одне з нижченаведеного: Протягніть курсор над виділеними символами. Подвійним натисканням виділіть потрібне слово. Натисніть в місці початку виділення і утримуючи клавішу Shift натисніть в місці кінця виділення. Натисніть Ctrl+A (Windows) чи Command+A (Macintosh) для виділення всіх символів тексту. 

Виділення текстових об'єктів: 
Включивши інструмент "Arrow" (Стрілка), натисніть на текстовому об'єкті. Для виділення декількох об'єктів, натисніть по них, утримуючи клавішу Shift. 

Вибір шрифту, розміру тексту і стилю 
Шрифт - набір алфавітно-цифрових символів, що мають специфічний дизайн. За допомогою кнопок, що знаходяться в нижній частині панелі інструментів, можна вибирати шрифт, кегель і стиль для виділеного тексту. Незалежно від встановленої одиниці виміру розмір кегля вказується в пунктах. 

1. Виділіть потрібні символи. 

2. Якщо текстовий об'єкт виділений інструментом "Arrow" (Стрілка), включіть інструмент "Text Tool" (Текст). 

3. Виберіть шрифт зі списку шрифтів (Font modifier). 
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4. Для встановлення розміру кегля, виберіть його значення зі списку (Font size) чи наберіть потрібне. 

5. Для вказання стилю написання, натисніть відповідні кнопки "B" (Bold) чи "I" (Italic). 

Вибір шрифту, розміру і стилю за допомогою вікна діалогу шрифту: 
1. Виділіть потрібні символи, як описано у Виділенні тексту. 

2. Виберіть Modify > Font. 

3. Виберіть шрифт, розмір і тип написання за допомогою відповідних опцій у вікні діалогу, що відкрилося. 

Встановлення полів, відступів і міжстрічкового інтервалу:
Поля (Margins) встановлюють відстань між границею текстового об'єкта і самим текстом. Відступи (Indents) встановлюють відстань між границею і початком першого рядка абзацу. Міжстрічковий інтервал (Line spacing) встановлюють відстань між рядками.

1. Виберіть текст в якому необхідно зробити ці зміни. 

2. Виберіть Modify > Paragraph чи натисніть на кнопку Paragraph (Параграф) у нижній частині панелі інструментів. 

3. Введіть потрібні значення для полів (Margins), відступів (Indents) і міжстрічкового інтервалу (Line spacing). 

Відключення автоматичного кернинга:
1. Виділіть потрібні символи, як описано у Виділенні тексту. 

2. Виберіть Modify > Font. 

3. Відключіть кернинг. 

Встановлення міжлітерного інтервалу: 
1. Виділіть потрібні символи, як описано у Виділення тексту. 

2. Зробіть одне з нижченаведеного:
Для встановлення міжлітерного інтервалу виберіть Modify > Font і введіть його значення. Для зменшення інтервалу на півпікселя, виберіть Modify > Kerning > Narrower чи натисніть Ctrl+Alt+Left Arrow (Windows) чи Command+Option+Left Arrow (Macintosh). Для зменшення інтервалу на два пікселі, натисніть Shift+Ctrl+Alt+Left Arrow (Windows) чи Shift+Command+Option+Left Arrow (Macintosh). Для збільшення інтервалу на півпіксель, виберіть Modify > Kerning > Wider чи натисніть Ctrl+Alt+Right Arrow (Windows) чи Command+Option+Right Arrow (Macintosh). Для збільшення інтервалу на два пікселі, натисніть Shift+Ctrl+Alt-Right Arrow (Windows) чи Shift-Command-Option-Right Arrow (Macintosh). Для відновлення первісного значення, виберіть Modify > Kerning > Reset, чи натисніть Control+Alt+Up Arrow (Windows) чи Command+Option+Up Arrow (Macintosh).

Визначення кольору тексту
Натисканням відповідної кнопки в нижній частині інструментальної панелі, чи через вікно з колірною палітрою тексту задається потрібний колір. При цьому можна призначати тільки одноколірне (solid) значення кольору. Щоб застосувати градієнтне заливання для тексту, його спочатку необхідно перевести в графічний вид. 

1. Виділіть потрібні символи, як описано у Виділення тексту. 

2. Якщо текстовий об'єкт виділений інструментом "Arrow" (Стрілка), включіть інструмент "Text Tool" (Текст). 

3. Зробіть одне з нижченаведеного: 
У нижній частині панелі інструментів натисніть на кнопку "Text color" (Колір тексту) із зображенням кольорового квадрата і виберіть потрібний колір у колірній палітрі, що відкрилася. Виберіть Window > Colors і вкажіть необхідний колір з однотонної (solid) колірної палітри. 

Вирівнювання тексту
Вирівнювання визначає позицію кожного рядка тексту в параграфі (абзаці) щодо лівої і правої границі текстового об'єкта. Текст може бути вирівняний по лівій чи правій границі об'єкта, центрований чи одночасно примикати і до лівого і до правих границь (повне вирівнювання). 

1. Виділіть потрібні символи. 

2. Зробіть одне з нижченаведеного: 

В нижній частині панелі інструментів натисніть на кнопку "Alignment" (Вирівнювання) і виберіть потрібний спосіб вирівнювання. Виберіть Modify > Style і вкажіть спосіб 

Завдання
1. Завантажити програму Flash MX. 

2. Введіть текст “Flash MX”.

3. Зафарбуйте даний текст в синій колір, збільшіть розмір до 25. 

4. Розмістіть текст по центру, зробіть його “жирним” курсивом. 

5. Введіть текст “Macromedia ”.

6. Розфарбуйте кожну літеру різним кольором. 

Контрольні запитання:
1. Як ввести текстову інформацію, в програмі Flash MX? 

2. Які текстові блоки ви знаєте? 

3. Які маніпуляції можна робити з текстовими блоками? 

4. Що таке “поле введення” і “динамічні текстові блоки”?

5. Яким чином можна працювати з текстом, як з графікою? 

ПР № 12 Екземпляри, символи, бібліотеки
Теоретичні відомості

Нехай, ми створили деякий графічний об’єкт, який містить велику кількість однакових елементів. Кожний елемент описується деяким набором графічних примітивів. А це означає, що він займає місце в пам’яті і на диску. І чим більше таких елементів, тим більше місця вони займають. Але, за допомогою Flash-технологій можна зменшити об’єм таких файлів. Намалюємо елемент, який повторюється, один раз, а потім просто створимо посилання в потрібному місці на його опис. В такому випадку опис графічного елемента заноситься до бібліотеки, а сам елемент отримує назву - символ. (symbol). Тепер, в потрібному місці на робочому листі ми ставимо посилання на цей символ, створюючи тим самим, екземпляр (instance).

Всі файли, які можна імпортувати в Flash, крім формата Shockwave/Flash, також заносяться до бібліотеки. 

Flash підтримує створення символів трьох типів: 

1. графічний символ (graphic) являє собою звичайне статичне або анімоване зображення, створене в Flash, або імпортоване з іншої програми; 

2. символ-кнопка (button)- це особливий символ, який являє собою звичайну кнопку. Такі символи використовуються для створення графічного користувацького інтерфейса.; 

3. символ-кліп (movie-clip). Являє собою фільм, створений засобами Flash. Більш детально про створення кнопок, символів-кліпів і роботу з ними розглянемо пізніше.

Крім перерахованих вище трьох типів символів, Flash підтримує ще чотири: символ-растрове зображення (bitmap), символ-звук (sound), символ-імпортований звук (embedded video) i символ-шрифт (font). 

Існує два способа створення символів. Перший: можна намалювати на робочому листі графічний елемент, а потім перетворити його в символ і помістити в бібліотеку. Другий: можна створити “порожній” символ і помістити його в бібліотеку, а вже потім “наповнити” його графічним змістом. 

Нехай, графічний примітив вже створено. Перетворимо його в символ. Виділіть графічний елемент на листі і виберіть пункт Convert to Symbol. В меню Insert в контексному меню виділеного графічного фрагмента.
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В полі введення Name введемо ім’я символа. За допомогою пункту Behavior задається тип символа. Елемент управління Registration задає місцезнаходження точки фіксації символа. Натисніть кнопку ОК і створений символ буде занесено в бібліотеку. 

Для створення екземплярів потрібно вивести на екран вікно бібліотеки (в меню Window виберіть пункт Library), вибрати в ньому потрібний символ і перетягнути його на робочий лист. На листі буде створений новий екземпляр, вибраного символа. 

Якщо екземпляр виділено, то редактор властивотей має вигляд: 
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Змінювати колір екземпляра можна за допомогою списка Color, в якому доступні п’ять пунктів: None (відключення усіх кольорових ефектів), Brightness (загальна яскравість екземпляра), Tint (загальний відтінок екземпляра), Alpha (загальна прозорість екземпляра) i Advanced (більш точніше задання кольору екземпляра). 

З екземпляром можна виконувати всі ті ж дії, що і для будь-якого графічного об’єкта: обертання, зміна розмірів та ін. 

Операція зміни типу екземпляра того чи іншого символа, не змінюючи типу самого символу, виконується за допомогою редактора властивостей. Виділіть потрібний екземпляр і виберіть в списку, який знаходиться нижче імені символу, новий тип - Graphic, Button, Movie Clip. 

Якщо потрібно змінити одразу всі екземпляри, найкращий спосіб це зробити - змінити сам символ. Одразу після того, як символ буде змінений, Flash поновить всі створені на його основі екземпляри. 

Flash надає три способа змінити символ:

1. в звичайному режимі редагування символа;

2. “на місці”;

3. в окремому вікні.

Для редагування символа в звичайному режимі виберіть пункт Edit Symbol меню Edit. 

Для редагування символа “на місці”, виберіть пункт Edit in Place меню Edit. При цьому можна змінювати символ на робочому листі, вся решта графіка не буде підлягати редагуванню. 

Для редагування символа в окремому вікні виберіть пункт Edit in New Window контексного меню. 

Для того, щоб вийти з режиму редагування символа виберіть пункт Edit Document меню Edit або натиснути комбінацію клавіш +.

Flash надає зручні засоби для перенесення символів з однієї бібліотеки в іншу. Ви можете відкрити кілька документів, виділити на робочому столі потрібні символи, скопіювати в буфер обміну і вставити на робочий листок іншого документа. Інший спосіб полягає в наступному: виберіть пункт Open as Library меню File. На екрані з’явиться стандартне діалогове вікно відкриття файлу Windows. Виберіть файл документа з якого ви імпортуєте символи, і натисніть кнопку відкриття. Після цього відкриється інше вікно бібліотеки, яке належить відкритому документу, скопіюйте з нього символи звичайним перенесенням. Використовуючи пункт Open as Library, можна відкрити будь-яку кількість бібліотек. 

Практична частина

Завдання
1. Намалюйте малюнок 1 і перетворіть його на графічний символ. 

2. Перетворіть малюнок на символ-кліп. 

3. Створіть екземпляр даного символу. 

4. Намалюйте малюнок 2 і перетворіть його на графічний символ. 

5. Перетворіть малюнок на символ-кліп. 

6. Створіть екземпляр даного символу. 

7. Змініть колір і прозорість створеного екземпляра. 
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Контрольні запитання
1. Що таке символи і екземпляри і для чого вони використовуються? 

2. Які види символів ви знаєте? 

3. Які два способа створення символів ви знаєте? 

4. Яким чином можна змінити колір екземпляра? 

5. Чи можна змінити тип символа? 

6. Яким чином можна відредагувати символ? 

7. Як можна перенести символи з однієї бібліотеки в іншу? 

ПР № 13 Сценарії та панель Actions
Теоретичні відомості

Сценарій - це невелика програма, написана на спеціальній мові ActionScript, яка виконується при деякій події. Наприклад, натискання клавіши мишки. Мова програмування в середовищі Flash - ActionScript розроблена на основі популярної мови JavaScript, містить спільні команди і слідує тим же принципам написання програм.

Для того, щоб вивести панель Actions на екран виберіть пункт Actions в меню Window. Панель складається з двох частин (див. рис.).
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В лівій частині панелі Actions знаходиться ієрархічний список операцій, які доступні на мові ActionScript. Таких операцій є багато, тому вони розбиті на кілька груп. Якщо в сценарії не можна використовувати дану операцію, вона показана сірим кольором. В правій частині знаходиться текст сценарію. Він представляє собою список команд мови ActionScript. Параметри команд задаються за допомогою набора елементів управління (див. рис.). 
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Значення параметра, звичайно, вводиться в поле введення або в список. В верхній частині вікна знаходиться невелике сіре текстове поле. В якому відображається короткий опис вибраної операції. Для отримання повної інформації натисніть кнопку. 
Панель Action може працювати в двох режимах: звичайному і професійному. Професійний режим зображено нижче.
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Для переключення між режимами використовуйте кнопку View Options [image: image58.jpg]


.

Отже, напишемо невеликий сценарій для вже створеного фільма, і “прив’яжемо” його до кадру. Для цього відкрийте фільм. Нехай наш фільм містить дві сцени. Напишемо сценарій для останнього кадра другої сцени, який повертає програвання фільма на перший кадр цієї сцени. Виділіть останій кадр другої сцени. Зайдіть в панель Actions. Для того, щоб додати яку-небудь операцію мови ActionScript натисніть кнопку + і виберіть потрібний пункт. В даному випадку виберіть gotoAndPlay. Відразу в списку текста сценарія з’явилась ця дія. А над списком знаходяться елементи управління. Розглянемо їх докладніше.

Перемикач Go to and Play - продовжує програвання з заданого кадра, а Go to and Stop - зупиняється на ньому.

В списку Scene можна вибрати сцену фільма, в якій знаходиться потрібний кадр.

Список Type дозволяє вибрати спосіб задання потрібного кадра:

· Frame Number - задається номер кадра;

· Frame Label -задається ім’я кадра;

· Expression - номер кадра обчислюється за допомогою арифметичного виразу;

· Next Frame - перехід до наступного кадра;

· Previous Frame - перехід до попереднього кадра.

В нашому випадку потрібно ввімкнути перемикач gotoAndPlay, вибрати пункт current scene, в списку Scene, пункт Frame Number - в списку Type і ввести 1 в список Frame. Після чого сценарій прийме вигляд: gotoAndPlay(1). Збережіть фільм і перевірте чи ввімкнено пункт Eneble Simple Frame Actions в меню Control.

Далі розглянемо, яким чином можна “прив’язати” сценарій до екземпляра-кліпа.
Створіть фільм в якому прямокутник рухається зліва направо. Перетворіть екземпляр прямокутник в екземпляр-кліп (Movie Clip).

Напишемо сценарій, який зупиняє рух прямокутника, при натисканні на нього лівою клавішою миші.

Виділіть кліп на робочому листі. Виведіть на екран панель Actions. Для того, щоб присвоїти якій-небудь події сценарій, потрібно використати спеціальну дію onClipEvent. Ця дія задає подію, на яку буде виконуватись сценарій. А сам сценарій матиме вигляд:

OnClipEvent (<опис події>) { <текст сценарія> }

Виберемо дію OnClipEvent, яка знаходиться в пункті Actions в підпункті Movie Clip Control. Натисніть на перемикач Mousе down (натиснути на ліву клавішу миші). Тепер Flash точно знає на яку подію відгукнутись. Але він поки не знає, що саме потрібно робити. Зупинку кліпа виконує дія stop. Вона знаходиться в пункті Actions підпункту Movie Control. Перенесемо її в текст сценарія так, щоб вона потрапила між фігурними дужками. Текст сценарія буде виглядати так:

OnClipEvent (Mousе down) { stop(); }

Виберіть пункт Test Movie в меню Control. Після запуска фільма в окремому вікні спробуйте натиснути на прямокутник - він одразу ж зупиниться. 

Практична частина

Завдання
1. Завантажте програму Flash MX.

2. Створіть фільм, який складається з двох сцен, і в якому коло рухається по заданій траекторії.

3. Створіть сценарій, який “зациклює” фільм.

4. Створіть фільм, в якому по заданій траекторії рухається автомобіль.

5. Створіть сценарій, після виконання якого на екран виводиться характеристика автомобіля: колір, об’єм двигуна тощо.

Контрольні запитання
1. Що таке сценарій?

2. Яка мова програмування використовується програмою Flash?

3. З яких основних частин складається панель Actions?

4. В яких двох режимах може працювати панель Actions?

5. Як використовувати панель Actions?

ПР № 14 Створення кнопок
Теоретичні відомості

Розглянемо створення і використання кнопок - найпростіших елементів керування, наданих Flash. Кнопки використовуються дуже часто, і не тільки в додатках, але й у звичайних інтерактивних фільмах Flash, наприклад, для створення Web-сайтів.

Створення кнопок.

Щоб створити зразок-кнопку, зробіть наступне. Виберіть пункт New Symbol у меню Insert або натисніть комбінацію клавіш +. Якщо у вас відкрите вікно бібліотеки, ви також можете вибрати пункт New Symbol у додатковому меню цього вікна. На екрані з'явиться діалогове вікно Create New Symbol. Введіть у поле Name ім'я створюваного зразка, ввімкніть перемикач Button у групі Behavior і натисніть кнопку ОК. 

Після всього цього, як ви знаєте, Flash відкриє створений зразок у режимі редагування. Вам залишиться намалювати вашу кнопку. 
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Але не поспішаєте це робити. Подивимося уважно на тимчасову шкалу Рис.1. Добре видно, що кнопка - це насправді кліп, який складається з чотирьох кадрів, точніше, не кадрів, а розділів тимчасової шкали. Це дуже дивні кадри: усі вони мають підпис: Up, Over, Down і Hit. 

Рис.1. Чотири кадри, з яких складається кнопка Справа в тому, що ці кадри містять зображення, що будуть виведені Flash на робочому листі в різних випадках. Давайте їх перелічимо:

· зображення, що знаходиться в кадрі up, з'являється, коли кнопка не натиснута, і курсор миші не розташований над нею; 

· зображення, що знаходиться в кадрі over, з'являється, коли курсор миші розташований над кнопкою, але сама кнопка не натиснута; 

· зображення, що знаходиться в кадрі Down, з'являється в той момент, коли користувач натискає ліву кнопку мишки; 

· останнє зображення (кадр Hit) задає область, що буде відгукуватися на натискання миші ("гарячу" область кнопки). Це зображення ніколи не відображається Flash. 

Виділіть кадр up і намалюйте зображення кнопки. Нехай вона буде овальною. Після цього виділіть розділ тимчасової шкали over і помістіть туди новий основний кадр, вибравши пункт Keyframe меню Insert або пункт Insert Keyframe контекстного меню. Після цього Flash автоматично скопіює намальоване в першому кадрі зображення в новий кадр кнопки, вам залишиться тільки його підправити. Якщо ви хочете цілком змінити зображення, створене в черговому кадрі кнопки, то потрібно буде вибрати пункт Blank Keyframe меню Insert або пункт Blank Insert Keyframe контекстного меню.

Намалюйте вміст інших двох кадрів кнопки. Взагалі, вам необов'язково створювати всі чотири зображення. Ви можете намалювати одне-єдине зображення в кадрі up, після цього Flash автоматично перенесе це зображення в інші три кадри. Звичайно, така кнопка вийде "неживою", тобто не буде реагувати на натискання і рух миші. 

От і все. Тепер поверніться в режим виправлення фільму і відкрийте вікно бібліотеки. Знайдіть у списку зразків тільки що створену вами кнопку і виділіть її. Ви можете "програти" кнопку, як кліп, натиснувши кнопку, що знаходиться в правому верхньому куті панелі попереднього перегляду зразків. Для відтворення можна також вибрати пункт Play контекстного чи додаткового меню вікна бібліотеки, а для зупинки - Stop. 

Тепер перевіримо нашу кнопку в дії. Помістіть екземпляр кнопки на робочий лист. Клацніть по ньому мишею, щоб його виділити. Змініть розміри кнопки. Можете задати для неї яке-небудь перетворення, наприклад, повернути на 90° або зробити напівпрозорою. 

Власне перевірити кнопку ви можете двома шляхами. По-перше, можна просто запустити програвання фільму. По-друге, можна скористатися ще однією цікавою особливістю Flash. Для цього ввімкніть пункт-перемикач Enable Simple Buttons у меню Control чи натисніть комбінацію клавіш Ctrl+Alt+В. Після цього кнопка буде "працювати" прямо на робочому листі Flash, без необхідності запуску програвання фільму. 

Спробуйте помістити курсор миші над кнопкою і подивіться, як вона зміниться. Клацніть по кнопці. Як бачите, Flash прекрасно виконує свої обов'язки. 

Ви можете прив'язувати звуки до кнопок. Причому, прив'язати свій звук можна до кожного стану кнопки, тобто коли курсор миші вкаже на кнопку, буде програний один звук, а при натисканні по кнопці - інший звук. 

Насамперед, потрібні звуки необхідно імпортувати. Як це робиться, було докладно розказано. Помістіть їх прямо в бібліотеку і дайте їм імена, наприклад, buttonup і buttonOver. Якщо бажаєте, задайте для них параметри експорту. 

Тепер відкрийте потрібний зразок-кнопку в режимі редагування. Додайте новий шар для звуків і виділіть його. Після цього виділіть конкретний розділ на шкалі анімації, в залежності від того, до якого стану кнопки ви хочете прив'язати звук. Так, якщо ви хочете прив'язати звук до стану Over (коли курсор миші вказує на кнопку), вам належить виділити розділ Over. Створіть новий порожній ключовий кадр. А після цього вам залишиться тільки перекинути потрібний звук на робочий лист. 

Щоб прив'язати звуки відразу до двох станів кнопки (Оver або Down; звук прив'язувати не має змісту), буде краще створити для кожного звуку окремий шар. Таким чином, ви зможете краще керувати прив'язаними звуками. 

Кнопки Flash мають ще одну цікаву особливість. Справа в тому, що "гаряча" область кнопки зовсім не обов'язково повинна збігатися із самою кнопкою. Кнопка може спрацьовувати, якщо користувач клацне зовсім по іншому місці на робочому листі. Це дозволяє створювати дуже цікаві і корисні речі, на зразок підказок, які з‘являються при наведенні на яке-небудь місце кліпу, та ін. 

Практична частина

Завдання
1. Завантажити програму Flash MX.

2. Створити кнопку у вигляді еліпса.

3. Використовуючи ActionScript написати сценарій для кнопки.

4. На робочому столі знаходиться квадрат. Натискаємо на кнопку - з‘являється коло.

5. Створіть інтерактивний фільм, використовуючи кнопки 

Контрольні запитання
1. Як створити кнопку?

2. Які чотири поля має редактор кнопки?

3. Яким чином можна додати звук до кнопки?

